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Preface

This guide is your primary source of introductory and reference information for 
Oracle Database for Windows for both client and server. Differences between 
product versions are noted where appropriate.

This document describes the features of Oracle Database for Windows software that 
apply to the Windows NT Server, Windows 2000, Windows XP, and Windows 
Server 2003 operating systems.

This preface contains these topics:

■ Audience

■ Organization

■ Related Documentation

■ Conventions

■ Documentation Accessibility
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Audience
Oracle Database Platform Guide is intended for:

■ Database administrators

■ Network administrators

■ Security specialists

■ Developers who use Oracle Database

To use this document, you need:

■ Oracle-certified Windows operating system software installed and tested

■ Knowledge of object-relational database management concepts 

Organization
This document contains:

What's New in Oracle Database for Windows

Chapter 1, "Oracle Database Architecture on Windows"
This chapter describes how Oracle Database architecture takes advantage of some 
of the more advanced services in the Windows operating system.

Chapter 2, "Multiple Oracle Homes and Optimal Flexible Architecture"
This chapter describes how to use multiple Oracle homes and an Optimal Flexible 
Architecture (OFA) configuration for placement of database files.

Chapter 3, "Database Tools on Windows"
This chapter provides a list of preferred and optional tools you can use to perform 
common database administration tasks. It also explains how to start these tools.

Chapter 4, "Postinstallation Database Creation on Windows"
This chapter explains how to create a database after installing Oracle Database, 
using either the Database Configuration Assistant or command-line tools.

Chapter 5, "Postinstallation Configuration Tasks on Windows"
This chapter describes some of the configuration tasks you must perform before 
using Oracle interMedia and other Oracle options. 



xix

Chapter 6, "Administering a Database on Windows"
This chapter explains how to administer Oracle Database for Windows.

Chapter 7, "Monitoring a Database on Windows"
This chapter explains how to monitor Oracle Database for Windows.

Chapter 8, "Tuning Windows to Optimize Oracle Database"
This chapter explains how to tune Windows Server operating systems to ensure that 
Oracle Database is running in the best possible environment.

Chapter 9, "Authenticating Database Users with Windows"
This chapter describes authentication of Oracle Database users on Windows 
operating systems. 

Chapter 10, "Administering External Users and Roles on Windows"
This chapter describes the administration of external users and roles.

Chapter 11, "Storing Oracle Wallets in the Windows Registry"
This chapter describes the storing and retrieving of Oracle Wallets in the Windows 
registry.

Chapter 12, "Oracle PKI Integration with Windows"
This chapter describes the integration of Oracle public key infrastructure (PKI) with 
Windows 2000 public key infrastructure (Windows PKI) on Windows operating 
systems. 

Chapter 13, "Oracle Database Specifications for Windows"
This chapter discusses initialization parameters, which Oracle Database uses on 
Windows to enable various features of the database every time an instance is 
started.

Chapter 14, "Configuration Parameters and the Registry"
This chapter describes the use of the registry for various Oracle Database 
components. In addition, this chapter lists the recommended values and ranges for 
configuration parameters.



xx

Chapter 15, "Developing Applications for Windows"
This chapter points to sources of information on developing applications for 
Windows and outlines a procedure for building and debugging external 
procedures.

Appendix A, "Getting Started with Your Documentation"
This appendix describes the contents of your Oracle Database documentation set.

Appendix B, "Storing Tablespaces on Raw Partitions"
This appendix describes how to configure your system to store datafiles for 
tablespaces on raw partitions.

Appendix C, "Oracle Net Services Configuration on Windows"
This appendix describes Oracle Net Services configuration for Windows. For an 
overview of Oracle Net Services configuration in general, see Oracle Net Services 
Administrator's Guide.

Appendix D, "Error Messages on Windows"
This appendix lists error messages, causes, and corrective actions that are specific to 
the operation of Oracle Database for Windows.

Appendix E, "Using Oracle Database on Windows 2000"
This appendix highlights differences between Windows 2000 and Windows NT, 
with emphasis on procedures for common database tasks.

Appendix F, "Oracle Database Windows/UNIX Differences"
This appendix compares features of Oracle Database for Windows and UNIX. This 
information may be helpful to Oracle Database developers and database 
administrators moving from UNIX to Windows platforms. 

Glossary

Related Documentation
For information on the components available in your Oracle Database installation 
type, see your Oracle Database Installation Guide for Windows.

For Oracle Database product information that is applicable to all operating systems, 
see your Oracle Database Online Documentation Library CD-ROM for Windows. 
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Many of the examples in the documentation set use the sample schemas of the seed 
database, which is installed by default when you install Oracle Database. Refer to 
Oracle Database Sample Schemas for information on how these schemas were created 
and how you can use them yourself.

For information about Oracle Database error messages, see Oracle Database Error 
Messages. Oracle Database error message documentation is available only in HTML. 
If you only have access to the Oracle Database Documentation CD, you can browse 
the error messages by range. Once you find the specific range, use your browser's 
"find in page" feature to locate the specific message. When connected to the Internet, 
you can search for a specific error message using the error message search feature of 
the Oracle Database online documentation.

If you are not familiar with object-relational database management concepts, see 
Oracle Database Concepts.

Printed documentation is available for sale in the Oracle Store at 
http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register 
online before using OTN; registration is free and can be done at 
http://otn.oracle.com/membership/

If you already have a username and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at 
http://otn.oracle.com/documentation/

Conventions
This section describes the conventions used in the text and code examples of this 
documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in 
a glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.

UPPERCASE 
monospace 
(fixed-width) 
font

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width) 
font

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to open SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, 
and location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED 
initialization parameter to true.

Connect as oe user.

The JRepUtil class implements these 
methods.

lowercase 
italic 
monospace 
(fixed-width) 
font

Lowercase italic monospace font 
represents placeholders or variables.

You can specify the parallel_clause.

Run Uold_release.SQL where old_
release refers to the release you installed 
prior to upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line 
statements. They are displayed in a monospace (fixed-width) font and separated 
from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = 'MIGRATE';

The following table describes typographic conventions used in code examples and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two 
or more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the 
code that are not directly related to 
the example

■ That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .
 .
 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

SQL> SELECT NAME FROM V$DATAFILE;
NAME
------------------------------------
/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf
9 rows selected.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

acctbal NUMBER(11,2);
acct    CONSTANT NUMBER(4) := 3;
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Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password
DB_NAME = database_name

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the 
order and with the spelling shown. 
However, because these terms are not 
case sensitive, you can enter them in 
lowercase.

SELECT last_name, employee_id FROM 
employees;
SELECT * FROM USER_TABLES;
DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names 
of tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;
sqlplus hr/hr
CREATE USER mjones IDENTIFIED BY ty3MU9;

Convention Meaning Example

Choose Start > How to start a program. To start the Database Configuration Assistant, 
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools > 
Database Configuration Assistant.

File and directory 
names

File and directory names are not case 
sensitive. The following special characters 
are not allowed: left angle bracket (<), 
right angle bracket (>), colon (:), double 
quotation marks ("), slash (/), pipe (|), 
and dash (-). The special character 
backslash (\) is treated as an element 
separator, even when it appears in quotes. 
If the file name begins with \\, then 
Windows assumes it uses the Universal 
Naming Convention.

c:\winnt"\"system32 is the same as 
C:\WINNT\SYSTEM32

Convention Meaning Example
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C:\> Represents the Windows command 
prompt of the current hard disk drive. 
The escape character in a command 
prompt is the caret (^). Your prompt 
reflects the subdirectory in which you are 
working. Referred to as the command 
prompt in this manual.

C:\oracle\oradata>

Special characters The backslash (\) special character is 
sometimes required as an escape 
character for the double quotation mark 
(") special character at the Windows 
command prompt. Parentheses and the 
single quotation mark (') do not require 
an escape character. Refer to your 
Windows operating system 
documentation for more information on 
escape and special characters.

C:\>exp scott/tiger TABLES=emp 
QUERY=\"WHERE job='SALESMAN' and 
sal<1600\"
C:\>imp SYSTEM/password FROMUSER=scott 
TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name. The 
home name can be up to 16 alphanumeric 
characters. The only special character 
allowed in the home name is the 
underscore. 

C:\> net start OracleHOME_NAMETNSListener

Convention Meaning Example
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at

http://www.oracle.com/accessibility/

ORACLE_HOME 
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3, 
when you installed Oracle components, 
all subdirectories were located under a 
top level ORACLE_HOME directory. For 
Windows NT, the default location was 
C:\orant.

This release complies with Optimal 
Flexible Architecture (OFA) guidelines. 
All subdirectories are not under a top 
level ORACLE_HOME directory. There is a 
top level directory called ORACLE_BASE 
that by default is C:\oracle. If you 
install the latest Oracle release on a 
computer with no other Oracle software 
installed, then the default setting for the 
first Oracle home directory is 
C:\oracle\orann, where nn is the 
latest release number. The Oracle home 
directory is located directly under 
ORACLE_BASE.

All directory path examples in this guide 
follow OFA conventions.

Refer to Oracle Database Platform Guide for 
Windows for additional information about 
OFA compliances and for information 
about installing Oracle products in 
non-OFA compliant directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example
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Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 
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What's New in Oracle Database for
Windows

This section describes new features of Oracle Database and provides pointers to 
additional information. New features information from previous releases is also 
retained to help those users migrating to the current release.

The following sections describe new features:

■ Oracle Database 10g New Features

■ Oracle9i Release 2 (9.2.0.2) New Feature

■ Oracle9i Release 2 (9.2) New Features

■ Oracle9i Release 1 (9.0.1) New Features
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Oracle Database 10g New Features
This section contains these topics:

■ Large Page Support

■ Scheduler

■ Database Password Encryption

■ Data Pump Import and Export

■ Oracle Database for 64-Bit Windows

Large Page Support
Large page support provides a performance boost for memory-intensive database 
instances running on Windows Server 2003. By taking advantage of newly 
introduced operating system support, Oracle Database 10g can now make more 
efficient use of processor memory addressing resources.

Scheduler
This release includes a new database scheduler to provide enterprise scheduling 
functionality. External jobs performed by the user are started using the 
OracleJobScheduler service. This service is disabled by default. In order to use the 
external jobs functionality, the administrator must set the username and password 
for the user account under which this service must run, and enable the service.

Restricting execution of external jobs to a low-privileged user prevents any random 
database user from gaining operating system level privileges, but it also places 
restrictions on the kinds of jobs that can be run. Jobs requiring a higher level of 
operating system privileges cannot be run by this mechanism.

On Windows, running an external job involves the following processes:

■ Job slave process (one for each job)

■ extjob service (one service, with one thread for each job)

■ The actual external executable or job (one for each external job)

See Also: "Large Page Support" on page 8-2
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Database Password Encryption
When a user attempts a remote login to Oracle Database, the password is 
automatically encrypted before it is sent to the remote database. For more 
information, see "Automatically Encrypted Database Passwords" on page 6-18.

Data Pump Import and Export
Two new utilities offer faster transfer of files to and from Oracle Database. The older 
file transfer utilities, Import and Export, are retained for use with databases created 
with earlier versions of Oracle software. For more information on Data Pump 
Import and Export, see Chapter 3, "Database Tools on Windows".

Oracle Database for 64-Bit Windows
Oracle plans to release a 64-bit version of Oracle Database 10g for Windows at a 
later date.

Oracle9i Release 2 (9.2.0.2) New Feature
Beginning with Oracle9i release 2 (9.2.0.2.1) for 64-bit Windows, Oracle supports 
64-bit processing in the following operating systems:

■ Windows XP 64-bit Edition Version 2003

■ Windows Server 2003 for 64-bit Itanium 2 Systems 

Most of the features and functions of the 32-bit version carry over to the 64-bit 
version. 

See Also:

■ "The Scheduler" in Oracle Database New Features

■ "Overview of Scheduler Concepts" in Oracle Database 
Administrator's Guide

■ "Using the Scheduler" in Oracle Database Administrator's Guide

■ "Managing the Scheduler" in Oracle Database Administrator's 
Guide

See Also: http://otn.oracle.com for the latest version of Oracle 
Database for 64-bit Windows
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Oracle9i Release 2 (9.2) New Features
This section contains these topics:

■ Very Large Memory Support

■ User Migration Utility

Very Large Memory Support
Oracle9i release 2 (9.2) for Windows supports Very Large Memory (VLM) 
configurations in Windows 2000 and Windows XP, which allow Oracle9i release 2 
(9.2) to access more than the 4 gigabyte (GB) of RAM traditionally available to 
Windows applications. For more information, see "Oracle Database Scalability on 
Windows" on page 1-5. 

User Migration Utility
A new command-line tool, User Migration Utility, simplifies conversion of local or 
external database users to enterprise users. For more information, see:

■ Database Tools on Windows on page 3-1

■ Manually Migrating Users on page 10-50

■ "Using the User Migration Utility" in Oracle Advanced Security Administrator's 
Guide

Oracle9i Release 1 (9.0.1) New Features
This section contains these topics:

■ Windows XP Support

■ Database Configuration Assistant Improvements

■ Oracle Internet Directory Administration Improvements

■ Using Oracle Database on Windows 2000

■ CONNECT INTERNAL Not Supported

■ Server Manager Not Supported

See Also: http://otn.oracle.com for the latest version of Oracle 
Database for 64-bit Windows
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Windows XP Support
Oracle9i release 1 (9.0.1.1.1) for Windows is certified on the 32-Bit version of 
Windows XP Professional Edition. 

Oracle provides support information for components on various platforms, lists 
compatible client and database versions, and identifies patches and workaround 
information. Find the latest certification information at 
http://metalink.oracle.com/

You must register online before using OracleMetaLink. After logging into 
OracleMetaLink, select Product Lifecycle from the left-hand column. 

Database Configuration Assistant Improvements
Database Configuration Assistant has been redesigned to include database 
definitions saved as templates. The templates can generate databases. Users can 
define new templates, modify existing templates, or use the ones Oracle provides. 
When creating a database with Database Configuration Assistant, users can include 
new Sample Schemas provided by Oracle. 

Oracle Internet Directory Administration Improvements
Administration of Oracle Internet Directory replication server has been improved 
with the addition of new replication queue management and reconciliation tools. 

Using Oracle Database on Windows 2000
There are some differences between using Oracle Database on Windows 2000 and 
Windows NT 4.0. For more information, see Appendix E, "Using Oracle Database 
on Windows 2000". 

CONNECT INTERNAL Not Supported
CONNECT INTERNAL and CONNECT INTERNAL/PASSWORD are not supported in 
Oracle9i. Use the following instead:

CONNECT / AS SYSDBA

CONNECT username/password AS SYSDBA

Server Manager Not Supported
Server Manager is not supported in Oracle9i. Use SQL*Plus instead. Most Server 
Manager scripts should work in a SQL*Plus environment, but some scripts may 
need to be modified.
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1
Oracle Database Architecture on Windows

This chapter describes how Oracle Database architecture takes advantage of some 
of the more advanced services in Windows operating systems.

This chapter contains these topics:

■ Oracle Database on Windows Architecture

■ Oracle Database Scalability on Windows

■ Oracle Database Integration with Windows

■ Other Sources of Information
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Oracle Database on Windows Architecture
Oracle Database on Windows is a stable, reliable, and high performing system upon 
which to build applications. Each release of the database provides new 
platform-specific features for high performance on Windows.

Oracle Database operates the same way on Windows as it does on other platforms. 
The architecture offers several advantages on Windows, such as:

■ Thread-Based Architecture

■ File I/O Enhancements

■ Raw File Support

Thread-Based Architecture
The internal process architecture of Oracle Database is thread-based. Threads are 
objects within a process that run program instructions. Threads allow concurrent 
operations within a process so that a process can run different parts of its program 
simultaneously on different processors. A thread-based architecture provides the 
following advantages:

■ Faster context switching

■ Simpler System Global Area allocation routine, because it does not require use 
of shared memory

■ Faster spawning of new connections, because threads are created more quickly 
than processes

■ Decreased memory usage, because threads share more data structures than 
processes

Internally, the code to implement the thread model is compact and separate from 
the main body of Oracle Database code. Exception handlers and routines track and 
de-allocate resources. They add robustness, with no downtime because of resource 
leaks or an ill-behaved program.

Oracle Database is not a typical Windows process. On Windows, an Oracle 
Database instance (threads and memory structures) is a Windows service: a 
background process registered with the operating system. The service is started by 
Windows and requires no user interaction to start. This enables the database to 
open automatically at startup. 

When running multiple Oracle Database instances on Windows, each instance runs 
its own Windows service with multiple component threads. Each thread may be 
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required for the database to be available, or it may be optional and specific to 
certain platforms. The background processes read and write from various datafiles, 
depending on your configuration. Oracle Database architecture on Windows is 
illustrated in Figure 1–1. Examples of optional and required threads on Windows 
are listed in Table 1–1.

Figure 1–1 Oracle Database Architecture on Windows
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Oracle Database for Windows is supplied as a set of executables and dynamic link 
libraries (DLLs). Executable images can be modified using ORASTACK to change 
the size of the stack used by the threads of the Oracle Database process. (Oracle 
recommends you use this tool only under the guidance of Oracle Support Services.)

File I/O Enhancements
Oracle Database supports 64-bit file I/O to allow use of files larger than 4 gigabytes 
(GB). In addition, physical and logical raw files are supported as data, log, and 
control files to support Oracle Real Application Clusters on Windows and for those 
cases where performance needs to be maximized.

All Oracle Database file I/O routines support 64-bit file offsets, meaning there are 
no 2 GB or 4 GB file size limitations when it comes to data, log, or control files, as 
there are on some other platforms. In fact, the limitations that are in place are 
generic Oracle Database limitations across all platforms. These limits include 4 
million database blocks for each file, 16KB maximum block size, and 64K files for 
each database. If these values are multiplied, then maximum file size for a database 
file on Windows is 64 GB, and maximum total database size supported (with 16KB 
database blocks) is 4 petabytes.

Table 1–1 Required and Optional Oracle Database Threads

Oracle Database Thread Description Required/Optional

DBW0 database writer Required

LGWR log writer Required

PMON process monitor Required

SMON system monitor Required

CKPT checkpoint process (thread on Windows) 
that runs by default on Windows

Optional

ARCH0 archive process (or thread on Windows) Optional

RECO distributed recovery background process Optional

Note: You can view running background processes by issuing the 
following query:

SQL> select * from v$bgprocess where paddr <> '00' ; 
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Raw File Support
Windows supports raw files, similar to UNIX. Using raw files for database or log 
files can have a slight performance gain. Raw files are unformatted disk partitions 
that can be used as one large file. Raw files have the benefit of no file system 
overhead, because they are unformatted partitions. However, standard Windows 
commands do not support manipulating or backing up raw files. As a result, raw 
files are generally used only by very high-end installations and by Oracle Real 
Application Clusters, where they are required.

To Oracle Database, raw files are no different from other Oracle Database files. They 
are treated in the same way by Oracle Database as any other file and can be backed 
up and restored through Recovery Manager or OCOPY.

Oracle Database Scalability on Windows
Features in Oracle Database and in the Windows operating system work together to 
help increase scalability, throughput, and database capacity. These features include:

■ Support for Very Large Memory (VLM) Configurations

■ 4 GB RAM Tuning (4GT)

■ Large User Populations 

Support for Very Large Memory (VLM) Configurations
Oracle Database for Windows supports Very Large Memory (VLM) configurations 
in Windows 2000 and Windows XP, which allows Oracle Database to access more 
than the 4 gigabyte (GB) of RAM traditionally available to Windows applications. 

Specifically, Oracle Database uses Address Windowing Extensions (AWE) built into 
Windows 2000 and Windows XP to access more than 4 GB of RAM. 

The requirements for taking advantage of this support are: 

1. The computer on which Oracle Database is installed must have more than 4 GB 
of memory. 

Note: This feature is not supported on Windows NT, and it is 
available on Windows 2000 and Windows XP only with Intel 
Pentium II and Pentium III Xeon 32-bit processors.
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2. The operating system must be configured to take advantage of Physical 
Address Extensions (PAE) by adding the /PAE switch in boot.ini. See 
Microsoft Knowledge Base article Q268363 for instructions on modifying 
boot.ini to enable PAE.

3. It is advisable (though not necessary) to enable 4GT support by adding the 
/3GB parameter in boot.ini. See Microsoft Knowledge Base article Q171793 
for additional requirements and instructions on modifying boot.ini to enable 
4GT.

4. The user account under which Oracle Database runs (typically the LocalSystem 
account), must have the "Lock memory pages" Windows 2000 and Windows XP 
privilege.

5. USE_INDIRECT_DATA_BUFFERS=TRUE must be present in the initialization 
parameter file for the database instance that will use VLM support. If this 
parameter is not set, then Oracle Database 10g behaves in exactly the same way 
as previous releases. 

6. Initialization parameters DB_BLOCK_BUFFERS and DB_BLOCK_SIZE must be 
set to values you have chosen for Oracle Database.

Note: The total number of bytes of database buffers (that is, DB_
BLOCK_BUFFERS multiplied by DB_BLOCK_SIZE) is no longer 
limited to 3 GB.

Dynamic SGA and multiple block size are not supported with 
VLM. When VLM is enabled, the following new buffer cache 
parameters are not supported:

■ DB_CACHE_SIZE

■ DB_2K_CACHE_SIZE

■ DB_4K_CACHE_SIZE

■ DB_8K_CACHE_SIZE

■ DB_16K_CACHE_SIZE

■ DB_32K_CACHE_SIZE

To select the block size for the instance, use the initialization 
parameter DB_BLOCK_SIZE. The buffer cache size is set by the 
initialization parameter DB_BLOCK_BUFFERS.
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7. Registry parameter AWE_WINDOW_MEMORY must be created and set in the 
appropriate key for your Oracle home. This parameter is specified in bytes and 
has a default value of 1 GB. AWE_WINDOW_MEMORY tells Oracle Database how 
much of its 3 GB address space to reserve for mapping in database buffers. 

This memory comes from the 3 GB virtual address space in Oracle Database, so 
its value must be less than 3 GB. Setting this parameter to a large value has the 
effect of using more of the address space for buffers and using less AWE 
memory for buffers. However, since accessing AWE buffers is somewhat slower 
than accessing virtual address space buffers, Oracle recommends that you tune 
these parameters to be as large as possible without adversely limiting database 
operations. 

In general, the higher AWE_WINDOW_MEMORY is set, the fewer connections and 
memory allocations will be possible for Oracle Database. The lower AWE_
WINDOW_MEMORY is set, the lower the performance. 

8. Once this parameter is set, Oracle Database can be started and will function 
exactly the same as before except that more database buffers are available to the 
instance. In addition, disk I/O may be reduced because more Oracle Database 
data blocks can be cached in the System Global Area (SGA). 

VLM Instance Tuning 
VLM configurations improve database performance by caching more database 
buffers in memory. This reduces disk I/O compared to configurations without 
VLM. VLM support in Oracle Database 10g has been re-written to integrate very 
closely with Oracle Database. Compared to Oracle8i release 2 (8.1.6), VLM users 
should see better performance with the newer implementation. 

Tuning for VLM is no different than tuning for configurations without VLM. It is an 
iterative task that begins by selecting appropriate DB_BLOCK_SIZE and DB_
BLOCK_BUFFERS initialization parameters for the application being supported.

Note: Registry parameter VLM_BUFFER_MEMORY, which enabled 
VLM configurations in Windows NT in Oracle8i release 2 (8.1.6), is 
not supported in Oracle Database 10g.

Note: Oracle Database 10g VLM configurations do not support 
multiple database block sizes.
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AWE_WINDOW_MEMORY, a new registry parameter specific to VLM, tells Oracle 
Database how much of its address space to reserve for mapping in database buffers. 
It defaults to a value of 1 GB, which should be suitable for most installations. If DB_
BLOCK_SIZE is large, however, the default AWE_WINDOW_MEMORY value of 1 GB 
may not be sufficient to start the database. 

Increasing the value of AWE_WINDOW_MEMORY will improve performance, but it will 
also limit the amount of memory available for other Oracle Database threads (like 
foreground threads). Clients may see "out of memory" errors if this value is set too 
large. As a general guideline, increase the AWE_WINDOW_MEMORY registry value by 
20 percent.

For example, if DB_BLOCK_SIZE is set to 8 KB, AWE_WINDOW_MEMORY is set to 1 
GB, and the number of LRU latches is set to 32 (16 processor computer), then 
database startup fails with out of memory errors 27102 and 34. Increasing the value 
of AWE_WINDOW_MEMORY to 1.2 GB fixes the problem. 

Having a large cache in a VLM configuration may also slow down database writer 
(DBWR) threads. Having more DBWR threads will distribute work required to identify 
and write buffers to disk and will distribute I/O loads among threads. Initialization 
parameter DB_WRITER_PROCESSES enables you to configure multiple database 
writer threads. 

A large cache can also introduce contention on the LRU (least recently used) latch. 
On symmetric multiprocessor (SMP) systems, Oracle Database sets the number of 
LRU latches to a value equal to one half the number of processors on the system. 
You can reduce contention on such configurations by increasing the number of LRU 
latches to twice (or four times) the number of processors on the system. 

4 GB RAM Tuning (4GT)
The following Windows operating systems include a feature called 4 GB RAM 
Tuning (4GT):

■ Windows Server 2003

■ Windows 2000 Advanced Server

■ Windows 2000 Datacenter Server

■ Windows NT 4.0 Enterprise Edition

See Also: Oracle Database Performance Tuning Guide for more 
information on instance tuning
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This feature allows memory-intensive applications running on Oracle Database 
Enterprise Edition to access up to 3 GB of memory, as opposed to the standard 2 GB 
in previous operating system versions. 4GT provides a tremendous benefit: 50 
percent more memory is available for database use, increasing SGA sizes or 
connection counts.

Large User Populations
Several features allow Oracle Database to support an increasingly large number of 
database connections on Windows:

■ Oracle Database Shared Server Process, which limits the number of threads 
needed in the Oracle Database process, supports over 10,000 simultaneous 
connections to a single database instance.

■ Oracle Net multiplexing and connection pooling features allow a large 
configuration to connect more users to a single database instance. 

■ Oracle Real Application Clusters raises connection counts dramatically by 
allowing multiple server computers to access the same database files, increasing 
the number of user connections by tens of thousands, as well as increasing 
throughput.

Oracle Database Integration with Windows
Oracle Database is increasingly integrated with Windows, easing maintenance and 
improving enterprise-level deployment in security, directory, and transaction 
services. Integration features in Oracle Database include: 

■ Oracle PKI Integration with Windows

■ Oracle Services for Microsoft Transaction Server

■ Oracle Fail Safe Integration with Windows 

■ Oracle Real Application Clusters Integration with Windows

Note: Oracle Real Application Clusters is not supported on 
Windows XP.
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Oracle PKI Integration with Windows
Oracle Advanced Security includes Oracle PKI (public key infrastructure) 
integration for authentication and single sign-on. You can integrate Oracle-based 
applications with the PKI authentication and encryption framework, using Oracle 
Wallet Manager.

Oracle Services for Microsoft Transaction Server
Microsoft Transaction Server (MTS) is used in the middle tier as an application 
server for COM/COM+ objects and transactions in distributed environments. In 
Windows 2000 and Windows XP it is part of COM+. Oracle Services for Microsoft 
Transaction Server allows Oracle Database to be used as a resource manager in 
Microsoft Transaction Server-coordinated transactions, providing strong integration 
between Oracle solutions and Microsoft Transaction Server. Oracle Services for 
Microsoft Transaction Server can operate with Oracle Database running on any 
operating system.

Oracle Database takes advantage of a native implementation and also stores 
recovery information in Oracle Database itself. Oracle Services for Microsoft 
Transaction Server allows development in all industry-wide data access interfaces, 
including Oracle Objects for OLE (OO4O), Oracle Call Interface (OCI), ActiveX 
Data Objects (ADO), OLE DB, and Open Database Connectivity (ODBC). The 
Oracle APIs, OO4O and OCI, offer greatest efficiency.

Oracle Fail Safe Integration with Windows
Oracle Fail Safe ensures that Oracle Database (and also other Oracle and third-party 
applications) can be configured and managed for high availability on Windows 
clusters. An instance runs on only one node at a time.

A cluster is a group of independent computing systems that operates as a single 
virtual system, eliminating individual host systems as points of failure. Oracle Fail 
Safe works with Microsoft Cluster Server to ensure that if a failure occurs on one 
cluster system, then workloads running on that system fail over quickly and 
automatically to a surviving system. Oracle Database combined with Oracle Fail 
Safe on a Windows cluster ensures protection from both hardware and software 
failures. 

For well-configured solutions, Oracle Fail Safe ensures a surviving system to be 
operational in less than a minute, even for heavily-used databases.
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Oracle Real Application Clusters Integration with Windows
Oracle Real Application Clusters are integrated with Microsoft Cluster Server 
clusters deployed on all Windows operating systems that support clustering. This 
enhances high availability features of Oracle Real Application Clusters by offering:

■ Optional automatic restarts of a failed instance or listener in a cluster

■ Detection and resolution of instance hangs

■ Elimination of connect-time failover TCP/IP timeout delays for new connection 
requests

■ Use of user-written scripts after database state (online/offline) changes

Other Sources of Information

Note: Windows XP does not support the clustering technology 
found in Microsoft Cluster Server. Therefore, Oracle Fail Safe 
Server, which integrates with Microsoft Cluster Server, is not 
supported on Windows XP. Oracle Fail Safe Manager Console is 
supported.

See Also: Your Oracle Fail Safe documentation set, available on 
separate media in the Oracle CD-ROM package

See Also:

■ Appendix F, "Oracle Database Windows/UNIX Differences"

■ Chapter 3, "Database Tools on Windows", for Oracle Database 
integration with Windows tools

■ Chapter 15, "Developing Applications for Windows", for more 
Oracle Database integration with Windows features
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2
Multiple Oracle Homes and Optimal Flexible

Architecture

This chapter describes multiple Oracle homes and Optimal Flexible Architecture 
(OFA) for Oracle Database for Windows.

This chapter contains these topics:

■ Introduction to Multiple Oracle Homes and OFA

■ Multiple Oracle Homes Overview

■ Changing the Value of PATH

■ Exiting Oracle Universal Installer After Entering Name and PATH

■ Setting Variables in the Environment or the Registry

■ Optimal Flexible Architecture Overview

■ Differences Between Directory Trees by Release

■ OFA Directory Naming Conventions

■ OFA and Multiple Oracle Home Configurations

■ Increasing Reliability and Performance

■ Comparison Between OFA on Windows and UNIX
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Introduction to Multiple Oracle Homes and OFA
When you install Oracle Database, you are installing one of the largest applications 
that your computer can support. Using multiple Oracle homes and OFA provides 
many advantages when administering large databases. The following advantages 
are most important:

■ Structured organization of directories and files and consistent naming used for 
database files simplify database administration.

■ Distribution of I/O across multiple disks prevents performance bottlenecks 
caused by multiple read or write commands issued simultaneously to a single 
drive.

■ Distribution of applications across multiple disks safeguards against database 
failures.

■ Login home directories are not at risk when database administrators add, move, 
or delete Oracle home directories.

■ Multiple versions of application software can execute concurrently.

■ Software upgrades can be tested in an Oracle home in a separate directory from 
the Oracle home where your production database is located.

Multiple Oracle Homes Overview
This section includes the following topics:

■ What Is an Oracle Home?

■ Benefit of Using Multiple Oracle Homes

■ One-Listener Support of Multiple Oracle Homes

What Is an Oracle Home?
An Oracle home corresponds to the environment in which Oracle products run. 
This environment includes the following:

■ Location of installed product files 

■ PATH variable pointing to binary files of installed products

Note: Oracle recommends that you test software upgrades on a 
separate server from your production database server
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■ Registry entries 

■ Service names

■ Program groups

Oracle homes also have a name associated with them, which you specify along with 
their location during installation.

Benefit of Using Multiple Oracle Homes
The main benefit of using multiple Oracle homes is that you can run multiple 
releases of the same products concurrently. For example, you can test an Oracle 
Database patch before you run your production Oracle Database against it. 

One-Listener Support of Multiple Oracle Homes
You can use one listener for spawning connections to databases for multiple Oracle 
homes. Simply add each system identifier to the SID_LIST section in the ORACLE_
BASE\ORACLE_HOME\network\admin\listener.ora file.

Because the SID is unique to a system across different Oracle homes, the listener can 
spawn the database thread for a specific SID in the correct Oracle home, and the 
ORACLE_HOME parameter (used in UNIX environments only) is not needed in the 
listener.ora file.

Changing the Value of PATH
Unless you specify otherwise at installation time, the Oracle home in which you 
installed products most recently is the first directory listed in your PATH (primary 
home). As such, it has priority over the other Oracle home entries in your PATH.

If you start a product from the command prompt, then the release of the product 
started is the one in the Oracle home listed first in your PATH, unless you 
specifically start a different release of the product by one of the following methods:

Note: There may be multiple listener.ora files on your 
computer, one for each Oracle home. To ensure that you use the 
correct listener.ora file, check the Oracle home name in the 
listener service. See "Managing Oracle Database Services" on 
page 6-2 for information on verifying service names.
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■ Specifying the full directory path name to the release of the product you want 
to use at the command prompt

■ Changing to the directory that contains the executable you want to use

■ Changing your PATH so that the first entry points to binary files for the product 
release you want to use

You have three options for changing the value of PATH:

■ Changing the Value of PATH Using Oracle Universal Installer

■ Changing the Value of PATH at the System Level 

The new value exists until you change the value of PATH again.

■ Changing the Value of PATH at the Command Prompt

The new value reverts to its previous value when you quit the session.

Changing the Value of PATH Using Oracle Universal Installer
Oracle Universal Installer enables you to edit your environment PATH to make a 
specific Oracle home directory your primary home when you have multiple active 
Oracle home directories on a single computer.

1. Choose Start > Programs > Oracle > HOME_NAME > Oracle Installation 
Products > Universal Installer.

The Oracle Universal Installer: Welcome window appears.

2. Click Installed Products.

3. Select the Environment tab.

4. Select a primary Oracle home and use the up arrow to move it to the top of the 
list.

5. Click Apply.

6. Click Close.

Note: The first two methods of changing the value of PATH are 
only valid if you are a member of the Administrators group. After 
you have changed the value of PATH, you must open a new 
command prompt window to make it active. The change is not 
reflected in already-opened windows.
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Changing the Value of PATH at the System Level
PATH is an environment variable, and the procedure for changing its value depends 
on your operating system.

Changing the Value of PATH at the Command Prompt
At the command prompt, enter:

C:\> set PATH=PATHNAME;%PATH%

where PATHNAME is the full path to binary files for the products you want to use. 
This change is valid for the current session only. If you want to change the value of 
your PATH permanently, then use Oracle Universal Installer or change the value of 
PATH at the system level. Both methods are described earlier in this section.

Exiting Oracle Universal Installer After Entering Name and PATH
If you have to exit Oracle Universal Installer unexpectedly after you have entered 
the name and path for an Oracle home (for example, because there is no more disk 
space in the path you specified), then you cannot specify a different path until you 
delete the KEY_HOME_NAME key corresponding to that Oracle home from the 
registry. To do this:

1. Read the value of parameter ORACLE_HOME_NAME for each KEY_HOME_NAME 
subkey in key HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE until you find the 
value that matches the name of the Oracle home you must delete.

2. Delete subkey KEY_HOME_NAME you just located.

Note: This procedure requires Oracle Universal Installer release 
2.3.0.5.0a or newer.

See Also: Your Windows documentation for information on 
environment variables

See Also: Chapter 14, "Configuration Parameters and the 
Registry" for more information on registry keys and subkeys
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Setting Variables in the Environment or the Registry
Variables set in the environment always override the value of equivalent variables 
set in the registry. The following section describes consequences of setting two of 
the most commonly-used environment variables, ORACLE_HOME and TNS_ADMIN.

Setting ORACLE_HOME
Oracle recommends that you never set the ORACLE_HOME environment variable, 
because it is not required for Oracle products to function properly. If you set the 
ORACLE_HOME environment variable, then Oracle Universal Installer will unset it 
for you. Oracle products find the value of ORACLE_HOME at the location specified 
by the ORACLE_BASE\ORACLE_HOME\bin\oracle.key file. If you must set 
ORACLE_HOME in the environment for another reason, then you must take care to 
run software only from that Oracle home when the variable is set. 

When you run an Oracle application from the command prompt, the first 
executable by that name found in the directory path runs. For example, C:\> 
sqlplus. Alternately, if you specify a full directory path, then the specified 
application runs. For example, C:\oracle\ora82> sqlplus.

If you modify the value of PATH using any of the three methods described in the 
previous section, then you can choose which release of an application is run from 
the command prompt. In sum, modifying the value of PATH indicates from which 
Oracle home to run executables at the command prompt, when no full directory 
path is specified. 

Once an Oracle application starts, it looks for all environment variables first in the 
current environment and second in the registry key for the Oracle home from which 
the application is running.

The application knows where it is running from by calling Windows to obtain the 
executable's path name and then parsing the path name to get the directory from 
which it is running. In the ORACLE_BASE\ORACLE_HOME\bin directory where the 
executable resides, there is a file called oracle.key. This file specifies where in the 
registry to look for variables when applications from that particular Oracle home 
are run. 

For example, if you run C:\oracle\ora82\bin\sqlplus.exe, then 
sqlplus.exe looks in C:\oracle\ora82\bin\oracle.key to find out where 
to look for its registry variables. If the oracle.key file does not exist (for version 7 
and some version 8 Oracle homes), then Oracle uses HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to locate the registry variables. 
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In a typical case, there are no Oracle variables (that is, ORACLE_HOME) set in the 
environment. Any applications run from an Oracle8 release 8.0.5 or later Oracle 
home look in the oracle.key file in that Oracle home and find their variables 
(including ORACLE_HOME) in the correct registry key. Likewise for Oracle Database 
10g, the Oracle home that gets priority depends on the PATH, but regardless of the 
PATH setting, all software works correctly. 

Consequences of Setting ORACLE_HOME 
If you set ORACLE_HOME in the environment, then software run from another Oracle 
home will not work reliably. Conflict occurs when you set ORACLE_HOME to point to 
one Oracle home directory, then attempt to run applications from a second Oracle 
home. These applications first check for any environment variable settings (such as 
ORACLE_HOME), before checking the registry through the oracle.key file. Because 
ORACLE_HOME is set, the applications in the second Oracle home attempt to use files 
in the first Oracle home, causing a conflict.

For example, suppose you have Oracle8 release 8.0.5 installed in C:\orant and 
Oracle Database 10g installed in C:\oracle\ora10. Suppose further that 
ORACLE_HOME is set to C:\orant in the environment. If you run an application 
from C:\oracle\ora10\bin, then that application first looks in the environment 
for all variables before looking at its oracle.key file. So an application run from 
your Oracle Database 10g Oracle home runs with ORACLE_HOME=C:\orant. 
Therefore, anything that the application uses ORACLE_HOME for will be looked for 
in C:\orant, where it may not exist. Examples include message files (*.msb), SQL 
scripts (.sql), and any other files opened by the application and based off 
ORACLE_HOME. 

Note that the same behavior occurs on UNIX. If you run an application from Oracle 
home number 1 with ORACLE_HOME=OracleHome number 2 in the environment, 
then the same behavior can be observed. 

Setting TNS_ADMIN
Oracle software looks for TNS_ADMIN in one location in the registry (depending 
upon the type of Oracle home installed). If you installed software into the default 
Oracle home, then any software running from that Oracle home will look in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE. If you installed a new-style (8.0.4 or later) 
multiple Oracle home, then the Oracle software looks in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOMEID. 

The environment always overrides the registry, so if TNS_ADMIN is set in the 
environment, then that takes precedence over the TNS_ADMIN setting in the registry.
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Optimal Flexible Architecture Overview
Oracle Optimal Flexible Architecture (OFA) is a set of file naming and placement 
guidelines for Oracle software and databases. It can also be thought of as a set of 
good habits to adopt when organizing Oracle directories and files on your 
computer. All Oracle products on CD-ROM are OFA-compliant; that is, Oracle 
Universal Installer places Oracle products in directory locations that follow OFA 
guidelines. Although using OFA is not a requirement, Oracle recommends that you 
use it if your database will grow in size, or if you plan to have multiple databases. 

The aim of OFA is to prevent an entire class of problems that can occur when you 
have different releases of Oracle software and multiple, growing databases on your 
computer. OFA is designed to provide significant benefits:

■ Easier maintenance of Oracle software and databases through standard file 
organization

■ Greater reliability through data spanning multiple physical drives

■ Higher performance through decreased I/O contention for disks

For example, Oracle Universal Installer now separates Oracle software executables 
from database files. Previously, database files were placed in ORACLE_
HOME\database, a subdirectory of the Oracle home directory that also contained 
Oracle software.

Using OFA, Oracle Universal Installer puts Oracle software in ORACLE_
BASE\ORACLE_HOME and database files in ORACLE_BASE\oradata. Now when 
you upgrade a database to the latest release, the new Oracle software executables 
will be placed in a different Oracle home directory. After you judge the upgrade 
successful, you can easily remove the old Oracle home directory and reclaim space, 
because the database does not reside there.

Benefits of an OFA-Compliant Database
An OFA-compliant database has the following benefits:

■ Easier database administration and management of database growth

File system organization simplifies locating specific database files and adding 
database files as the database grows.

■ Fewer performance bottlenecks
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Disk contention decreases, because Oracle administration files, binary files, and 
datafiles that used to be on one disk can now reside in separate directories on 
separate disks.

■ Safeguards against disk failures

By spreading files across more than one disk, disk failures impact as little data 
as possible.

■ Support for concurrent execution of application software

Multiple releases of application software can run simultaneously, enabling 
testing and use of a new release of an application before abandoning the 
previous release. Transferring to a new release after an upgrade is simple for the 
database administrator and transparent for the user.

Characteristics of an OFA-Compliant Database
An OFA-compliant database has the following characteristics:

■ Independent subdirectories

Categories of files are separated into independent subdirectories so that files in 
one category are minimally affected by operations on files in other categories.

■ Consistent naming conventions for database files

Database files are easily distinguishable from all other files. Files of one 
database are easily distinguishable from files of another database. Datafiles, 
redo log files, and control files are easily identifiable. Datafiles are clearly 
associated with a particular tablespace.

■ Integrity of Oracle home directories

You can add, move, or delete Oracle home directories without having to revise 
applications that refer to them.

■ Separation of administrative information for each database

The ability to distinguish administrative information about one database from 
that of another ensures a reasonable structure for the organization and storage 
of administrative data.

■ Separation of tablespace contents

Tablespace free space fragmentation and I/O request contention are minimized, 
while administrative flexibility is maximized.
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■ Tuning I/O loads across all disks

I/O loads are tuned across all disks, including disks storing Oracle data in raw 
devices, if needed.

Differences Between Directory Trees by Release
OFA has necessitated changes to the Oracle Database directory tree. This section 
lists the differences.

Top-Level Oracle Directory
When you install an Oracle8i release 8.1.3 or earlier release, all subdirectories are 
located under a top-level ORACLE_HOME directory that by default is C:\orant.

When you install an Oracle8i release 8.1.4 or later OFA-compliant database, all 
subdirectories are no longer under a top-level ORACLE_HOME directory. There is 
now a new top-level directory called ORACLE_BASE of form X:\oracle, where X 
is any hard drive. If you install an OFA-compliant database using Oracle Universal 
Installer defaults, then ORACLE_BASE is C:\oracle.

ORACLE_BASE contains \ORACLE_HOME directories, \oradata directories (for 
database files), and \admin directories (for database administration files).

Database Filenames
In Oracle8i release 8.1.3 and earlier releases, database files have the SID in the 
database filename. For example, the first control file is named ctl1SID.ora.

Beginning with Oracle8i release 8.1.4, database files no longer have the SID in the 
database filename. For example, the first control file is named control01.ctl. 
There is no need for the presence of the SID in the filename, because all the database 
files for a particular database are placed in \oradata under a directory called DB_
NAME that is named for that database.

Database Filename Extensions
In Oracle8i release 8.1.3 and earlier releases, all database files have the same 
".ORA" extension.

In an OFA-compliant release, the convention of having ".ora" as the filename 
extension for database files is no longer used. Database filenames now have more 
meaningful extensions. These are: 
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■ .ctl for control files, 

■ .log for log files

■ .dbf for datafiles.

OFA Directory Naming Conventions
OFA uses directory naming conventions that make it easy to identify the precise 
Oracle home and database name that is associated with a set of files. This section 
describes the naming conventions used for top-level directories of an 
OFA-compliant database directory tree:

■ ORACLE_BASE Directory

■ ORACLE_HOME Directory

■ ADMIN Directory

■ ORADATA Directory

■ DB_NAME Directory

ORACLE_BASE Directory 
ORACLE_BASE is the root of the Oracle directory tree. If you install an 
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive. For example, C:\oracle.

If you are installing Oracle Database for Windows on a computer with no other 
Oracle software installed, then you can change ORACLE_BASE before running 
Oracle Universal Installer. Most users will not need or want to do this.

Do not change the value of ORACLE_BASE after you run Oracle Universal Installer 
for the first time. If there is an existing ORACLE_BASE and you change it, then there 
will be a conflict of Oracle base directories. If you create another ORACLE_BASE 
when the original ORACLE_BASE already exists, then certain tools and the database 
will not be able to find previously created files. They will look for them in the new 
ORACLE_BASE instead of the original ORACLE_BASE.

See Also: Your Windows documentation for instructions on 
editing environment variables
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ORACLE_HOME Directory 
The \ORACLE_HOME directory is located beneath X:\ORACLE_BASE and contains 
subdirectories for Oracle software executables and network files.

If you install Oracle Database for Windows on a computer with no other Oracle 
software installed and you use default settings, then the first Oracle home directory 
that you create is called \ora10.

ADMIN Directory
Database administration files are stored in subdirectories of ORACLE_BASE 
\admin\DB_NAME. Names and brief descriptions of some of these subdirectories 
are:

\bdump     --background process trace files
\cdump     --core dump files
\create    --database creation files
\exp       --database export files
\pfile     --initialization parameter files
\udump     --user SQL trace files

ORADATA Directory
Database files are stored in ORACLE_BASE\ORADATA\DB_NAME. Names and brief 
descriptions of these files are:

control01.ctl   --control file 1
control02.ctl   --control file 2
control02.ctl   --control file 3
system01.dbf    --SYSTEM tablespace datafile
temp01.dbf      --TEMP tablespace datafile
users01.dbf     --USERS tablespace datafile
*.dbf           --datafiles corresponding to each tablespace in your database
redo01.log      --redo log file group one, member one
redo02.log      --redo log file group two, member one
redo03.log      --redo log file group three, member one

Note: This directory structure allows for disk striping only on 
UNIX platforms. See "Support for Symbolic Links on Windows" on 
page 2-19.
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DB_NAME Directory 
DB_NAME is the unique name for a particular database and has the same value as 
parameter DB_NAME in the initialization parameter file. When you create a 
database, DB_NAME can be no more than eight characters long and can contain only 
the following characters:

■ Alphabetic characters

■ Numbers

■ Underscores (_)

■ Pound sign (#)

■ Dollar sign ($)

OFA and Multiple Oracle Home Configurations
The following sections describe various OFA and multiple Oracle homes 
configurations.

Specifying an ORACLE_HOME Directory
To install an OFA-compliant database, you must specify an Oracle home directory 
in the Path field of Oracle Universal Installer. It is of the form:

X:\[PATHNAME]\oracle\HOME_NAME 

where:

■ X:\ is any hard drive. For example, C:\

■ [PATHNAME] is an optional directory path name

■ \oracle is a mandatory directory path name, unless you changed the value of 
registry key ORACLE_BASE before performing the installation

■ HOME_NAME is the name of the Oracle home

The following are examples of OFA-compliant Oracle home directories:

■ C:\test\oracle\ora10 

■ D:\oracle\ora10 
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Installing a Default OFA Database: Example
1. Install any Oracle Database that supports OFA (Oracle Database 8.1.6 or later) 

on a computer with no other Oracle software installed and make sure that you 
accept default settings for the Oracle home (for example, c:\oracle\ora81).

2. Install any Oracle Database (for example, Oracle Database 10g) in a second 
Oracle home accepting the default settings.

Table 2–1 shows the default OFA database settings.

Installing a Nondefault OFA Database: Example 1
1. Install any Oracle Database that supports OFA (Oracle Database 8.1.6 or later) 

on a computer with no other Oracle software installed and change default 
Oracle Universal Installer settings for the first Oracle home (for example, from 
C:\oracle\ora81 to X:\xyz).

2. Install any Oracle Database (for example, Oracle Database 10g) in a second 
Oracle home and change default Oracle Universal Installer settings for the 
second Oracle home (for example, from C:\oracle\ora10 to Y:\abc).

Table 2–2 shows the nondefault OFA database settings for example 1.

The resulting directory tree would look similar to this:

X:\xyz
     \admin

Table 2–1 Default OFA Database Settings

Setting Value

ORACLE_BASE C:\oracle (same for all Oracle homes)

Oracle home 1 C:\oracle\ora81

Oracle home 2 C:\oracle\ora10

Table 2–2 Nondefault OFA Database Settings: Example 1

Setting Value

ORACLE_BASE X:\xyz for first Oracle home; 
Y:\abc for second Oracle home

Oracle home 1 X:\xyz 

Oracle home 2 Y:\abc 
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          \DB_NAME1 
          \DB_NAME2 
     \bin
     \network
     \oradata
          \DB_NAME1 
               control01.ctl
               control02.ctl
               control03.ctl
               indx01.dbf
               rbs01.dbf
               system01.dbf
               temp01.dbf
               users01.dbf
               redo01.log
               redo02.log
               redo03.log
          \DB_NAME2 
 Y:\abc
     \admin
          \DB_NAME1
          \DB_NAME2
     \bin
     \network
     \oradata
          \DB_NAME1
               control01.ctl
               control02.ctl
               control03.ctl
               indx01.dbf
               rbs01.dbf
               system01.dbf
               temp01.dbf
               users01.dbf
               redo01.log
               redo02.log
               redo03.log
          \DB_NAME2
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Installing a Nondefault OFA Database: Example 2
1. Install any Oracle Database that supports OFA (Oracle Database 8.1.6 or later) 

on a computer with no other Oracle software installed and change default 
Oracle Universal Installer settings for the first Oracle home (for example, from 
C:\oracle\ora81 to X:\xyz\oracle\abc).

2. Install any Oracle Database and change default Oracle Universal Installer 
settings for the second Oracle home (for example, from C:\oracle\ora10 to 
X:\pqr).

Table 2–3 shows the nondefault OFA database settings for example 2.

The resulting directory tree would look similar to this:

X:\pqr                         --Oracle home 2
  \bin
  \network
X:\xyz
    \oracle                    --ORACLE_BASE for both Oracle homes
      \abc                     --Oracle home 1
        \bin
        \network
      \admin
        \DB_NAME1 
          \adhoc
          \bdump
          \cdump
          \create
          \exp
          \pfile
          \udump
        \DB_NAME2 
          \...
      \oradata
        \DB_NAME1 

Table 2–3 Nondefault OFA Database Settings: Example 2

Setting Value

ORACLE_BASE X:\xyz\oracle 

(same for both Oracle homes)

Oracle home 1 X:\xyz\oracle\abc 

Oracle home 2 X:\pqr 
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          control01.ctl
          control02.ctl
          control03.ctl
          indx01.dbf
          rbs01.dbf
          system01.dbf
          temp01.dbf
          users01.dbf
          redo01.log
          redo02.log
          redo03.log
        \DB_NAME2 

Increasing Reliability and Performance
One of the basic goals of OFA is to increase reliability and performance by 
distributing I/O loads across different physical drives. Two ways to do that are:

■ Disk Mirroring

■ Disk Striping

Disk Mirroring
Oracle Database log files and database files can be separated and treated with 
different levels of hardware reliability. Oracle Database log files are highly reliable 
to start with, because they are stored redundantly. Creating similar reliability for 
database files may require you to duplicate all of your data, using disk mirrors. 

Disk mirroring usually involves two or more identical drives and either a hardware 
controller or Windows Disk Administrator. If one disk fails, then the other disk(s) 
can be used to recover data that would otherwise be lost. Using one of the disks to 
recover lost data may involve "breaking" the mirror. If the mirror breaks, then you 
must build a new mirror.

Disk mirroring is part of some levels of Redundant Array of Independent Disks 
(RAID) configurations, provided by the disk controller. The RAID level determines 
the amount of redundancy. Some RAID levels can use the "hot swapping" feature, 
which means that you can replace a bad disk with a good one without turning off 
the computer or losing functionality.
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Disk Striping
How you set up disks for use in a database depends on the number of disks and the 
type of hard disk controllers available. If the hard disk controllers support both 
striping and mirroring, then Oracle recommends you configure the controllers to 
support striping.

Some controllers are configured at system startup time by issuing a keyboard 
sequence that brings up configuration programs written by the controller 
manufacturer. One goal is to stripe as many drives together as possible by 
configuring the controllers. Each stripe shows up as one logical device.

Striping provides significant performance advantages. All the space from the 
striped drives appears as a single logical drive. Furthermore, the space is used by 
interlacing "stripes" of space from all of the disks in the stripe. This means that a 
large file uses some space from the first disk, then some from the second disk and so 
on to the last disk and then starting back at the first disk again. Each file can be 
spread over all of the striped disks. Data in such a file may be accessed randomly by 
more than one CPU without contention.

Controllers that support striping usually provide caching as well. This means that 
data can be written to the controller and cached and saved for a time in storage not 
on the disk. Data that is read can be cached on the controller in a similar fashion. 
Read caching is not necessary for Oracle Database, because all database reads are 
cached already in the System Global Area (SGA). The value of parameter DB_
CACHE_SIZE in the initialization parameter file (init.ora) determines the buffer 
size that can be used in the SGA. This value also configures Oracle Database on 
startup.

Using Raw Partitions for Tablespaces
A raw partition is a portion of a physical disk that is accessed at the lowest possible 
level. I/O of a raw partition improves performance by approximately 5% to 10% 
compared to I/O of a partition containing a file system. Therefore, Oracle 
encourages you to use raw partitions for your tablespace files. 

Comparison Between OFA on Windows and UNIX
You implement OFA on Windows and UNIX in the same way. However, differences 
exist with regard to the following:

■ Directory Naming

■ ORACLE_BASE Directory
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■ Support for Symbolic Links on Windows

Directory Naming
Top-level names of the OFA directory tree differ between Windows and UNIX. 
However, main subdirectory and filenames are the same on both operating systems.

ORACLE_BASE Directory 
On Windows, ORACLE_BASE is associated with an Oracle home directory. ORACLE_
BASE is defined in the registry (for example, in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME).

On UNIX, ORACLE_BASE is associated with a UNIX user's environment.

Support for Symbolic Links on Windows
The goal of OFA is to place all Oracle software under one ORACLE_BASE directory 
and to spread files across different physical drives as your databases increase in 
size. 

On UNIX, although everything seems to be in one directory on the same hard drive, 
files can be on different hard drives if they are symbolically linked or have that 
directory as a mount point.

Windows currently does not support symbolic links, so datafiles will not all show 
up under a single directory like on UNIX. Instead, you may have oradata 
directories on multiple drives, with datafiles in each one. In this way, you still get 
OFA benefits, even though datafiles are not all visible in a single directory.

Oracle recommends that you use one logical drive to store your database 
administration files and that you place other files, as needed, on other logical drives 
in an oradata\DB_NAME directory.

In the following example, there are four logical drives for a database named prod:

■ C:\ contains an Oracle home and database administration files.

■ F:\ contains redo log files. (F:\ drive could also represent two physical drives 
that have been striped to increase performance.)

■ G:\ contains one of the control files and all tablespace files. (G:\ drive could 
also use a RAID Level-5 configuration to increase reliability.)

See Also: Your UNIX operating system-specific administrator's 
reference for information about OFA on UNIX
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■ H:\ contains the second control file.

The directory structure would look similar to this:

C:\oracle             --First logical drive
    \ora10            --Oracle home
      \bin            --Subtree for Oracle binaries
      \network        --Subtree for Oracle Net
      \...
    \admin            --Subtree for database administration files
      \prod           --Subtree for prod database administration files
        \adhoc        --Ad hoc SQL scripts
        \adump        --Audit files
        \bdump        --Background process trace files
        \cdump        --Core dump files
        \create       --Database creation files
        \exp          --Database export files
        \pfile        --Initialization parameter file
        \udump        --User SQL trace files

F:\oracle             --Second logical drive (two physical drives, striped)
    \oradata          --Subtree for Oracle Database files
      \prod           --Subtree for prod database files
        redo01.log    --Redo log file group one, member one
        redo02.log    --Redo log file group two, member one
        redo03.log    --Redo log file group three, member one

G:\oracle             --Third logical drive (RAID level 5 configuration)
    \oradata          --Subtree for Oracle Database files
      \prod           --Subtree for prod database files
        control01.ctl --Control file 1
        indx01.dbf    --Index tablespace datafile
        rbs01.dbf     --Rollback tablespace datafile
        system01.dbf  --System tablespace datafile
        temp01.dbf    --Temporary tablespace datafile
        users01.dbf   --Users tablespace datafile

H:\oracle             --Fourth logical drive
    \oradata          --Subtree for Oracle Database files
      \prod           --Subtree for prod database files
        control02.ctl --Control file 2
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3
Database Tools on Windows

Oracle Database for Windows includes various tools to perform database functions. 
This chapter describes preferred tools to perform common database administration 
tasks and explains how tools can be started.

Unless otherwise noted, features described in this guide are common to Oracle 
Database Enterprise Edition, Oracle Database Standard Edition, and Oracle 
Database Personal Edition.

This chapter contains these topics:

■ Choosing a Database Tool

■ Starting Database Tools

■ Using SQL*Loader

■ Using Windows Tools

■ Optional Windows Diagnostic and Tuning Utilities
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Choosing a Database Tool
Database tools is a collective term for tools, utilities, and assistants that you can use 
to perform database administration tasks. Some database tools perform similar 
tasks, though no one database tool performs all database administration tasks. The 
following sections indicate which database tools can be used on particular 
operating systems and preferred tools to use for common database administration 
tasks.

Database Tools and Operating System Compatibility
Almost all database tools are available on all supported versions of Windows. The 
exceptions are:

■ Oracle Advanced Security includes Enterprise Security Manager Console and 
Oracle Wallet Manager. These are available only with Oracle Database 
Enterprise Edition and Oracle Database Personal Edition, and not Oracle 
Database Standard Edition. To learn whether they were installed or not, see 
your installActions.log at C:\program 
files\Oracle\Inventory\logs.

■ Oracle Enterprise Manager and its optional management packs have additional 
integrated tools to assist in managing databases. See Oracle Enterprise Manager 
Concepts for more information.

■ Microsoft Management Console must be obtained from Microsoft Corporation 
for use with Windows NT 4.0.

Note: Oracle Server Manager is no longer shipped as of Oracle9i 
release 2 (9.2). All Server Manager text and examples have been 
replaced with SQL*Plus equivalents. 

Additionally, connecting to the database as CONNECT INTERNAL is 
no longer supported.

SQL> CONNECT INTERNAL/password@tnsalias 

has been replaced by:

SQL> CONNECT SYS/password@tnsalias AS SYSDBA 
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Preferred Database Tools
Table 3–1 lists various database tools you can use to perform common database 
administration tasks. Oracle recommends you use tools listed in the "Preferred 
Database Tool" column of the table. After choosing a tool to perform a task, go to 
Table 3–2, " Starting Database Tools from the Start Menu",  on page 3-7 for 
instructions on how to start the tool.

Note: The VOLSIZE parameter for Export and Import utilities is 
not supported on Windows. If you attempt to use the utilities with 
the VOLSIZE parameter, then error LRM-00101 occurs. For 
example:

D:\> exp system/manager full=y volsize=100m;
LRM-00101: unknown parameter name 'volsize'
EXP-00019: failed to process parameters, type 'EXP HELP=Y' for 
help
EXP-00000: Export terminated unsuccessfully

Table 3–1 Preferred Database Tools

Administration Task Preferred Tool Other Tools

Create a database Database Configuration Assistant SQL*Plus Worksheet

Delete database services Database Configuration Assistant ORADIM

Start a database Oracle Enterprise Manager Console SQL*Plus or SQL*Plus Worksheet

Shut down a database Oracle Enterprise Manager Console Control Panel

SQL*Plus or SQL*Plus Worksheet

Change database passwords ORAPWD ORADIM

Migrate database users to a 
directory

User Migration Utility None

Migrate a database Oracle Database Upgrade Assistant Migration Utility (MIG)

Upgrade a database Oracle Database Upgrade Assistant Run provided scripts in SQL*Plus

Export data Data Pump Export (EXPDP) Export (EXP)

Import data Data Pump Import (IMPDP) Import (IMP)

Load data Oracle Enterprise Manager Load Wizard SQL*Loader (SQLLDR)
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Back up database Oracle Enterprise Manager Backup 
Wizard

Recovery Manager (RMAN)

OCOPY

Recover database Oracle Enterprise Manager Recovery 
Wizard

Recovery Manager (RMAN)

OCOPY

Authenticate database 
administrators and users

Oracle Enterprise Manager Console SQL*Plus or SQL*Plus Worksheet

Windows operating system

Oracle Administration Assistant for 
Windows

Store encrypted and 
decrypted Oracle Wallet 
(Oracle Advanced Security 
and Oracle PKI integration)

Oracle Wallet Manager None

Grant database roles Oracle Enterprise Manager Console Local Users and Groups

User Manager

SQL*Plus

Create database objects Oracle Enterprise Manager Console SQL*Plus

Table 3–1 (Cont.) Preferred Database Tools

Administration Task Preferred Tool Other Tools
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Starting Database Tools
This section describes how to start each of the database tools in the following 
categories:

■ Starting Database Tools in Multiple Oracle Homes

■ Starting Database Tools from the Start Menu

■ Starting Database Tools from the Command Line

Note: The following refer to items in Table 4-7.

■ ORADIM can only set a password when none was previously 
set. If a password has been previously set, then ORADIM can 
change it only by deleting and re-creating Oracle Database 
services.

■ User Migration Utility can migrate local or external users to 
enterprise users. For more information, see "Using the User 
Migration Utility" in Oracle Advanced Security Administrator's 
Guide.

■ Oracle Database Upgrade Assistant can upgrade the following 
databases to the current release: Oracle7 release 7.3.4, Oracle8 
release 8.0.6, Oracle8i releases 8.1.5, 8.1.6, and 8.1.7, Oracle9i 
releases 1 (9.0.1) and 2 (9.2). It cannot be used to upgrade an 
earlier Oracle7 release to a later Oracle7 release. See your 
Oracle7 for Windows NT documentation for information on 
how to upgrade from one Oracle7 database to another.

■ Data Pump Export and Data Pump Import are preferred for 
Oracle Database 10g data; Export and Import are preferred for 
earlier data.

■ When upgrading a database, the provided scripts in SQL*Plus 
are required when upgrading Oracle Real Application Clusters 
systems.

■ If you back up files while you are shutting down the database, 
then your backup will be invalid. You cannot use an invalid 
backup to restore files at a later date.

■ For guidelines on creating database objects, see Oracle Database 
Administrator's Guide. 
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■ Starting Windows Tools

You will be referred back to this section for database tool startup procedures as you 
use this guide.

Starting Database Tools in Multiple Oracle Homes
If you have multiple Oracle homes on your computer from previous releases, then 
see Chapter 2, "Multiple Oracle Homes and Optimal Flexible Architecture" for a 
description of differences between Oracle homes before and after Oracle Database 
10g.

Starting Tools from Oracle8 Release 8.0.4 and Later 8.0.x Multiple Oracle Homes
If you are using multiple Oracle homes, then the command to start a tool from any 
home other than the first includes a HOME_NAME, where HOME_NAME indicates 
the name of that Oracle home. The first Oracle home created on your computer does 
not have HOME_NAME appended to the group. 

To start Oracle Administration Assistant for Windows from the first Oracle home, 
choose Start > Programs > Oracle > Configuration and Migration Tools > 
Administration Assistant for Windows.

To start Oracle Administration Assistant for Windows from an additional Oracle 
home, choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Starting Tools from Oracle8i Release 8.1.3 and Later Multiple Oracle Homes
Beginning in Oracle8i release 8.1.3, each Oracle home, including the first Oracle 
home you create on your computer, has a unique HOME_NAME. To start Oracle 
Administration Assistant for Windows from any Oracle home, choose Start > 
Programs > Oracle - HOME_NAME > Configuration and Migration Tools > 
Administration Assistant for Windows.

Starting Database Tools from the Start Menu
Table 3–2 describes how to start assistants and other tools from the Start Menu. It 
also tells where to go for further information on using these products. All Start 
Menu paths begin with Start > Programs > Oracle - HOME_NAME >.
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Note: When you use an assistant, you must have read and write 
access to the directory where database files will be moved or 
created. To create an Oracle Database, you must have an 
administrative privilege. If you run Database Configuration 
Assistant from an account that is not part of the Administrators 
group, then the tool exits without completing the operation.

Note: All Start Menu paths begin with choose Start > Programs > 
Oracle - HOME_NAME >. 

Table 3–2 Starting Database Tools from the Start Menu

Tool Start Menu Path More Information

Oracle Administration 
Assistant for Windows

Configuration and Migration Tools > 
Administration Assistant for 
Windows 

Chapter 9, "Authenticating Database Users 
with Windows"

Oracle Database 
Upgrade Assistant

Configuration and Migration Tools > 
Database Upgrade Assistant

Oracle Database Upgrade Guide

Database Configuration 
Assistant

Configuration and Migration Tools > 
Database Configuration Assistant

"Creating a Database on Windows Using 
Database Configuration Assistant" on 
page 4-3

Oracle Enterprise 
Manager Configuration 
Assistant

Configuration and Migration Tools > 
Enterprise Manager Configuration 
Assistant

Oracle Enterprise Manager Grid Control 
Installation and Basic Configuration

Oracle Enterprise 
Manager Console

Enterprise Manager Console Oracle 2 Day DBA

Oracle INTYPE File 
Assistant

Application Development > INTYPE 
File Assistant

Oracle INTYPE File Assistant online help

Oracle Locale Builder Configuration and Migration Tools > 
Locale Builder

Oracle Database Globalization Support Guide

Microsoft ODBC 
Administrator

Configuration and Migration Tools > 
Microsoft ODBC Administration

Microsoft ODBC Administration online help



Starting Database Tools

3-8 Oracle Database Platform Guide

Starting Database Tools from the Command Line
Table 3–3 describes how to start Oracle Database tools from the command line, and 
where to go for further information on using these products.

Oracle Migration 
Workbench

Configuration and Migration Tools > 
Migration Workbench

Oracle Migration Workbench Release Notes 

Oracle Migration Workbench Reference Guide for 
Microsoft SQL Server and Sybase Adaptive Server 
Migrations

Oracle Migration Workbench Reference Guide for 
Microsoft Access 2.0, 95, 97, 2000 Migrations

Oracle Net 
Configuration Assistant

Configuration and Migration Tools > 
Net Configuration Assistant

Oracle Net Services Administrator's Guide

Oracle Net Manager Configuration and Migration Tools > 
Net Manager

Oracle Net Services Administrator's Guide

Oracle Directory 
Manager

Integrated Management Tools > 
Oracle Directory Manager

Oracle Internet Directory Administrator's Guide

Oracle Counters for 
Windows Performance 
Monitor

Configuration and Migration Tools > 
Oracle Counters for Windows 
Performance Monitor

"Using Oracle Counters for Windows 
Performance Monitor" on page 7-2

Pro*C/C++ Application Development > 
Pro*C/C++

Pro*C/C++ Programmer's Guide

SQL*Plus Application Development > 
SQL*Plus

SQL*Plus User's Guide and Reference

"Starting and Shutting Down a Database with 
SQL*Plus" on page 6-8

SQL*Plus Worksheet Application Development > 
SQL*Plus Worksheet

Integrated Management Tools > 
SQL*Plus Worksheet

Oracle Enterprise Manager Administrator's 
Guide

Oracle Wallet Manager Integrated Management Tools > 
Wallet Manager

Oracle Advanced Security Administrator's Guide

Table 3–2 (Cont.) Starting Database Tools from the Start Menu

Tool Start Menu Path More Information
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Table 3–3 Starting Database Tools from the Command Line

Tool Enter at Prompt More Information

Oracle Enterprise 
Manager Console

C:\> oemapp console Oracle 2 Day DBA

DBVERIFY C:\> dbv

DBVERIFY starts and prompts you for a 
filename parameter. To obtain a list of 
parameters, enter:

C:\> dbv help=y

Oracle Database Utilities

Data Pump 
Export

C:\> expdp username/password

EXPDP starts and prompts you for 
parameters. To obtain a list of these 
parameters, enter:

C:\> expdp help=y

Oracle Database Utilities for instructions on 
use of Data Pump Export

Oracle Database Error Messages for 
information on error messages

Data Pump 
Import

C:\> impdp username/password

IMPDP starts and prompts you for 
parameters. To get a list of these parameters, 
enter:

C:\> impdp help=y

Oracle Database Utilities for instructions on 
use of Data Pump Import

Oracle Database Error Messages for 
information on error messages

Export C:\> exp username/password

EXP starts and prompts you for parameters. 
To obtain a list of these parameters, enter:

C:\> exp help=y

Oracle Database Utilities for instructions on 
use of Export

Oracle Database Error Messages for 
information on error messages

Import C:\> imp username/password

IMP starts and prompts you for parameters. 
To get a list of these parameters, enter:

C:\> imp help=y

Oracle Database Utilities for instructions on 
use of Import

Oracle Database Error Messages for 
information on error messages

Migration Utility C:\> mig

To obtain a list of parameters, enter:

C:\> mig help=y

Oracle Database Upgrade Guide

OPERFCFGver C:\> OPERFCFGver "Modifying Oracle Counters for Windows 
Performance Monitor Parameters" on 
page 14-19
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ORADIM C:\> oradim options

To get a list of ORADIM options, enter either 
of the following:

C:\> oradim 

C:\> oradim -? | -h | -help

"Using ORADIM to Administer an Oracle 
Database Instance" on page 4-18

Password Utility 
(ORAPWD)

C:\> orapwd

Password file is hidden. Use Windows 
Explorer to see it in a file list. Choose View > 
Options > View > Show All Files 

"Creating and Populating Password Files" on 
page 6-14

Recovery 
Manager 
(RMAN)

C:\> rman parameters Oracle Database Backup and Recovery Basics

SQL*Plus 
(SQLPLUS)

C:\> sqlplus SQL*Plus User's Guide and Reference 

"Starting and Shutting Down a Database 
with SQL*Plus" on page 6-8

SQL*Loader 
(SQLLDR)

C:\> sqlldr

SQL*Loader displays a Help screen with 
available keywords and default values.

Oracle Database Utilities 

Oracle Database Error Messages 

"Starting Windows Tools" on page 3-11

TKPROF C:\> tkprof Oracle Database Performance Tuning Guide 

User Migration 
Utility

C:\> umu parameters

To get a list of parameters, enter:

C:\> umu help=yes

"Using the User Migration Utility" in Oracle 
Advanced Security Administrator's Guide

Note: Three special conditions apply when running Export or 
Import utilities on Windows. First, default values for BUFFER and 
RECORDLENGTH parameters are 4 KB and 2 KB respectively. This 
default RECORDLENGTH parameter does not depend on the value of 
BUFSIZ defined in the system header file. If you specify a value 
larger than USHRT_MAX (64 KB), you will get a warning message. 
Second, the VOLSIZE parameter is not supported. Third, to export 
an entire database, you must use the EXP_FULL_DATABASE role.

Table 3–3 (Cont.) Starting Database Tools from the Command Line

Tool Enter at Prompt More Information
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Starting Windows Tools
Table 3–4 describes how to start each Windows tool and where to go for more 
information on using these products.

Table 3–4 Starting Windows Tools

Tool Start Procedure More Information

Event Viewer Choose Start > Programs > 
Administrative Tools > Event 
Viewer

"Using Event Viewer to Monitor a Database" on 
page 3-15

Your Windows documentation

Microsoft 
Management 
Console (MMC)1

Choose Start > Programs > 
Oracle - HOME_NAME > 
Configuration and Migration 
Tools > Administration 
Assistant for Windows 

Your Windows documentation

Oracle Counters 
for Windows 
Performance 
Monitor

Choose Start > Programs > 
Oracle - HOME_NAME > 
Configuration and Migration 
Tools > Oracle Counters for 
Windows Performance Monitor

"Using Oracle Counters for Windows Performance 
Monitor" on page 7-2

Your Windows documentation

Registry Editor At the command prompt enter:

C:\> regedt32

"Using Registry Editor to Modify Configuration 
Information" on page 3-17

Chapter 14, "Configuration Parameters and the 
Registry"

Your Windows documentation

Task Manager Right-click the Task Bar and 
choose Task Manager

"Using Task Manager to Monitor Applications and 
Processes" on page 3-17

Your Windows documentation

Local Users and 
Groups

Choose Start > Settings > 
Control Panel. Double-click 
Administrative Tools. 
Double-click Computer 
Management. In the console 
tree, click Local Users and 
Groups.

"Using Local Users and Groups to Manage Users and 
Groups" on page 3-18

Your Windows documentation

User Manager Choose Start > Programs > 
Administrative Tools > User 
Manager

"Using User Manager to Manage Users" on page 3-18

Chapter 9, "Authenticating Database Users with 
Windows"

Your Windows documentation
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Using SQL*Loader
This section describes Windows-specific information for using SQL*Loader 
(SQLLDR).

Windows Processing Options
This section discusses possible values for the Operating System Dependent (OSD) 
file processing specifications string option, referred to in "SQL*Loader Control File 
Reference" in Oracle Database Utilities. 

Default (No Processing Option) or "str terminator_string"
Stream record format in which each record is terminated by a record terminator. If 
"str terminator_string" is not specified, then the record terminator defaults to either 
the Windows-style record terminator (the two-character sequence carriage return, 
\r, followed by line feed, \n) or the UNIX-style record terminator (single-character 
line feed, \n). Maximum record size is 48 KB.

When processing stream format data files, SQL*Loader can usually recognize record 
terminators automatically, whether they are Windows-style or UNIX-style. So you 
usually do not need to specify which record terminator you are using.

For external table loads, however, only Windows-style record terminators are 
recognized automatically. If your data file contains UNIX-style record terminators, 
you must specify the record terminator. If you are using SQL*Loader (with 
external_table option), then specify the UNIX-style record terminator by 
specifying "str '\n'" on the INFILE line in the SQL*Loader control file. For 
example: 

INFILE mydata.dat "str '\n'"

You can also specify the record terminator in hex, by specifying "str x'0a'" 
(assuming an ASCII-based character set). For example: 

INFILE mydata.dat "str x'0a'"

Note that the "0" (zero) before the "a" is required. If you are using SQL with an 
access parameter list to create the external table, then you must specify '\n' in a 
RECORDS DELIMITED BY clause. For example: 

RECORDS DELIMITED BY '\n'

1 MMC is started whenever Oracle Administration Assistant for Windows is started.
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You can also use a hex string in this case. For example: 

RECORDS DELIMITED BY 0x'0a'

Note that in this case, the "0" (zero) before the "x" and the "0" (zero) before the "a" 
are both required.

"FIX n"
Fixed record format in which each record is exactly n bytes long. Record 
terminators are not required with fixed record format. If the record includes a 
record terminator, then the record terminator bytes are included in the number of 
bytes n.

"VAR n"
Variable record format in which the length of each record in a character field is 
included at the beginning of each record in the datafile. Record terminators are not 
required with the variable record format. This format provides some added 
flexibility over the fixed record format and a performance advantage over the 
stream record format. You can specify a datafile that is to be interpreted as being in 
variable record format as follows:

INFILE "mydata.dat" "var n"

In this example, n specifies the number of bytes in the record length field. If n is not 
specified, SQL*Loader assumes a length of 5 bytes. Specifying n larger than 40 will 
result in an error. Lengths are always interpreted in bytes, even if character-length 
semantics are in effect for the file. This is necessary because the file could contain a 
mix of fields, some processed with character-length semantics and others processed 
with byte-length semantics.

Case Study Files
The distribution media for SQL*Loader contains case study files for control files, 
datafiles, and setup files in ulcase1,...ulcase11 in the following directory: 
Oracle_Home\rdbms\demo.
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Specifying the Bad File
When SQL*Loader executes, it can create a file called a bad file or reject file in which 
it places records that were rejected because of formatting errors or because they 
caused Oracle Database errors. If you have specified that a bad file is to be created, 
it overwrites any existing file with the same name; ensure that you do not overwrite 
a file you wish to retain.

Control File Conventions
When preparing SQL*Loader control files (.ctl), you must follow certain syntax 
and notational conventions. 

In full path descriptions, backslashes do not require escape characters or other 
special treatment. When embedding a single or double quotation mark inside a 
string delimited by double quotation marks, place a backslash escape character 
before the embedded quotation mark.

When specifying datatypes in the SQL*Loader control file, note that the default 
sizes of native datatypes shown in Table 3–5 are specific to Windows. These 
datatypes can be loaded with correct results only between systems where they have 
the same length in bytes. You cannot override these defaults in the control file. If the 
byte order is different between the systems, you can indicate the byte order of the 
data with the BYTEORDER parameter, or you can place a byte-order mark (BOM) in 
the file.

Table 3–5 Default Sizes of Native Datatypes

Native Datatypes Default Field Length

DOUBLE 8

FLOAT 4

INTEGER1

1 The default listed is correct if INTEGER is specified without 
a size. But INTEGER(n) is also allowed. In that case, n 
specifies the size of the INTEGER field in bytes.

4

SMALLINT 2

See Also: Oracle Database Utilities for a complete list of options 
and instructions on using SQL*Loader
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Using Windows Tools
You can use Windows tools in various ways to manage Oracle Database:

■ Using Event Viewer to Monitor a Database

■ Using Microsoft Management Console to Administer a Database

■ Using Oracle Counters for Windows Performance Monitor

■ Using Registry Editor to Modify Configuration Information

■ Using Task Manager to Monitor Applications and Processes

■ Using Local Users and Groups to Manage Users and Groups

■ Using User Manager to Manage Users

Using Event Viewer to Monitor a Database
Event Viewer lets you monitor events in your system. An event is an important 
occurrence in the system or application (such as Oracle Database) that requires user 
notification. While messages for major events can appear on-screen as you work at 
your computer, events not requiring your immediate attention are recorded by 
Windows in the Event Viewer log file. You can then view this information at your 
convenience.

Event Viewer can be used to monitor Oracle Database events, such as:

■ Initialization of System Global Area for active instance

■ Initialization of Program Global Area (PGA) for background processes of active 
instance

■ Connection to Oracle Database using AS SYSDBA

In addition, the operating system audit trail is logged to Event Viewer.

Using Microsoft Management Console to Administer a Database
Microsoft Management Console provides a central location for network 
administration. Microsoft Management Console hosts applications (called snap-ins) 
that administrators can use to manage their networks. Oracle snap-ins enable 
database administrators to:

See Also: Chapter 7, "Monitoring a Database on Windows" for 
specific instructions on accessing and using Event Viewer to 
monitor Oracle Database events
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■ Configure Oracle Database administrators, operators, users, and roles so the 
Windows operating system can authenticate them 

■ Configure OracleServiceSID

■ Modify registry parameters for all Oracle homes on the computer

■ Modify the computer hostname, username, and password for the database 
being monitored by Oracle Counters for Windows Performance Monitor

■ View and terminate an Oracle Database thread

Using Oracle Counters for Windows Performance Monitor
Oracle Counters for Windows Performance Monitor is integrated into Windows 
Performance Monitor. This tool enables you to view performance of processors, 
memory, cache, threads, and processes. Performance information provided includes 
device usage, queue lengths, delays, throughput measurements, and internal 
congestion measurements. This information is provided as charts, alerts, and 
reports.

You can use Oracle Counters for Windows Performance Monitor to monitor key 
Oracle Database information, such as:

■ Library cache

■ Buffer cache

■ Data dictionary cache

■ Redo log buffer cache

■ Thread activity

You can use your findings to improve database performance. 

See Also: "Using Oracle Counters for Windows Performance 
Monitor" on page 7-2 for specific instructions on accessing and 
using Oracle Counters for Windows Performance Monitor to 
monitor Oracle Database performance
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Using Registry Editor to Modify Configuration Information
Oracle Database stores its configuration information in a structure known as the 
registry. You can view and modify this configuration information through Registry 
Editor. The registry contains configuration information for your computer and must 
not be accessible for editing by inexperienced users. Only experienced 
administrators should view and change this information.

Registry Editor displays configuration information in a format similar to Windows 
Explorer. In the left-hand window is a tree-like format consisting of keys (or 
folders). When one of these keys is highlighted, parameters and values assigned to 
that key are displayed in the right-hand window. 

When you install products from your CD-ROM, configuration parameters are 
automatically entered in the registry. These parameters are read each time your 
Windows computer is started and whenever an Oracle Database product is started. 
These parameters include settings for:

■ Oracle home directory

■ Language

■ Company name

■ Oracle home subdirectories for individual products

■ Individual products such as SQL*Plus

■ Services

Using Task Manager to Monitor Applications and Processes
Task Manager has three tabs:

■ Applications tab displays what applications are running. This is useful for 
identifying and ending unresponsive tasks. (Oracle Database does not appear 
as an application because it runs as a service.)

■ Processes tab displays details of currently running processes and their resource 
usage. Columns are customizable.

See Also: Chapter 14, "Configuration Parameters and the 
Registry" for definitions of Oracle Database configuration 
parameters and specific instructions on using the registry to modify 
Oracle Database configuration parameters
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■ Performance tab graphically displays real-time CPU and memory usage, which 
is useful for spotting sudden changes.

Using Local Users and Groups to Manage Users and Groups
Local Users and Groups enables you to manage users and groups on Windows 2000 
and Windows XP. Specifically, you can:

■ Create and modify local user accounts 

■ Create and modify user profiles

■ Create, add, and delete local groups

Using User Manager to Manage Users
User Manager enables you to manage Windows computer security and create user 
accounts on Windows NT. With User Manager, you can:

■ Grant Oracle Database roles

■ Use operating system authentication for user accounts (For example, you can 
grant DBA access to a Windows user.)

■ Create a Windows user account that enables you to make secure client 
connections to Oracle Database without a password

Optional Windows Diagnostic and Tuning Utilities
Windows 2000 Resource Kit includes several diagnostic and tuning utilities.

QuickSlice provides a quick overview of what is occurring on the system, using a 
graphical user interface.

■ Distinguishes between time spent in user mode and kernel mode

■ Imposes low overhead on the system (unlike Performance Monitor)

■ Shows a continuous display, rather than just a snapshot

■ Opens a window with more details when you double-click a process 

Process Viewer summarizes resource usage by a process.

See Also: "Manually Administering External Users and Roles" on 
page 10-38 for specific instructions on using User Manager to 
perform Oracle Database administration
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Process Explode provides a detailed display of resource usage by a process.

Task List displays resource usage and other details of a process when its processor 
identifier or process name is given as an argument. This tool also displays a list of 
executables and DLLs associated with a process. 

See Also:

■ Appendix E, "Using Oracle Database on Windows 2000"

■ Chapter 6, "Administering a Database on Windows" for 
OracleServiceSID configuration tasks

■ Chapter 7, "Monitoring a Database on Windows" for thread 
management tasks

■ Chapter 9, "Authenticating Database Users with Windows" for 
authentication tasks

■ Chapter 14, "Configuration Parameters and the Registry" and 
Chapter 7, "Monitoring a Database on Windows" for Oracle 
Counters for Windows Performance Monitor tasks

■ Oracle Database Installation Guide for Windows for components 
available for installation
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4
Postinstallation Database Creation on

Windows

This chapter describes how to create a database after installing Oracle Database, 
using either Database Configuration Assistant or command-line tools.

This chapter contains these topics:

■ Naming Conventions for Oracle Database

■ Accessing Data Files and Log Files on Remote Computers

■ Creating a Database on Windows Using Database Configuration Assistant

■ Creating a Database on Windows Using Command-Line Tools

■ Using ORADIM to Administer an Oracle Database Instance
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Naming Conventions for Oracle Database
All mounted instances of Oracle Database in a network must have unique database 
names. When a database is created, a name is associated with it and stored in its 
control files. If you provide the database keyword, either in the CREATE 
DATABASE statement or when prompted by Database Configuration Assistant, then 
that value becomes the name for that database. 

If you attempt to mount two instances of Oracle Database with the same database 
name, then you receive the following error during mounting of the second 
database:

ORA-01102: cannot mount database in EXCLUSIVE mode

If there are two or more instances of Oracle Database on the same computer, but 
located in different Oracle homes, then the following rules apply:

■ Each database name must be unique

■ Each SID must be unique

To change the name of an existing database, you must use the CREATE 
CONTROLFILE statement to re-create your control files and specify a new database 
name. This restriction exists only for Oracle8i and later versions. Any Oracle7 
release 7 instances running simultaneously with an Oracle Database 10g instance 
are not subject to this restriction.

Accessing Data Files and Log Files on Remote Computers
Oracle Database can access database files on a remote computer using Universal 
Naming Convention (UNC), but it may degrade database performance and network 
reliability. UNC is a PC format for specifying locations of resources on a local area 
network. UNC uses the following format:

\\server-name\shared-resource-path-name

Note: Directory path examples in this chapter follow Optimal 
Flexible Architecture (OFA) guidelines. An example of an OFA 
path is ORACLE_BASE\ORACLE_HOME\rdbms\admin. If you 
specified non-OFA directories during installation, then your 
directory paths will differ.
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For example, UNC specification for file system01.dbf in directory 
C:\oracle\oradata\orcl on shared server argon would be:

\\argon\oracle\oradata\orcl\system01.dbf

Locations of archive log files cannot be specified using UNC. Always set 
initialization parameter LOG_ARCHIVE_DEST_n to a mapped drive. If you set it to a 
UNC specification, then Oracle Database does not start and you receive the 
following errors:

ORA-00256: error occurred in translating archive text string '\meldell\rmdrive'
ORA-09291: sksachk: invalid device specified for archive destination 
OSD-04018: Unable to access the specified directory or device
O/S-Error: (OS 2) The system cannot find the file specified

An ORA-00256 error also occurs if you enter \\\meldell\rmdrive or 
\\\meldell\\rmdrive. Control files required the additional backslashes for 
Oracle8 release 8.0.4, but redo log files and datafiles did not.

Creating a Database on Windows Using Database Configuration 
Assistant

Oracle recommends you use Database Configuration Assistant to create a database, 
because it is easier. It offers the same interface and operates the same way on all 
supported platforms, so no step-by-step procedures or screen shots are included 
here.

Database Configuration Assistant enables you to:

■ Create a Database

■ Configure Database Options in a database

■ Delete a Database

■ Manage Templates

An initialization parameter file is an ASCII text file containing parameters. It can 
be used to create and modify a database using command-line tools. When you 
create a database using Database Configuration Assistant, a server parameter file 
(SPFILE) is created from the initialization parameter file, and the initialization 

See Also: Oracle 2 Day DBA for instructions on using Database 
Configuration Assistant
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parameter file is renamed. Oracle does not recognize the renamed file as an 
initialization parameter file, and it is not used after the instance is started.

If you want to modify an instance created with Database Configuration Assistant 
after it starts up, you must use ALTER SYSTEM statements. You cannot change the 
SPFILE itself, because it is a binary file that cannot be browsed or edited using a text 
editor. The location of the newly-created SPFILE is ORACLE_BASE\ORACLE_
HOME\database. The SPFILE filename is spfileSID.ora. 

Creating a Database on Windows Using Command-Line Tools
This section describes how to create a new database manually. As part of its 
database software files, Oracle Database provides a sample database creation script 
and a sample initialization parameter file, both of which can be edited to suit your 
needs. Alternatively, if you have an existing script you can use it as-is to create a 
database manually or edit it using the sample database creation script as a guide. 

Database creations are of three types:

■ Copy an existing database and delete the old database.

■ Copy an existing database and keep the old database.

■ Create a new database when no database exists on your system.

Table 4–1 summarizes tasks involved in creating a new database for each of these 
database creation categories. Each step is explained in detail in the following 
subsections.

See Also: "Managing Initialization Parameters Using a Server 
Parameter File" in Oracle Database Administrator's Guide

Table 4–1 Manual Database Creation Tasks

Task

Copy existing 
database and delete 
old database

Copy existing 
database and keep 
old database

Create new database when 
no database exists on 
system

Creating Directories Yes Yes Yes

Exporting an Existing 
Database

Yes Maybe1 Not applicable

Deleting Database Files Yes No Not applicable

Modifying the Initialization 
Parameter File

Yes Yes Yes
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We use an example in the following sections to demonstrate how to create a 
database. In this example, the existing database is the starter database with a SID of 
orcl located in directory C:\oracle\oradata\orcl. You will copy orcl to a 
new database with a database name and SID of prod located in directory 
C:\oracle\oradata\prod. You will then delete starter database orcl.

Creating Directories
Create the following directories in which to put administration and database files 
for new database prod:

■ C:\oracle\admin\prod 

■ C:\oracle\admin\prod\bdump 

Starting an Oracle Database 
Instance

Yes Yes Yes

Creating and Starting an 
Oracle Database Service

No Yes Yes

Putting the CREATE 
DATABASE Statement in a 
Script

Yes Yes Yes

Running the CREATE 
DATABASE Script

Yes Yes Yes

Importing a Database Yes Maybe2 Not applicable

Updating ORACLE_SID in 
the Registry

No Only if you change 
the default SID

Yes

Backing Up the New 
Database

Yes Yes Yes

1 Yes if you copy data from the existing database to the new database; no otherwise.
2 Yes if you import tables and other objects exported from the existing database; no otherwise.

Note: In this example, ORACLE_BASE is C:\oracle. See 
"Conventions" on page xxi for more information on ORACLE_BASE.

Table 4–1 (Cont.) Manual Database Creation Tasks

Task

Copy existing 
database and delete 
old database

Copy existing 
database and keep 
old database

Create new database when 
no database exists on 
system
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■ C:\oracle\admin\prod\pfile 

■ C:\oracle\admin\prod\udump 

■ C:\oracle\oradata\prod 

Exporting an Existing Database
You are required to export an existing database only if you intend to copy its 
contents to a new database. If you are working with data from an earlier Oracle 
release, then you can use Export for this task. If you are using Oracle Database 10g 
data, then Oracle recommends that you use Data Pump Export because it supports 
new Oracle Database 10g features, such as floating points. 

Although you can start Data Pump Export or Export in either parameter mode or 
interactive mode, Oracle recommends parameter mode. Interactive mode provides 
less functionality than parameter mode and exists for backward compatibility only.

The syntax for Data Pump Export parameter mode is:

C:\> expdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOGFILE=myexp.log

The syntax for Data Pump Export interactive mode is:

C:\> expdp SYSTEM/password 

Enter only the command expdp SYSTEM/password to begin an interactive 
session and let Data Pump Export prompt you for information it needs. 

The syntax for Export parameter mode is:

C:\> exp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log

Note: If you use parameter mode, then Data Pump Export 
considers filenames and directory names to be invalid if they 
contain one or more blank spaces. The workaround is to enclose the 
full path in the DUMPFILE= parameter in triple quotation marks. 
For example:

DUMPFILE="""C:\program files\export.dmp""" 

If Data Pump Export is used in interactive mode, then the filename 
or directory name can contain a space without quotation marks.
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The syntax for Export interactive mode is:

C:\> exp SYSTEM/password 

Enter only the command exp SYSTEM/password to begin an interactive session 
and let Export prompt you for information it needs. 

To export all data from an existing database to a new database:

1. Set ORACLE_SID to the database service of the database whose contents you 
intend to export. For example, if the database you intend to export is starter 
database orcl, then enter the following at the command prompt. Note that 
there are no spaces around the equal sign (=) character.

C:\> set ORACLE_SID=orcl

2. If the existing database is Oracle Database 10g, then start Data Pump Export 
from the command prompt:

C:\> expdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOG=myexp.log

You now have a full database export of starter database orcl in file 
myexp.dmp. All messages from Data Pump Export are logged in file 
myexp.log.

3. If the existing database is before Oracle Database 10g, then start Export from the 
command prompt:

C:\> exp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log

Note: If you use parameter mode, then Export considers filenames 
and directory names to be invalid if they contain one or more blank 
spaces. The workaround is to enclose the full path in the FILE= 
parameter in triple quotation marks. For example:

FILE="""C:\program files\export.dmp""" 

If Export is used in interactive mode, then the filename or directory 
name can contain a space without quotation marks.

See Also: Oracle Database Utilities for more information on using 
Data Pump Export or Export
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You now have a full database export of starter database orcl in file 
myexp.dmp. All messages from Export are logged in file myexp.log.

Deleting Database Files
Deleting database files is required only when you copy an existing database to a 
new database to replace the old database. In the following example, you delete the 
database files of starter database orcl.

To delete database files:

1. Shut down starter database orcl at the command prompt:

C:\> oradim -SHUTDOWN -SID orcl -SHUTTYPE inst -SHUTMODE immediate

2. Delete the following files from directory C:\oracle\oradata\orcl:

Modifying the Initialization Parameter File
To use starter database orcl as the basis for your new database, first copy 
ORACLE_BASE\admin\orcl\pfile\init.ora. Second, put the copy in 
ORACLE_BASE\admin\prod\pfile\init.ora. Third, modify the file as 
described in this section.

File Name File Name File Name File Name

control01.ctl drsys01.dbf temp01.dbf xdb01.dbf 

control02.ctl cwmlite01.dbf tools01.dbf redo01.log 

control03.ctl example01.dbf undotbs01.dbf redo02.log 

index01.dbf system01.dbf user01.dbf redo03.log 
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If you do not have an existing database on your system, then you cannot copy an 
existing initialization parameter file to use as the basis for your new initialization 
parameter file. However, you can use the sample initialization parameter file 
initsmpl.ora provided in 

ORACLE_BASE\ORACLE_HOME\admin\sample\pfile

as the basis for the initialization parameter file for database prod.

If you use initsmpl.ora as the basis for the initialization parameter file, then you 
must set the following parameters to the indicated values, or you will not be able to 
start database prod:

■ DB_NAME=prod.domain 

Parameter DB_NAME indicates the database name and must match the name 
used in the CREATE DATABASE statement in "Putting the CREATE DATABASE 
Statement in a Script" on page 4-11. You give a unique database name to each 
database. You can use up to eight characters for a database name. The name is 
not required to match the SID of the database service.

■ INSTANCE_NAME=prod.domain 

■ SERVICE_NAMES=prod.domain 

■ CONTROL_FILES = ("C:\oracle\oradata\prod\control01.ctl",   
"C:\oracle\oradata\prod\control02.ctl",   
"C:\oracle\oradata\prod\control03.ctl") 

Note: Beginning with Oracle9i release 2 (9.2), nesting of quotation 
marks using the backslash (\) escape character is no longer 
supported. This may affect how Oracle Database interprets 
parameter values in your initialization parameter file. For example, 
if you specified CONTROL_FILES = "ctlfile\'1.ora" in 
releases prior to release 9.2, the filename would be interpreted as 
ctlfile'1.ora. Starting with release 9.2, the filename would be 
interpreted as ctlfile\'1.ora.

Oracle highly recommends modifying your parameter files to 
remove such references. See Oracle Database Reference for other 
methods of nesting quotation marks in initialization parameter 
values.
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Parameter CONTROL_FILES lists database control files. You do not have control 
files on your file system at this point, because control files are created when you 
run the CREATE DATABASE statement. Ensure that you specify the complete 
path and filename, including drive letter. 

■ BACKGROUND_DUMP_DEST = C:\oracle\admin\prod\bdump 

■ USER_DUMP_DEST = C:\oracle\admin\prod\udump 

■ DB_FILES=100 

Modifying initialization parameter DB_FILES is not required, but it is 
recommended to optimize performance. Set this parameter to the same number 
as the value of the MAXDATAFILES option of the CREATE DATABASE 
statement. The value of 100 is used for this example.

Starting an Oracle Database Instance
Start an instance without mounting a database. 

STARTUP NOMOUNT

You are not required to specify the PFILE clause in this example, because the 
initialization parameter file is stored in the default location. At this point, there is no 
database. Only the SGA is created and background processes are started in 
preparation for the creation of a new database.

Creating and Starting an Oracle Database Service
You are required to create and start an Oracle Database service only if you do one of 
the following:

■ Copy an existing database to a new database and keep the old database

■ Create a new database when you have no other database to copy

Before you create the database, first create a Windows service to run the database. 
This service is the Oracle Database process, oracle.exe, installed in the form of a 
Windows service. 

Use ORADIM to create the service. After it has been created, the service starts 
automatically. See "Using ORADIM to Administer an Oracle Database Instance" on 
page 4-18 for information on how to use ORADIM.

See Also: Oracle Database Reference for information on other 
initialization parameters that you can add or modify
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To create and start an Oracle Database service:

1. Run ORADIM from the command prompt:

C:\> oradim -NEW -SID prod -STARTMODE manual
-PFILE "C:\oracle\admin\prod\pfile\init.ora"

Note that the previously created initialization parameter file is specified, with 
complete path, including drive name. You can check if the service is started in 
the Services window of the Control Panel.

2. Set ORACLE_SID to equal prod. Note that there are no spaces around the equal 
sign (=) character:

C:\> set ORACLE_SID=prod

Putting the CREATE DATABASE Statement in a Script
The CREATE DATABASE statement is a SQL statement that creates the database. A 
script containing this statement can be used anytime you create a database.

The CREATE DATABASE statement may have the following parameters:

■ MAXDATAFILES - default value: 32, maximum value: 65534

■ MAXLOGFILES - default value: 32, maximum value: 255

When you run a CREATE DATABASE statement, Oracle Database performs several 
operations depending upon clauses that you specified in the CREATE DATABASE 
statement or initialization parameters that you have set.

To create database prod, copy and save the following statement in a file named 
script_name.sql:

CREATE DATABASE prod
MAXLOGFILES 5
MAXDATAFILES 100

Note: Oracle-managed files is a feature that works with the CREATE 
DATABASE statement to simplify administration of Oracle Database. 
Oracle-managed files eliminates the requirement to directly manage 
operating system files comprising an instance of Oracle Database, because 
you specify operations in terms of database objects rather than filenames. 
For more information on using Oracle-managed files see Oracle Database 
Administrator's Guide.
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DATAFILE 'oracle\oradata\prod\system01.dbf' SIZE 325M REUSE
AUTOEXTEND ON NEXT 10240K MAXSIZE UNLIMITED
UNDO TABLESPACE "UNDOTBS" DATAFILE 'oracle\oradata\prod\undotbs01.dbf'
SIZE 200M REUSE AUTOEXTEND ON NEXT 5120K MAXSIZE UNLIMITED
CHARACTER SET WE8MSWIN1252
logfile 'C:\oracle\oradata\prod\redo01.log' size 100M reuse,
        'C:\oracle\oradata\prod\redo02.log' size 100M reuse,
        'C:\oracle\oradata\prod\redo03.log' size 100M reuse;

Running the CREATE DATABASE Script
To use the SQL script to create a database:

1. Verify that the service is started in the Control Panel. In this example, the 
service name is OracleServicePROD, and its status column must display 
Started. If not, then select the service name and choose Start.

You can also check the status of the service by entering the following at the 
command prompt:

C:\> net START

A list of all Windows services currently running on the system appears. If 
OracleServicePROD is missing from the list, then enter:

C:\> net START OracleServicePROD

2. Make PROD the current SID: 

C:\> set ORACLE_SID=PROD

3. Start SQL*Plus from the command prompt, and connect to the database as 
SYSDBA:

C:\> sqlplus /NOLOG
SQL> CONNECT / AS SYSDBA 

The message connected appears.

4. Turn on spooling to save messages:

SQL> SPOOL script_name.log
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5. Run script script_name.sql that you created in "Putting the CREATE 
DATABASE Statement in a Script" on page 4-11:

SQL> @C:\oracle\ora92\rdbms\admin\script_name.sql;

If the database is successfully created, then the instance is started and the 
following message appears numerous times: Statement processed

Importing a Database
You can use Data Pump Import (for Oracle Database 10g data) or Import (for earlier 
data) to import the full export created in "Exporting an Existing Database" on 
page 4-6 into the new database. Although you can start Data Pump Import or 
Import using either parameter mode or interactive mode, Oracle recommends 
parameter mode because it provides more functionality. Interactive mode exists 
solely for backward compatibility.

The syntax for Data Pump Import parameter mode is:

C:\> impdp SYSTEM/password DUMPFILE=myexp.dmp FULL=y LOG=myexp.log

The syntax for Data Pump Import interactive mode is:

C:\> impdp SYSTEM/password 

Enter only impdp SYSTEM/password to begin an interactive session and let Data 
Pump Import prompt you for information it needs.

The syntax for Import parameter mode is:

C:\> imp SYSTEM/password FILE=myexp.dmp FULL=y LOG=myexp.log

Note: If you use parameter mode, then Data Pump Import 
considers filenames and directory names to be invalid if they 
contain one or more blank spaces. The workaround is to enclose the 
full path in the DUMPFILE= parameter in triple quotation marks. 
For example:

DUMPFILE="""C:\program files\export.dmp""" 

If you use Data Pump Import in interactive mode, then the 
filename or directory name can contain a space without quotation 
marks.
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The syntax for Import interactive mode is:

C:\> imp SYSTEM/password 

Enter only imp SYSTEM/password to begin an interactive session and let Import 
prompt you for information it needs.

Updating ORACLE_SID in the Registry
If this is the first database on the system or if you intend to make the new database 
the default database, then you must make a change in the registry.

1. Start Registry Editor at the command prompt:

C:\> regedt32

The Registry Editor window appears.

Note: If you use parameter mode, then Import considers 
filenames and directory names to be invalid if they contain one or 
more blank spaces. The workaround is to enclose the full path in 
the FILE= parameter in triple quotation marks. For example:

FILE="""C:\program files\export.dmp""" 

If you use Import in interactive mode, then the filename or 
directory name can contain a space without quotation marks.

Note: If the original database from which the export file was 
generated contains a tablespace that is not in the new database, 
then Import tries to create that tablespace with associated datafiles.

The easy solution is to ensure that both databases contain the same 
tablespaces. Datafiles are not required to be identical. Only 
tablespace names are important.

See Also: Oracle Database Utilities for more information on using 
Data Pump Import or Import
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2. Choose subkey \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0 for the 
first Oracle home on your computer. For subsequent installations to different 
Oracle homes on the same computer, the path is \HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOMEID where ID is the unique number 
identifying the Oracle home.

3. Locate parameter ORACLE_SID on the right side of the Registry Editor window.

4. Double-click the parameter name and change the data to the new SID, which is 
prod in this example.

If you do not yet have parameter ORACLE_SID, because this is the first database on 
your system, then you must create it.

To create parameter ORACLE_SID:

1. Choose Add Value from the Edit menu.

The Add Value dialog appears:

2. Enter ORACLE_SID in the Value Name field.

3. Select REG_EXPAND_SZ (for an expandable string) in the Data Type list.

4. Click OK.

A string editor dialog appropriate for the data type appears:

See Also: Chapter 14, "Configuration Parameters and the 
Registry" for more information on subkey locations for multiple 
Oracle homes
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5. Enter prod in the String field.

6. Click OK.

Registry Editor adds parameter ORACLE_SID.

7. Choose Exit from the Registry menu.

Registry Editor exits.

Backing Up the New Database

To back up the new database:

1. Shut down the database instance and stop the service:

C:\> oradim -SHUTDOWN -SID prod -SHUTTYPE srvc,inst -SHUTMODE immediate

Caution: If anything goes wrong while operating the new 
database without a backup, then you must repeat the database 
creation procedure. Back up your database now to prevent loss of 
data. 

Caution: Although ORADIM returns the prompt immediately, 
you must wait for the database and the service to stop completely 
before continuing to Step 2. Wait until the Control Panel indicates 
service OracleServicePROD has stopped. If you do not do this, then 
the backup may be useless because it was taken while data was 
being written to datafiles.
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2. Using the tool of your choice, back up database files. 

Database files consist of the initialization parameter file, control files, online 
redo log files, and datafiles.

When the backup is complete, you can start the database again, create users and 
objects, if necessary, make any other changes, and use the database. 

Be sure to back up the database after making any significant changes, such as 
switching archiving mode or adding a tablespace or datafile.

Using ORADIM to Administer an Oracle Database Instance
ORADIM is a command-line tool that is available with Oracle Database. You are 
required to use ORADIM only if you are manually creating, deleting, or modifying 
databases. Database Configuration Assistant is an easier tool to use for this purpose.

The following sections describe ORADIM commands and parameters. Note that 
each command is preceded by a dash (-). To get a list of ORADIM parameters, 
enter:

oradim -? | -h | -help

When you use ORADIM, a log file called oradim.log opens in ORACLE_
BASE\ORACLE_HOME\database, or in the directory specified by registry 
parameter ORA_CWD. All operations, whether successful or failed, are logged in this 
file. You must check this file to verify success of an operation.

See Also: For more information on archiving, backup, and 
recovery

■ Oracle Database Concepts

■ Oracle Database Backup and Recovery Basics

■ Oracle 2 Day DBA

Caution: Do not store database files on a compressed drive. This 
can result in write errors and decreased performance.

Note: Specifying oradim without any options also returns a list of 
ORADIM parameters and descriptions.
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If you have installed an Oracle Database service on Windows 2000, then when 
logging in as SYSTEM user (LocalSystem), with startup mode set to Automatic, it is 
possible that the Oracle Database service starts but the database does not start 
automatically. The following error message is written to file ORADIM.LOG in 
directory ORACLE_BASE\ORACLE_HOME\database:

ORA-12640: Authentication adapter initialization failed 

Oracle Enterprise Management Agent, Oracle Enterprise Manager Management 
Server and Oracle Internet Directory may also fail, because they cannot connect to 
the database for the same reason. The workarounds are:

■ Modify SQLNET.ORA

You can modify SQLNET.ORA, either by removing the line 

sqlnet.authentication_services=(NTS) 

or by changing it to

sqlnet.authentication_services=(NONE)

■ Start the database after the service starts

You can start the database manually after the Oracle Database service has 
started, using SQL*Plus and connecting as SYSDBA. 

■ Start the service as a specific user

Creating an Instance
To use ORADIM to create an instance, enter:

oradim -NEW -SID SID | -SRVC service_name | -ASMSID SID | -ASMSRVC service_name 
[-SYSPWD password] [-STARTMODE auto | manual] [-SRVCSTART system | demand] 
[-PFILE filename | -SPFILE] [-SHUTMODE normal | immediate | abort] [-TIMEOUT 
secs] [-RUNAS osusr/ospass]

where

■ -NEW indicates that you are creating a new instance. This is a mandatory 
parameter.

■ -SID SID is the name of the instance to create. 

See Also: Your Windows documentation for instructions on 
starting services
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■ -SRVC service_name is the name of the service to create 
(OracleServiceSID). 

■ -ASMSID SID is the name of the Automatic Storage Management (ASM) 
instance to create.

■ -ASMSRVC service_name is the name of the ASM service to create.

■ -STARTMODE auto | manual indicates whether to start the instance when the 
Oracle Database service is started. Default is manual.

■ -SRVCSTART system | demand indicates whether to start the Oracle 
Database service on computer restart.

■ -PFILE filename is the initialization parameter file to be used with this 
instance. Ensure that you specify the complete path name of this file, including 
drive letter.

■ -SPFILE indicates that a server parameter file (SPFILE) be used during startup 
instead of a PFILE.

■ -TIMEOUT secs sets the maximum time to wait (in seconds) before the service 
for a particular SID stops.

To create an instance called PROD, for example, you can enter:

C:\> oradim -NEW -SID prod -STARTMODE auto -PFILE 
C:\oracle\admin\prod\pfile\init.ora

Starting an Instance and Services
To use ORADIM to start an instance and services, enter

oradim -STARTUP -SID SID | -ASMSID SID [-SYSPWD password] [-STARTTYPE srvc | 
inst | srvc,inst] [-PFILE filename | -SPFILE]

where

■ -STARTUP indicates that you are starting an instance that already exists. This is 
a mandatory parameter.

■ -SID SID is the name of the instance to start. 

■ -ASMSID SID is the name of the ASM instance to start.

■ -STARTTYPE srvc, inst indicates whether to start the service or the instance. 
One or both values can be specified. If it is not specified, then the registry is 
checked for the current setting.
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-STARTTYPE srvc is equivalent to running net start 
oracleservice<sid> from the command line. 

-STARTTYPE inst is equivalent of running startup within SQL*Plus.

■ -PFILE filename is the initialization parameter file to be used with this 
instance. Ensure that you specify the complete path name of this file, including 
drive letter.

■ -SPFILE indicates that a server parameter file (SPFILE) be used during startup 
instead of a PFILE.

To start an instance called puma, for example, you can enter:

C:\> oradim -STARTUP -SID puma -STARTTYPE inst -PFILE 
C:\oracle\admin\prod\pfile\init.ora

Stopping an Instance and Services
To use ORADIM to stop an instance, enter:

oradim -SHUTDOWN -SID SID | -ASMSID SID [-SYSPWD password] [-SHUTTYPE srvc | 
inst | srvc,inst] [-SHUTMODE normal | immediate | abort]

where

■ -SHUTDOWN indicates that you are stopping an instance. This is a mandatory 
parameter.

■ -SID SID specifies the name of the instance to stop. 

■ -ASMSID SID is the name of the ASM instance to stop.

■ -SHUTTYPE srvc, inst indicates whether to stop the service or the instance. 
One or both values can be specified. If it is not specified, then the registry is 
checked for the current setting.

■ -SHUTMODE specifies how to stop an instance. This is an optional parameter. If 
you do not specify how to stop an instance, then normal is the default mode.

To stop an instance called puma, for example, you can enter:

C:\> oradim -SHUTDOWN -SID puma -SHUTTYPE srvc,inst
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Editing an Instance
You can edit an existing instance to change such values as instance name, startup 
mode, shutdown mode, and shutdown type. To use ORADIM to modify an 
instance, enter:

oradim -EDIT -SID SID | -ASMSID SID [-SYSPWD password] [-STARTMODE auto | 
manual] [-SRVCSTART system | demand] [-PFILE filename | -SPFILE][SHUTMODE normal 
| immediate | abort] [SHUTTYPE srvc | inst | srvc,inst]

where

■ -EDIT indicates that you are modifying an instance. This is a mandatory 
parameter.

■ -SID SID specifies the name of the instance to modify. This is a mandatory 
parameter.

■ -ASMSID SID is the name of the ASM instance to modify.

■ -STARTMODE indicates whether to start the instance when the Oracle Database 
service is started. Default is manual.

■ -SRVCSTART system | demand indicates whether to start the Oracle 
Database service on computer restart.

■ -PFILE filename specifies the initialization parameter file to be used with 
this instance. Ensure that you specify the complete path name of this file, 
including drive letter.

■ -SPFILE indicates that a server parameter file (SPFILE) be used during startup 
instead of a PFILE.

■ -SHUTMODE specifies how to stop an instance. This is an optional parameter. If 
you do not specify how to stop an instance, then normal is the default mode.

■ -SHUTTYPE indicates whether to stop the service or the instance. One or both 
values can be specified. If it is not specified, then the registry is checked for the 
current setting.

To specify a new initialization parameter file for the instance prod, for example, 
you can enter:

C:\> oradim -EDIT -SID prod -PFILE C:\oracle\admin\lynx\pfile\init.ora
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Deleting an Instance
To use ORADIM to delete an instance, enter:

oradim -DELETE -SID SID | -ASMSID SID | -SRVC service_name | -ASMSRVC service_
name

where

■ -DELETE Indicates that you are deleting an instance or service. This is a 
mandatory parameter.

■ -SID SID specifies the name of the SID to delete. 

■ -SRVC service_name specifies the name of the service to delete. 

■ -ASMSID SID is the name of the ASM instance to delete.

■ -ASMSRVC service_name is the name of the ASM service to delete.

To delete an instance called prod, for example, you can enter:

C:\> oradim -DELETE -SID prod
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5
Postinstallation Configuration Tasks on

Windows

This chapter describes configuration tasks you can perform to increase security and 
other configuration tasks you must perform before using Oracle interMedia and 
other Oracle options. Where appropriate, the chapter provides references to other 
guides for those configuration tasks.

This chapter contains these topics:

■ Resetting Passwords for Default Accounts

■ NTFS File System and Windows Registry Permissions

■ Configuring External Job Support for the Scheduler on Windows

■ Oracle interMedia on Windows

■ Configuring Oracle Text on Windows

■ Configuring Oracle Spatial on Windows

■ Configuring Advanced Replication on Windows

Note: Directory path examples in this chapter follow Optimal 
Flexible Architecture (OFA) guidelines (for example, ORACLE_
BASE\ORACLE_HOME\rdbms\admin). If you specified non-OFA 
compliant directories during installation, then your directory paths 
will differ. See Chapter 2, "Multiple Oracle Homes and Optimal 
Flexible Architecture" for more information.



Resetting Passwords for Default Accounts

5-2 Oracle Database Platform Guide

Resetting Passwords for Default Accounts
Oracle Database installs with a number of default accounts. Database Configuration 
Assistant locks and expires most default database accounts upon successful 
installation. Oracle recommends changing all user passwords immediately after 
installation.

NTFS File System and Windows Registry Permissions
Oracle recommends that you configure Oracle Database files, directories, and 
registry settings to allow only authorized database administrators (DBAs) to have 
full control. If you created a database using Database Configuration Assistant or 
upgraded a database using Oracle Database Upgrade Assistant, then no further 
action is required.

This section describes the permissions automatically set by Oracle Universal 
Installer, Database Configuration Assistant, and Oracle Database Upgrade Assistant 
and the steps to set these permissions manually.

This section contains these topics:

■ File Permissions

■ Setting NTFS File System Security

■ Setting Windows Registry Security

File Permissions
Beginning with Oracle9i release 2 (9.2), Oracle Universal Installer, Database 
Configuration Assistant, and Database Upgrade Assistant set file permissions when 
Oracle Database software is installed or upgraded.

This section contains these topics:

■ File Permissions Set by Oracle Universal Installer

■ File Permissions Set by Database Configuration Assistant

■ File Permissions Set by Database Upgrade Assistant

See Also: Oracle Database Administrator's Guide for more 
information on default database accounts and passwords

See Also: Your Windows documentation for more information 
about modifying NTFS file system and Windows registry settings
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File Permissions Set by Oracle Universal Installer
During Oracle Database installation, by default Oracle Universal Installer installs 
software in ORACLE_BASE\ORACLE_HOME. Oracle Universal Installer sets the 
following permissions to this directory, and all files and directories under this 
directory:

■ Administrators - Full Control 

■ System - Full Control 

■ Authenticated Users - Read, Execute and List Contents 

File Permissions Set by Database Configuration Assistant
During database configuration, Database Configuration Assistant installs files and 
directories in the following default locations, where database_name is the 
database name or SID:

■ ORACLE_BASE\admin\database_name (administration file directories)

■ ORACLE_BASE\oradata\database_name (database file directories)

■ ORACLE_BASE\oradata\database_name (redo log files and control files)

■ ORACLE_BASE\ORACLE_HOME\database (SPFILESID.ORA)

Database Configuration Assistant sets the following permissions to these 
directories, and all files and directories under these directories: 

■ Administrators - Full Control 

■ System - Full Control 

Important: If these accounts already exist and possess more 
restrictive permissions, then the most restrictive permissions are 
retained. If accounts other than Administrators, System, and 
Authenticated Users already exist, then the permissions for 
these accounts are removed.

Important: If these accounts already exist and possess more 
restrictive permissions, then the most restrictive permissions are 
retained. If accounts other than Administrators and System 
already exist, then the permissions for these accounts are removed.
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File Permissions Set by Database Upgrade Assistant 
When an older version of the database is upgraded to Oracle Database 10g, 
Database Upgrade Assistant installs software in the following directories, where 
database_name is the database name or SID:

■ ORACLE_BASE\admin\database_name (administration files)

■ ORACLE_BASE\oradata\database_name (database file directories)

■ ORACLE_BASE\oradata\database_name (redo log files and control files)

■  ORACLE_BASE\ORACLE_HOME\database (SPFILESID.ORA)

Database Upgrade Assistant sets the following permissions to these directories, and 
all files and directories under these directories: 

■ Administrators - Full Control 

■ System - Full Control 

Beginning with Oracle Database 10g, Database Upgrade Assistant can also 
configure Enterprise Manager. If the "Enable daily backup" option is selected while 
configuring Enterprise Manager, then Database Upgrade Assistant shows a separate 
screen asking for Flash Recovery Area. Database Upgrade Assistant will try to 
create the directory structure in whatever file system location is specified if it does 
not exist. It will put the same set of file permissions to this location. The default 
location shown by DBUA for flash recovery area is: 

■ ORACLE_BASE\flash_recovery_area

Setting NTFS File System Security
To ensure that only authorized users have full file system permissions: 

1. Go to Windows Explorer.

2. Set the following permissions for each directory or file:

Important: If these accounts already exist and possess more 
restrictive permissions, then the most restrictive permissions are 
retained. If accounts other than Administrators and System 
already exist, then the permissions for these accounts are removed.
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Setting Windows Registry Security
Oracle recommends that you remove write permissions from users who are not 
Oracle Database DBAs or system administrators in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE of the Windows registry. 

To remove write permissions: 

1. Open the registry. 

2. Go to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE.

3. Select Permissions from the Security main menu. 

The Registry Key Permissions dialog appears. 

4. Remove write permissions from any users who are not Oracle Database DBAs 
or system administrators. Note that the SYSTEM account must have Full 
Control, since this is the account with which Oracle Database runs. 

Directory Group and Permissions

ORACLE_BASE\ORACLE_HOME ■ Administrators - Full Control 

■ System - Full Control 

■ Authenticated Users - Read, Execute 
and List Contents 

ORACLE_BASE\admin\database_name ■ Administrators - Full Control 

■ System - Full Control 

ORACLE_BASE\oradata\database_name ■ Administrators - Full Control 

■ System - Full Control 

ORACLE_BASE\ORACLE_HOME\database\spfileSID.ora ■ Administrators - Full Control 

■ System - Full Control 

Note: Oracle Database uses the Windows LocalSystem built-in 
security account. Therefore, file permissions must be granted to the 
System account of the local computer running Oracle Database.

See Also: Your Windows online help for more information about 
how to modify NTFS file system and Windows registry settings
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5. Ensure that user accounts that must run Oracle applications have read 
privileges.

6. Choose OK. 

7. Exit the registry. 

Configuring External Job Support for the Scheduler on Windows
This release includes a new database scheduler to provide enterprise scheduling 
functionality. External jobs performed by the user are started using the 
OracleJobScheduler service. This service is disabled by default. In order to use the 
external jobs functionality, the administrator must set the username and password 
for the user account under which this service must run and enable the service.

Restricting execution of external jobs to a low-privileged user prevents 
unauthorized database users from gaining operating system level privileges, but it 
also places restrictions on the kinds of jobs that can be run. Jobs requiring a higher 
level of operating system privileges cannot be run by this mechanism.

Oracle interMedia on Windows
Oracle interMedia includes the following components.

Client
Oracle interMedia Client provides an Oracle Database interMedia Audio, Image, 
and Video Java interface that lets you use local (client-side) applications to 
manipulate or modify multimedia data stored in a network-accessible (server-side) 
database. To use the Java library, set environment variable CLASSPATH so that it 
contains the Oracle interMedia library.

Client also provides a simple interMedia Image sample (SimpImg.exe) that was 
developed using Microsoft Visual C++. SimpImg.exe locates and updates images, 
using interMedia Image in Oracle Database.

Audio
Oracle interMedia Audio manages audio data in multiple file formats in Oracle 
Database. Types of audio data supported include conversations, songs, and other 
sounds in popular audio file formats. This makes it possible to integrate audio data 
with other application-specific object-relational data.
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Video
Oracle interMedia Video manages video data in multiple video file formats. This 
makes it possible to integrate video data with other application-specific 
object-relational data.

Image
Oracle interMedia Image provides image storage, retrieval, and format conversion 
capabilities through an object data type (ODT). It also supports image storage, using 
Binary Large Objects (BLOBs), and references to image data residing in external files 
(BFILEs).

The Image component of Oracle interMedia also comes with a sample 
demonstration that shows how an image is extracted from Oracle Database.

Locator
Oracle interMedia Locator enables Oracle Database to support online internet-based 
geocoding facilities for locator applications and proximity queries. 

Upgrading Oracle interMedia from an Earlier Release
If you upgrade from an earlier Oracle release to the current release, Oracle 
interMedia will be upgraded automatically if it is detected. If for some reason you 
want to upgrade interMedia manually, follow this procedure:

1. Upgrade the database.

2. Start SQL*Plus:

C:\> sqlplus /NOLOG

3. Connect to Oracle Database with account SYSDBA:

SQL> CONNECT / AS SYSDBA

4. Run script imdbma.sql:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\imdbma.sql

5. If the script displays NOT_INSTALLED, then no prior release of Oracle 
interMedia was installed on your computer. You must install rather than 
upgrade Oracle interMedia.

6. If the script displays INSTALLED, then the current Oracle interMedia release is 
already installed on your computer.
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7. If the script displays u0nnnnn0.sql, then Oracle interMedia release nnnnn is 
currently installed. For example, u0800060.sql means that Oracle Image 
Cartridge release 8.0.6.0.0 is currently installed.

8. Upgrade Oracle interMedia common files:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\u0nnnnn0.sql

9. Upgrade Oracle interMedia:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\u0nnnnn0.sql

10. Verify the upgrade:

SQL> CONNECT / AS ORDSYS
SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\imchk.sql

Configuring Oracle interMedia Audio, Video, Image, and Locator
If you install Enterprise Edition, then Database Configuration Assistant starts 
automatically at the end of installation. If you choose any Database Configuration 
Assistant installation type other than Customized, then interMedia does not require 
manual configuration. All tasks described in this section are performed 
automatically.

If you select Customized installation, then Database Configuration Assistant will 
guide you through configuration of Oracle interMedia.

If you are creating and configuring a database manually, then you can configure 
Oracle interMedia Audio, Video, Image, and Locator as follows:

1. Start SQL*Plus:

C:\> sqlplus /NOLOG

2. Connect to Oracle Database with account SYSDBA:

SQL> CONNECT / AS SYSDBA

3. Start the database (if necessary):

SQL> STARTUP

4. Run script ordinst.sql:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\ordinst.sql
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5. Run script iminst.sql:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\im\admin\iminst.sql

6. Exit SQL*Plus:

SQL> EXIT

Configuring Oracle interMedia Demos
To configure Oracle interMedia Audio, Video, and Image demos, follow instructions 
in readme.txt files at locations shown in Table 5–1.

Directory \img\demo also contains demo_ordimg.mk, the makefile to make 
interMedia Image demos for a Microsoft C compiler. But before you can build and 
run the demonstration, you must first modify it to adapt it to your environment.

Note: If you manually copy your Oracle8i listener.ora and 
tnsnames.ora files into your Oracle Database network directory, 
then you must modify network configuration files tnsnames.ora 
and listener.ora on your server to enable external routine calls 
to work and interMedia to function properly. Follow the procedure 
in Oracle Net Services Administrator's Guide.

Table 5–1 interMedia Demo Instructions

Demo File Location

Audio ORACLE_BASE\ORACLE_HOME\ord\aud\demo 

Video ORACLE_BASE\ORACLE_HOME\ord\vid\demo 

Image ORACLE_BASE\ORACLE_HOME\ord\img\demo 

Note: These readme.txt files contain UNIX line breaks. If you 
simply double-click them, they will open in Notepad by default, 
and Notepad does not recognize UNIX line breaks. Use 
write.exe or edit.com instead.
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To configure Oracle interMedia Locator demonstrations, go to the following 
directory: 

ORACLE_BASE\ORACLE_HOME\md\demo\geocoder

Sample data that can be loaded into Oracle Database is in nh_cs.sql. Examples 
that show use of Locator functionality are in geohttp.sql and geolocate.sql. 
Examples of data indexes created by using Locator are in geoindex.sql.

Configuring Oracle Text on Windows
Oracle Text enables text queries through SQL and PL/SQL from most Oracle 
interfaces. By installing Oracle Text with an Oracle Database server, client tools such 
as SQL*Plus, Oracle Forms, and Pro*C/C++ are able to retrieve and manipulate text 
in Oracle Database.

Oracle Text manages textual data in concert with traditional data types in Oracle 
Database. When text is inserted, updated, or deleted, Oracle Text automatically 
manages the change.

Your Oracle Text postinstallation tasks depend on your situation.

If you install Oracle Text from the CD-ROM and have a previous release of Oracle 
Text (formerly called interMedia Text) already installed, then see Oracle Text 
Application Developer's Guide.

If you upgrade your database, then you may be required to configure Oracle Net 
for external procedures. Otherwise, Oracle Text may not work. In any case other 
than upgrade, Oracle Net will be configured correctly by default to work with 
Oracle Text. See Oracle Text Application Developer's Guide and Oracle Text Reference.

If you are indexing formatted documents such as Microsoft Word, then you must 
set your environment to use the INSO filter before you can index your 
documentation set. For more information on setting up your environment for INSO 
filtering, see Oracle Text Reference.

Finally, if you install Oracle Text from the CD-ROM and do not have a previous 
release of Oracle Text installed, then Oracle Database is already configured for use 
with Oracle Text if one of the following is true:

■ You created the database by using Database Configuration Assistant in 
standalone mode, and selected Typical database creation type.

■ The database is a starter database that you created by installing Enterprise 
Edition, Standard Edition or Personal Edition.
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■ The database is a starter database that you created by performing the following 
sequence of steps:

1. Select Oracle Database in the Available Products window.

2. Install Enterprise Edition, Standard Edition, or Personal Edition in the 
Installation Types window.

3. Select General Purpose in the Database Configuration window.

If none of these is true, then you must configure Oracle Database for use with 
Oracle Text by doing one of the following:

■ Configuring Oracle Text Using Database Configuration Assistant

■ Configuring Oracle Text Using Command-Line Tools

Configuring Oracle Text Using Database Configuration Assistant
To use Database Configuration Assistant to configure Oracle Database for use with 
Oracle Text at the time you create the database, simply select Oracle Text as the 
option to configure when prompted. To configure the database at a later time:

1. Start Database Configuration Assistant.

Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Database Configuration Assistant.

2. Select Configure database options in a database.

3. Select the database to modify when prompted.

4. Select Oracle Text as the option to configure when prompted.

Configuring Oracle Text Using Command-Line Tools
Manually configuring Oracle Database for use with Oracle Text consists of creating 
a tablespace for Oracle Text data dictionary tables and then creating username 
ctxsys and Oracle Text data dictionary tables.

1. Start SQL*Plus:

C:\> sqlplus /NOLOG

See Also:  For more information about creating a starter database

■ Chapter 4, "Postinstallation Database Creation on Windows"

■ Oracle Database Installation Guide for Windows
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2. Connect to Oracle Database with account SYSDBA:

SQL: CONNECT / AS SYSDBA

3. Create a tablespace for Oracle Text data dictionary tables:

SQL> CREATE TABLESPACE tablespace_name DATAFILE 'ORACLE_BASE\oradata\db_
name\drsys01.dbf' SIZE 80m;

4. Connect AS SYSDBA:

SQL> CONNECT USERNAME/PASSWORD AS SYSDBA

5. Run script dr0csys.sql to create username ctxsys:

SQL> @ORACLE_BASE\ORACLE_HOME\ctx\admin\dr0csys.sql password default_
tablespace_name temporary_tablespace_name;

where:

■ password is the password that you intend to use for username ctxsys.

■ default_tablespace_name is the default tablespace for Oracle Text data 
dictionary tables. Set the default tablespace to the value of tablespace_
name in step 3.

■ temporary_tablespace_name is the temporary tablespace for Oracle 
Text data dictionary tables. Set the temporary tablespace to the value of 
tablespace_name in step 3.

6. Connect as ctxsys:

SQL> CONNECT ctxsys/password

7. Run script dr0inst.sql to create and populate Oracle Text data dictionary 
tables:

SQL> @ORACLE_BASE\ORACLE_HOME\bin\dr0inst.sql;

8. Run the language-specific default script, where xx is the language code (for 
example, us):

SQL> @ORACLE_BASE\ORACLE_HOME\ctx\admin\defaults\drdefxx.sql;

9. Exit SQL*Plus:

SQL> EXIT
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Configuring Oracle Spatial on Windows
Oracle Spatial makes storage, retrieval, and manipulation of spatial data easier and 
more intuitive to users.

One example of spatial data is a road map. A road map is a two-dimensional object 
that contains points, lines, and polygons representing cities, roads, and political 
boundaries such as states. A road map represents geographic information. 
Locations of cities, roads, and political boundaries are projected onto a 
two-dimensional display or piece of paper, preserving relative positions and 
relative distances of objects.

If you install Oracle Spatial through Enterprise Edition, then no manual 
configuration is required. All Oracle Spatial configuration tasks are performed 
automatically.

If you install both Oracle Spatial and Oracle Database together through Enterprise 
Edition or Standard Edition Custom installation, then Database Configuration 
Assistant starts automatically at the end of installation. If you choose Custom 
installation and select Create new database, then the assistant asks if Oracle Spatial 
is to be configured automatically.

If you install Oracle Spatial during a separate installation from Enterprise Edition, 
then you must either start Database Configuration Assistant and select Configure 
database options in a database or configure Oracle Spatial manually.

To configure Oracle Spatial manually:

1. Start SQL*Plus at the command prompt:

C:\> sqlplus /NOLOG

2. Connect to Oracle Database with account SYSDBA:

SQL> CONNECT / AS SYSDBA

3. Start the database (if necessary):

SQL> STARTUP

4. Run script ordinst.sql:

SQL> @ORACLE_BASE\ORACLE_HOME\ord\admin\ordinst.sql

5. Connect to the database as user SYSTEM:

SQL> CONNECT SYSTEM/password
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6. Run script mdinst.sql:

SQL> @ORACLE_BASE\ORACLE_HOME\md\admin\mdinst.sql

7. Exit SQL*Plus:

SQL> EXIT

Configuring Advanced Replication on Windows
Oracle Database installs replication packages and procedures automatically rather 
than as a separate manual process. There are many configuration and usage 
possibilities with Advanced Replication. 

This section describes how to manually configure Advanced Replication in Oracle 
Database. Follow the instructions only if you add Advanced Replication to an 
installation of Oracle Database that was not previously configured with this feature.

Configuring Advanced Replication consists of the following steps:

■ Checking Tablespace and Rollback Segment Requirements

■ Adding and Modifying Initialization Parameters

■ Monitoring Data Dictionary Tables

Checking Tablespace and Rollback Segment Requirements
Recommended tablespace and rollback segment requirements for Advanced 
Replication are shown in Table 5–2.

Note: Script mdinst.sql has a variable %MD_SYS_PASSWORD% 
that Oracle Universal Installer will instantiate at installation time. 
Therefore, if you have changed the mdsys user's password, then be 
sure during a manual installation to remember also to update script 
mdinst.sql with that password. 

See Also: Oracle Database Advanced Replication for more 
information about Advanced Replication and for definitions of 
master sites and materialized view sites
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Adding and Modifying Initialization Parameters
If you use Advanced Replication, then certain parameter values must be added to 
the initialization parameter file, and others must be set to recommended values. 
Parameter names and values for the master site and materialized view sites are 
shown in Table 5–3.

Table 5–2 Advanced Replication Tablespace/Rollback Segment Requirements

Tablespace/Rollback Segment Minimum Free Space

SYSTEM1

1 Replication triggers and procedures are stored here.

20 MB

UNDO TABLESPACE 10 MB

RBS 5 MB

TEMP 10 MB

USERS No specific requirement

Table 5–3 Advanced Replication Initialization Parameters

Parameter Name Recommended Value Site

JAVA_POOL_SIZE 50 MB master

DISTRIBUTED_LOCK_TIMEOUT 300 seconds master

GLOBAL_NAMES TRUE master

OPEN_LINKS 4 master

PROCESSES Add 9 to current value master

JOB_QUEUE-PROCESSES 21

1 Depends on number of n-way sites.

master

JOB_QUEUE_PROCESSES 2 materialized view
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Monitoring Data Dictionary Tables
If you use Advanced Replication and intend to set up a large number of replicated 
objects, then you are required to monitor the following data dictionary tables with 
the SQL SELECT command:

■ ARGUMENT$

■ IDL_CHAR$

■ IDL_UB1$

■ IDL_UB2$

■ IDL_SB4$

■ I_ARGUMENT1

■ I_SOURCE1I$

■ SOURCE$

■ TRIGGER

If necessary, increase storage parameters to accommodate storage requirements of 
large numbers of replicated objects.
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6
Administering a Database on Windows

This chapter describes how to administer Oracle Database for Windows.

This chapter contains these topics:

■ Managing Oracle Database Services

■ Starting and Shutting Down a Database with SQL*Plus

■ Starting and Shutting Down a Database Using Services

■ Starting Multiple Instances

■ Creating and Populating Password Files

■ Connecting Remotely to the Database as SYS

■ Automatically Encrypted Database Passwords

■ Creating Control, Data, and Log Files on Remote Computers

■ Archiving Redo Log Files
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Managing Oracle Database Services
This section tells you how to manage the services that Oracle Database installs on 
your computer.

This section provides information on the following:

■ Oracle Database Service Naming Conventions for Multiple Oracle Homes

■ Starting Oracle Database Services

■ Stopping Oracle Database Services

■ Auto-starting Oracle Database Services

Oracle Database Service Naming Conventions for Multiple Oracle Homes
Oracle Database for Windows lets you have multiple Oracle homes on a single 
computer. This feature, described in Chapter 2, "Multiple Oracle Homes and 
Optimal Flexible Architecture", affects Oracle services naming conventions. As you 
perform installations into Oracle home directories:

■ You must accept default Oracle home name provided or specify a different 
name for each Oracle home directory.

■ You are prompted to give a system identifier and global database name for 
each database installation.

Starting Oracle Database Services
Oracle Database services must be started for you to use Oracle Database and its 
products. You can start Oracle Database services from three different locations:

■ Control Panel

■ Command Prompt

■ Starting Oracle Database Services

See Also: Oracle Database Installation Guide for Windows for a list of 
the services installed
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Control Panel
To start Oracle Database services from the Control Panel:

1. Access your Windows Services dialog.

2. Find the service to start in the list, select it, and click Start.

If you cannot find OracleServiceSID in the list, then use ORADIM to create it. 

3. Click Close to exit the Services dialog.

Command Prompt
To start Oracle Database services from the command prompt, enter:

C:\> NET START service

where service is a specific service name, such as OracleServiceORCL.

Oracle Administration Assistant for Windows
To start Oracle Database services from Oracle Administration Assistant for 
Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows

2. Right-click the SID.

where SID is a specific instance name, such as orcl.

3. Click Start Service.

This starts service OracleServiceORCL.

Note: You can start Oracle Database when you start 
OracleServiceSID. See "Starting and Shutting Down a Database 
Using Services" on page 6-9 for information on registry parameters 
that enable you to do this.

See Also: Your Windows documentation for instructions
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Stopping Oracle Database Services
On occasion (for example, when re-installing Oracle Database), you must stop 
Oracle Database services. You can stop Oracle Database services from three 
different locations:

■ Control Panel

■ Command Prompt

■ Oracle Administration Assistant for Windows

Control Panel
To stop Oracle Database services from the Control Panel:

1. Access your Windows Services dialog.

2. Select OracleHOME_NAMETNSListener and click Stop.

OracleHOME_NAMETNSListener is stopped.

3. Select OracleServiceSID and click Stop.

4. Click OK.

OracleServiceSID is stopped.

Command Prompt
To stop Oracle Database services from the command prompt, enter:

C:\> net STOP service

where service is a specific service name, such as OracleServiceORCL.

Note: You can stop Oracle Database in normal, immediate, or 
abort mode when you stop OracleServiceSID. See "Starting and 
Shutting Down a Database Using Services" on page 6-9 for 
information on registry parameters that enable you to do this.

See Also: Your Windows documentation for instructions
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Oracle Administration Assistant for Windows
To stop Oracle Database services from Oracle Administration Assistant for 
Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

2. Right-click the SID.

where SID is a specific instance name, such as orcl.

3. Click Stop Service.

This stops service OracleServiceORCL.

Auto-starting Oracle Database Services
Oracle Database services can be set to start automatically whenever the Windows 
computer is restarted. You can turn auto-start on or off from two different locations:

■ Control Panel

■ Oracle Administration Assistant for Windows

Control Panel
To use the Control Panel to configure when and how Oracle Database is started: 

1. Access your Windows Services dialog.

2. Select service OracleServiceSID and click Startup.

3. Choose Automatic from the Startup Type field.

4. Click OK.

5. Click Close to exit the Services dialog.

Oracle Administration Assistant for Windows
To automatically start Oracle Database services from Oracle Administration 
Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

See Also: Your Windows documentation for instructions
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2. Right-click the SID.

where SID is a specific instance name, such as orcl.

3. Choose Startup/Shutdown Options.

4. Choose the Oracle Service tab.

5. Choose Automatic in Oracle Service Startup Type.

6. Click Apply.

7. Click OK.
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Starting and Shutting Down a Database with SQL*Plus
These instructions assume that a database instance has been created.

To start or shut down Oracle Database:

1. Go to your Oracle Database server.

2. Start SQL*Plus at the command prompt:

C:\> sqlplus /NOLOG

3. Connect to Oracle Database with username SYSDBA:

SQL> CONNECT / AS SYSDBA 

4. To start a database, enter:

SQL> STARTUP [PFILE=path\filename]

This command uses the initialization parameter file specified in 
path\filename. To start a database using a file named init2.ora located in 
C:\ora92\admin\orcl\pfile, for example, you would enter:

SQL> STARTUP PFILE=C:\ora92\admin\orcl\pfile\init2.ora

If no PFILE is specified, then the command looks for an SPFILE in ORACLE_
HOME\database. If it finds one, then it uses it to start the database. If it does 
not find an SPFILE, then it uses the default initialization parameter file located 
in ORACLE_BASE\ADMIN\db_name\pfile.

5. To stop a database, enter:

SQL> SHUTDOWN [mode]

where mode is normal, immediate, or abort. 

Note: Directory path examples in this chapter follow Optimal 
Flexible Architecture (OFA) guidelines (for example, ORACLE_
BASE\ORACLE_HOME\rdbms\admin). If you specified non-OFA 
compliant directories during installation, then your directory paths 
will differ. See Chapter 2, "Multiple Oracle Homes and Optimal 
Flexible Architecture" for more information.
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In a normal shutdown, Oracle Database waits for all currently-connected users 
to disconnect and disallows any new connections before shutting down. This is 
the default mode.

In an immediate shutdown, Oracle Database terminates and rolls back active 
transactions, disconnects clients, and shuts down.

In an abort shutdown, Oracle Database terminates active transactions and 
disconnects users; it does not roll back transactions. The database performs 
automatic recovery and rollback the next time it is started. Use this mode only 
in emergencies.

Starting and Shutting Down a Database Using Services
You can start or shut down Oracle Database by starting or stopping service 
OracleServiceSID in the Control Panel. Starting OracleServiceSID is equivalent to 
using the STARTUP command or manually entering:

C:\> oradim -STARTUP -SID SID [-STARTTYPE srvc | inst | srvc,inst] [-PFILE 
filename | -SPFILE]

Stopping OracleServiceSID is equivalent to using the SHUTDOWN command or 
manually entering:

C:\> oradim -SHUTDOWN -SID SID [-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE 
normal | immediate | abort]

You can enable starting and stopping Oracle Database through OracleServiceSID 
two different ways: 

■ Starting Oracle Database Services

■ Setting Registry Parameters

Oracle Administration Assistant for Windows
To start or stop a database using Oracle Database Services from Oracle 
Administration Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

See Also: Chapter 3, "Database Tools on Windows" for a list of 
other tools that can start Oracle Database and this guide for 
information on options you can specify when starting your 
database.
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2. Right-click the SID.

where SID is a specific instance name, such as ORCL.

3. Choose Startup/Shutdown Options.

4. Choose the Oracle Instance tab.

5. Select Start up instance when service is started, Shut down instance when 
service is stopped, or both.

Setting Registry Parameters
To start or stop Oracle Database through Oracle Database Services, set the following 
registry parameters to the indicated values:

■ ORA_SID_AUTOSTART 

When set to true, the default value, this parameter causes Oracle Database to 
start when OracleServiceSID is started.
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■ ORA_SID_PFILE 

This parameter sets the full path to the initialization parameter file. If this entry 
is not present, then oradim will try to start the database with an SPFILE or 
PFILE from ORACLE_HOME\database.

■ ORA_SHUTDOWN 

When set to true, this parameter enables the selected instance of Oracle 
Database to be shut down when OracleServiceSID is stopped. This includes any 
database in the current Oracle home. Default value is false.

■ ORA_SID_SHUTDOWN 

When set to true, the default value, this parameter causes the instance of 
Oracle Database identified by the SID value to shut down when 
OracleServiceSID is stopped manually—using either the Control Panel or Net 
stop command.

The following two registry parameters are optional:

■ ORA_SID_SHUTDOWNTYPE 

This parameter controls database shutdown mode. Set it to a (abort), i 
(immediate), or n (normal). Default mode is i (immediate) if you do not set 
this parameter.

■ ORA_SID_SHUTDOWN_TIMEOUT 

This parameter sets maximum time to wait before the service for a particular 
SID stops.

The registry location of these required and optional parameters is determined by 
the number of Oracle home directories on your computer. If you have only one 
Oracle home directory, then these parameters belong in:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0

Caution: If ORA_SHUTDOWN or ORA_SID_SHUTDOWN is set to 
false, then manually shutting down OracleServiceSID will still 
shut down Oracle Database. But it will be an abnormal shutdown, 
and Oracle does not recommend it.
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If you have multiple Oracle home directories, then these parameters belong in:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID 

where ID is incremented for each additional Oracle home directory on your 
computer.

Starting or Stopping OracleServiceSID from the Control Panel
1. To start the database, start OracleServiceSID.

This automatically starts ORADIM and issues the -STARTUP command using 
the initialization parameter file identified by ORA_SID_PFILE.

2. To stop the database, stop OracleServiceSID.

This automatically starts ORADIM, which issues the -SHUTDOWN command in 
the mode indicated by ORA_SID_SHUTDOWNTYPE, and shuts down Oracle 
Database.

Starting Multiple Instances
1. Start the service for each instance using ORADIM or the Services dialog of the 

Control Panel.

2. At the command prompt set the ORACLE_SID configuration parameter to the 
SID for the first instance to run:

C:\> SET ORACLE_SID=SID

where SID is the name of the Oracle Database instance.

Note: If you use ORADIM to create or edit instances, then it 
automatically sets the relevant registry parameters to their 
appropriate values.

See Also: Chapter 14, "Configuration Parameters and the 
Registry" for instructions on adding and editing registry 
parameters 

See Also: Your Windows documentation for instructions on 
starting and stopping services.
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3. Start SQL*Plus:

C:\> sqlplus /NOLOG

4. Connect AS SYSDBA:

SQL> CONNECT / AS SYSDBA

5. Start up the first instance:

SQL> STARTUP PFILE=ORACLE_BASE\admin\db_name\pfile\init.ora

where ORACLE_BASE is c:\oracle (unless you changed it during installation) 
and db_name is the name of the instance.

6. Repeat Steps 2-5 for the other instances to run.

Creating and Populating Password Files
Use Password Utility to create password files. Password Utility is automatically 
installed with Oracle Database utilities. Password files are located in directory 
ORACLE_BASE\ORACLE_HOME\DATABASE and are named PWDsid.ORA, where 
SID identifies the Oracle Database instance. Password files can be used for local or 
remote connections to Oracle Database. 

To create and populate a password file:

1. Create a password file with the Password Utility:

C:\> orapwd FILE=PWDsid.ora PASSWORD=password ENTRIES=max_users

where

■ FILE specifies the password filename.

■ SID identifies the database instance.

■ PASSWORD sets the password for account SYS.

■ ENTRIES sets maximum number of entries in password file. This 
corresponds to maximum number of distinct users allowed to connect to 
the database simultaneously with either the SYSDBA or the SYSOPER 
DBA privilege.
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2. Set initialization parameter file parameter REMOTE_LOGIN_PASSWORDFILE to 
exclusive, shared, or none.

exclusive specifies that only one instance can use the password file and that 
the password file contains names other than SYS. In search of the password file, 
Oracle Database looks in the registry for the value of parameter ORA_SID_
PWFILE. If no value is specified, then it looks in the registry for the value of 
parameter ORA_PWFILE, which points to a file containing usernames, 
passwords, and privileges. If that is not set, then it uses the default:

ORACLE_BASE\ORACLE_HOME\DATABASE\PWDsid.ORA.

The default value is shared. It specifies that multiple instances (for example, a 
Real Application Clusters environment) can use the password file. However, 
the only user recognized by the password file is SYS. Other users cannot log in 
with SYSOPER or SYSDBA privileges even if those privileges are granted in the 
password file. The shared value of this parameter affords backward 
compatibility with earlier Oracle releases. Oracle Database looks for the same 
files as it does when the value is exclusive.

none specifies that Oracle Database ignores the password file and that 
authentication of privileged users is handled by the Windows operating 
system. This is the default setting.

3. Start SQL*Plus:

C:\> sqlplus /NOLOG

4. Connect AS SYSDBA:

SQL> CONNECT / AS SYSDBA

5. Start Oracle Database:

SQL> STARTUP

6. Grant appropriate privileges to each user. Users who must perform database 
administration, for example, would be granted privilege SYSDBA:

SQL> GRANT SYSDBA TO scott;

If the grant is successful, then the following message displays:

Statement Processed.
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This adds scott to the password file and enables scott to connect to the 
database with SYSDBA privileges. Use SQL*Plus to add or delete usernames, 
user passwords, and user privileges in password files.

Viewing and Hiding the Password File
The password file is not automatically hidden. It can be made invisible and visible 
again from two different locations:

■ Command Prompt

■ Windows Explorer

Command Prompt
1. To see the password file, enter:

ORACLE_BASE\ORACLE_HOME\database> attrib

The password file is displayed as PWDsid.ora:

A       ORACLE_BASE\ORACLE_HOME\database\oradba.exe
A       ORACLE_BASE\ORACLE_HOME\database\OraDim.Log
A       ORACLE_BASE\ORACLE_HOME\database\PWDsid.ora
A       ORACLE_BASE\ORACLE_HOME\database\SPFILEsid.ora

2. To make the password file invisible, enter:

ORACLE_BASE\ORACLE_HOME\database> attrib +H PWDsid.ora

3. To see the effect of the change, enter:

ORACLE_BASE\ORACLE_HOME\database> attrib

The password file is now hidden:

A       ORACLE_BASE\ORACLE_HOME\database\oradba.exe
A       ORACLE_BASE\ORACLE_HOME\database\OraDim.Log

Caution: Copying or manually moving password files may result 
in ORADIM being unable to find a password to start an instance.

Note: The password file must be visible before it can be moved, 
copied, or deleted.
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A   H   ORACLE_BASE\ORACLE_HOME\database\PWDsid.ora
A       ORACLE_BASE\ORACLE_HOME\database\SPFILEsid.ora

4. To make the password file visible again, enter:

ORACLE_BASE\ORACLE_HOME\database> attrib -H PWDsid.ora

Windows Explorer
To make the password file invisible or visible again:

1. Navigate to directory ORACLE_BASE\ORACLE_HOME\database.

2. Right-click PWDsid.ora.

3. Choose Properties.

The PWDsid.ora Properties dialog opens. 

4. In Attributes, check or clear the checkbox next to Hidden.

5. Click OK.

To view or hide an invisible password file:

1. Navigate to directory ORACLE_BASE\ORACLE_HOME\database.

2. Choose Folder Options from the View main menu.

3. Choose the View tab.

4. To view an invisible password file, choose Show hidden files and folders.

5. To hide a visible password file, choose Do not show hidden files and folders.

6. Click OK.

Connecting Remotely to the Database as SYS 
When connecting to the starter database from a remote computer as SYS, you must 
use a different password from the one described in Oracle Database Installation Guide 
for Windows when logging on with SYSDBA privileges. This is because the password 
file enables database access in this situation and it requires the password oracle 
for this purpose. 
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Automatically Encrypted Database Passwords 
With Oracle Database, the password used to verify a remote database connection is 
automatically encrypted. Whenever a user attempts a remote login, Oracle Database 
encrypts the password before sending it to the remote database. If the connection 
fails, then the failure is noted in the operating system audit log.

Creating Control, Data, and Log Files on Remote Computers
Oracle Database can access database files on a remote computer using Universal 
Naming Convention (UNC), but it may degrade database performance and network 
reliability. UNC is a PC format for specifying locations of resources on a local area 
network. UNC uses the following format:

\\server-name\shared-resource-path-name

For example, UNC specification for file system01.dbf in directory 
C:\oracle\oradata\orcl on shared server argon would be:

\\argon\oracle\oradata\orcl\system01.dbf

Locations of archive log files cannot be specified using UNC. Always set 
initialization parameter LOG_ARCHIVE_DEST_n to a mapped drive. If you set it to a 
UNC specification, then Oracle Database does not start and you receive the 
following errors:

ORA-00256: error occurred in translating archive text string '\meldell\rmdrive'
ORA-09291: sksachk: invalid device specified for archive destination 
OSD-04018: Unable to access the specified directory or device
O/S-Error: (OS 2) The system cannot find the file specified

An ORA-00256 error also occurs if you enter \\\meldell\rmdrive or 
\\\meldell\\rmdrive. Control files required the additional backslashes for 
Oracle8 release 8.0.4, but redo log files and datafiles did not.

Note: Configuration parameter ORA_ENCRYPT_LOGIN is retained 
for backward compatibility and is set to true by default. See 
Chapter 14, "Configuration Parameters and the Registry" for 
instructions on adding and setting configuration parameters in the 
registry.
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Archiving Redo Log Files
If you installed Oracle Database through the Typical installation, then it is created in 
NOARCHIVELOG mode. If you created your database through the Custom option of 
Database Configuration Assistant, then you had the choice of either ARCHIVELOG 
or NOARCHIVELOG.

In NOARCHIVELOG mode, redo logs are not archived. Setting your archive mode to 
ARCHIVELOG and enabling automatic archiving causes redo log files to be 
archived. This protects Oracle Database from both instance and disk failure. 

This section describes how to change archive mode to ARCHIVELOG and enable 
automatic archiving.

Changing Archive Mode to ARCHIVELOG
1. Start SQL*Plus at the command prompt:

C:\> sqlplus /NOLOG

2. Connect to Oracle Database as SYSDBA:

SQL> CONNECT / AS SYSDBA

3. If the database is open, then shut it down:

SQL> SHUTDOWN

4. Next, mount the database:

SQL> STARTUP MOUNT

5. Enter the following command:

SQL> ARCHIVE LOG LIST

The following output indicates the database is not in archive mode:

Database log mode              No Archive Mode
Automatic archival             Disabled
Archive destination            %RDBMS%\
Oldest online log sequence     34
Current log sequence           37

See Also: For complete descriptions of ARCHIVELOG and 
NOARCHIVELOG modes, see "Managing Archived Redo Logs" in 
Oracle Database Administrator's Guide 
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6. Change archive mode to ARCHIVELOG:

SQL> ALTER DATABASE ARCHIVELOG;

7. Enter the following command:

SQL> ARCHIVE LOG LIST

The following output indicates the database is now in archive mode:

Database log mode              Archive Mode
Automatic archival             Disabled
Archive destination            %RDBMS%\
Oldest online log sequence     34
Current log sequence           37

8. Open the database:

SQL> ALTER DATABASE OPEN;

Enabling Automatic Archiving
1. Open file ORACLE_BASE\ADMIN\db_name\pfile\init.ora.

2. Find the following three initialization parameters:

# LOG_ARCHIVE_START = true
# LOG_ARCHIVE_DEST_1 = %ORACLE_HOME%\database\archive
# LOG_ARCHIVE_FORMAT = "%%ORACLE_SID%%T%TS%S.ARC"

3. Remove the # sign from in front of each.

4. Edit the LOG_ARCHIVE_DEST_n value to identify an existing drive and 
directory in which to archive your filled redo logs.

Note: Double quotation marks around LOG_ARCHIVE_FORMAT

Note: Default size of Redo logs is approximately 100 MG.
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5. Edit the LOG_ARCHIVE_FORMAT value to indicate the appropriate archiving 
format: 

%%ORACLE_SID%%%T.ARC specifies the thread number. This number is padded 
to the left by zeroes. The default value is one with a range of up to three 
characters. Example: SID0001.ARC

%%ORACLE_SID%%%S.ARC specifies the log sequence number. This number is 
padded to the left by zeroes. The default value is one with a range of up to five 
characters. Example: SID0001.ARC

%%ORACLE_SID%%%t.ARC specifies the thread number. The number is not 
padded. The default value is one with no range limit on characters. Example: 
SID1.ARC

%%ORACLE_SID%%%s.ARC specifies the log sequence number. The number is 
not padded. The default value is one with no range limit on characters. 
Example: SID1.ARC

6. Save your changes.

7. Exit the file.

8. Shut down the database:

SQL> SHUTDOWN

9. Restart the database

SQL> STARTUP

10. Enter the following command:

SQL> ARCHIVE LOG LIST

The following output indicates that automatic archiving of redo log files is 
enabled and an archiving destination is specified:

Database log mode              Archive Mode
Automatic archival             Enabled
Archive destination            C:\BACKUP
Oldest online log sequence     34
Current log sequence           37
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7
Monitoring a Database on Windows

This chapter describes how to monitor Oracle Database for Windows.

This chapter contains these topics:

■ Database Monitoring Overview

■ Using Oracle Counters for Windows Performance Monitor

■ Using Event Viewer

■ Trace Files

■ Alert Files

■ Viewing Threads
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Database Monitoring Overview
Table 7–1 describes tools that enable you to monitor Oracle Database.

Using Oracle Counters for Windows Performance Monitor 
Oracle Counters for Windows Performance Monitor is a graphical tool for 
measuring the performance of Oracle Database for Windows objects on a local 
server or other servers on a network. This tool is the same in appearance and 
operation as Windows Performance Monitor, except it has been preloaded with 
Oracle Database performance elements.

On each computer, you can view behavior of objects, such as buffer cache, data 
dictionary cache, datafiles, threads, and processes. An object is a graphical 
representation of an element in your system. Every element, resource, and device in 
your system can be represented as an object.

Table 7–1 Database Monitoring Tools

Tool Functionality

Oracle Counters for 
Windows Performance 
Monitor 

Monitor database objects, such as CPU usage, buffer cache, or a 
background process.

Event Viewer Monitor database events.

Trace Files Record occurrences and exceptions of database operations

Alert Files Record important information about error messages and 
exceptions during database operations.

Oracle Enterprise Manager 
Database Management 
Packs

Monitor and tune using tools with real-time graphical 
performance information.

See Also: Your Oracle Enterprise Manager documentation set 
for more information

Oracle Administration 
Assistant for Windows

View information on or terminate any Oracle thread.

See Also: Oracle Database Performance Tuning Guide for general 
tuning information 
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A set of counters is associated with each object. A counter is a unit of measurement 
used by Performance Monitor to display activity. The type of activity the counter 
measures is dependent upon type of object.

Certain types of objects and their respective counters are present on all systems. 
Other counters, such as application-specific counters, appear only if the computer is 
running the associated software.

Each of these objects has an associated set of counters that provide information 
about device usage, queue lengths, delays, and information used to measure 
throughput and internal congestion.

Registry Information
When you install Oracle Counters for Windows Performance Monitor, values are 
automatically set in the registry as described in Chapter 14, "Configuration 
Parameters and the Registry".

Oracle Counters for Windows Performance Monitor lets you monitor only one 
database instance at a time. For this reason, the registry contains the following 
values:

■ Hostname 

■ Username 

■ Password 

Use OPERFCFGver to change these values. Oracle recommends setting the security 
level on each of these registry values.

Note: Before using Oracle Counters for Windows Performance 
Monitor to view Oracle-specific counters, you must specify the 
SYSTEM password using OPERFCFGver.exe or Oracle 
Administration Assistant for Windows. See "Using OPERFCFGver" 
on page 14-18 or "Using Oracle Administration Assistant for 
Windows" on page 14-19 for instructions.

See Also: Chapter 14, "Configuration Parameters and the 
Registry" for instructions on how to use OPERFCFGver
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To use Oracle Counters for Windows Performance Monitor for another database 
instance on the same computer or a UNIX computer, change the values 
appropriately in the registry. You can also monitor non-Windows installations of 
Oracle Database by changing Hostname registry value so it points to another 
computer specified in file tnsnames.ora.

Accessing Oracle Counters for Windows Performance Monitor
To access Oracle Counters for Windows Performance Monitor:

Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Oracle Counters for Windows Performance Monitor.

Oracle Counters for Windows Performance Monitor has four views you can choose 
from the View menu:

■ Chart view displays database activity as it occurs.

■ Alert view lets you know when certain minimum performance criteria are not 
being met, or maximum criteria are being exceeded.

■ Log view maintains continuous records on performance.

■ Report view saves information about specific criteria.

Modifying Views
For each view you can decide objects to monitor, what counters to use for each 
object, and graphical attributes of the view. When an object is chosen, it is assigned 
a counter, a color, and added to the status bar at the bottom of Oracle Counters for 
Windows Performance Monitor.

To add objects to a view:

1. Choose Add To (Chart, Alert, Log, Report) from the Edit menu. 

The Add to Chart dialog appears.

2. In the Computer list, select the computer to monitor.

3. In the Object list, select the object or objects to monitor, then click Add.

If no data or Oracle Database objects appear, then either Oracle Database is not 
running or an invalid host string or password has been entered. If the database 
is not started, then exit Oracle Counters for Windows Performance Monitor, 

See Also: Your Windows documentation for complete 
information about the four views
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start the database, and restart Oracle Counters for Windows Performance 
Monitor.

4. In the Counter list, select one or more counters for each object you have 
selected. Note that the contents of the Counter list change depending upon your 
selection in the Object list. For details on how a counter works, highlight the 
counter and click Explain.

5. In the Instance list, select an instance for this counter.

6. In the Color list, choose a color for the display of the selected counter.

7. In the Scale list, choose the scale at which to display the counter.

8. In the Width list, specify the width of the line on the graph.

9. In the Style list, choose a style for your graph line.

10. Click Done when you are finished.

Understanding Oracle Database Performance Objects
All Oracle Database system resources that can be monitored through Oracle 
Counters for Windows Performance Monitor begin with 'Oracle Database'. This 
section lists Oracle Database objects and describes their associated counters. These 
measures are defined in

ORACLE_BASE\ORACLE_HOME\dbs\PERFver.ora

Oracle Database Buffer Cache
The counter is phyrds/gets %. The percentage of phyrds/gets is calculated as a 
Miss ratio. The lower the Miss counter, the better. To improve performance, increase 
the number of buffers in the buffer cache, if memory is available on the computer. 
This value is not time-derived.

See Also: Oracle Database Performance Tuning Guide for additional 
information on these objects

Note: You can monitor only one instance at a time using Oracle 
Counters for Windows Performance Monitor on a given computer. 
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Oracle Database Redo Log Buffer
The counter is redo log space requests. The value of this counter must be near zero. 
If this value increments consistently, then processes have had to wait for space in 
the redo log buffer. In this case, it may be necessary to increase the size of the redo 
log buffer.

Oracle Database Data Dictionary Cache
The counter is getmisses/gets %. The value of this counter must be less than 10 or 
15% for frequently accessed data dictionary caches. If the ratio continues to increase 
over this threshold while your application is running, then increase the amount of 
memory available to the data dictionary cache.

To increase the memory available to the cache, increase the value of initialization 
parameter SHARED_POOL_SIZE. This value is not time-derived.

Oracle Database Library Cache
The counter is reloads/pins %. This is the percentage of SQL statements, PL/SQL 
blocks, and object definitions that required reparsing. Total Reloads must be near 
zero. If the ratio of Reloads to Pins is greater than 1%, then reduce the library cache 
misses. This value is not time-derived.

Oracle Database Data Files
The counters are phyrds/sec and phywrts/sec. These values are time-derived. Disk 
contention occurs when multiple processes try to access the same disk 
simultaneously. Depending on results from monitoring disk activity, corrective 
actions could include:

■ Distributing I/O

■ Separating datafiles and redo log files

■ Separating tables and indexes

■ Striping table data

Oracle Database DBWR stats1
The two counters available, buffers scanned/sec and LRU scans/sec, are helpful in 
tuning Buffer Cache. Buffers scanned/sec is the number of buffers DBWR scanned 

See Also: Oracle Database Performance Tuning Guide for more 
detailed information on tuning memory allocation in Oracle 
Database
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in each second. The buffers scanned are on the LRU (Least Recently Used) list. LRU 
scans/sec is the number of times DBWR scanned the (Least Recently Used) buffer 
list in each second.

Oracle Database DBWR stats2
The two counters available, timeouts/sec and checkpoints/sec, are helpful in 
determining how much work DBWR has been requested to perform. Timeouts/sec 
is the number of times DBWR timed-out in each second. DBWR is on a three second 
timeout interval. If DBWR has not been posted within a three second interval, then 
it times out.

Checkpoints/sec is the number of checkpoint messages processed by database 
writer in each second. Whenever a checkpoint occurs, DBWR must be messaged 
(posted) to "write dirty buffers to disk".

Oracle Database Dynamic Space Management
The counter is recursive calls/sec. Dynamic extension causes Oracle Database to 
execute SQL statements in addition to those SQL statements issued by user 
processes. These SQL statements are called recursive calls. 

If Oracle Database makes excessive recursive calls while an application is running, 
then it may be necessary to determine the cause. Examine the recursive calls statistic 
through dynamic performance table V$SYSSTAT.

Oracle Database Free List
The counter is free list waits/requests %. Contention for free lists is reflected by 
contention for free data blocks in buffer cache. You can determine if contention for 
free lists is reducing performance by querying V$WAITSTAT.

If the number of free list waits for free blocks is greater than 1% of the total number 
of requests, then consider adding more free lists to reduce contention.

Oracle Database Sorts
The available counters are sorts in memory/sec and sorts on disk/sec. The default 
sort area size is adequate to hold all data for most sorts. However, if your 
application often performs large sorts on data that does not fit into the sort area, 
then you may increase sort area size. 
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Oracle Counters for Windows Performance Monitor Troubleshooting Information
If no data or Oracle Database objects appear in the Objects list of the Add to (Chart, 
Alert, Log, Report) dialog, then:

1. Ensure that Oracle Database is running. If it is not running, then exit Oracle 
Counters for Windows Performance Monitor, and start the database.

2. If the database is running but no data or Oracle Database objects appear, then 
check the error file for Oracle Counters for Windows Performance Monitor:

ORACLE_BASE\ORACLE_HOME\dbs\OPERFver.log

If the log file indicates an invalid host string or password, then check the 
registry for correct values for Hostname, Password, and Username. See 
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services" on 
page 14-8 for further information about these values.

3. Restart Oracle Counters for Windows Performance Monitor.

Using Event Viewer
Oracle Database for Windows problems and other significant occurrences are 
recorded as events in an application event log. View and manage these recorded 
events in Event Viewer. 

To access Event Viewer:

1. Choose Start > Programs > Administrative Tools > Event Viewer.

The Event Viewer window appears.

2. Choose Application from the Log menu.

Figure 7–1 displays the Application view window, Table 7–2 shows what is 
recorded in each column, and Table 7–3 interprets icons that appear at the left edge 
of the viewer.
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Figure 7–1 Application View Window

Table 7–2 Application View Definitions

Column Name Definition

Date Date event took place

Time Time event took place

Source Application that recorded event

Category Classification of event

Event Unique number assigned to event

Computer Computer name on which event occurred
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Reading Event Viewer
Oracle Database for Windows events display with a source of Oracle.SID. 

Event number 34 specifies an audit trail event. These events are recorded if 
parameter AUDIT_TRAIL is set to db (true) or os in the initialization parameter 
file. Option os enables system wide auditing and causes audited records to be 
written to Event Viewer. Option db enables system wide auditing and causes 
audited records to be written to the database audit trail (table SYS.AUD$). Some 
records, however, are written to Event Viewer.

Event numbers other than 34 specify general database activities, such as an instance 
being started or stopped.

When you double-click an icon in Event Viewer, the Event Detail dialog appears 
with more information about the selected event. Figure 7–2, for example, shows 
details about EventID 1011. In the Description field you will find a text description 
of the event. In the Data field you can choose Bytes to see the information in 
hexadecimal format or Words to see DWORDS for the same data.

Table 7–3 Event Viewer Icons

Icon Event Type Suggested Action

Red Stop Sign Error Always check these icons.

Lower-case "i" in 
Blue Circle

Information Noncritical system events. Check these icons only to 
track a specific event.

Exclamation Point 
in Yellow Circle

Warning Special events, such as instance termination or 
services shutdown. Investigate these icons, but they 
are usually noncritical.
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Figure 7–2 Event Detail Dialog

Managing Event Viewer
Setting AUDIT_TRAIL to db or os causes more records to be written to Event 
Viewer. This can fill up the Event Viewer log file. Follow these procedures to 
increase log file size:

1. Choose Log Settings from the Log menu.

The Event Log Settings dialog appears.

2. Adjust the setting in the Maximum Log Size field to an appropriate level.

3. Click OK.

You are returned to Event Viewer.

See Also: Microsoft Windows documentation for more 
information on using Event Viewer
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Trace Files
Oracle Database for Windows background threads use trace files to record 
occurrences and exceptions of database operations, as well as errors. Background 
thread trace files are created regardless of whether parameter BACKGROUND_DUMP_
DEST is set in the initialization parameter file. If BACKGROUND_DUMP_DEST is set, 
then trace files are stored in the directory specified. If the parameter is not set, then 
trace files are stored in directory ORACLE_BASE\ADMIN\db_name\bdump.

Oracle Database creates a different trace file for each background thread. The name 
of the trace file contains the name of the background thread, followed by the 
extension ".TRC". Sample trace file syntax includes:

■ SIDDBWR.TRC

■ SIDSMON.TRC

where SID is the name of the instance.

Trace files are also created for user threads if parameter USER_DUMP_DEST is set in 
the initialization parameter file. Trace files for user threads have the form 
oraxxxxx.trc, where xxxxx is a 5-digit number indicating the Windows thread 
ID.

Alert Files
Alert files contain important information about error messages and exceptions that 
occur during database operations. Each Oracle Database for Windows instance has 
one alert file; information is appended to the file each time you start the instance. 
All threads can write to the alert file.

For example, when automatic archiving of redo logs is halted because no disk space 
is available, a message is placed in the alert file. The alert file is the first place to 
check if something goes wrong with the database and the cause is not immediately 
obvious.

The alert file is named alert_SID.log and is found in the directory specified by 
parameter BACKGROUND_DUMP_DEST in the initialization parameter file. If 
parameter BACKGROUND_DUMP_DEST is not set, then file alert_SID.log is 

Caution: Audit information cannot be spooled to a file. Parameter 
AUDIT_FILE_DEST is not supported in Windows and should not 
be added to the initialization parameter file.
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generated in ORACLE_BASE\admin\db_name\bdump. Alert files should be 
deleted or archived periodically.

Viewing Threads
To view information on Oracle Database threads using Oracle Administration 
Assistant for Windows, you must either enable Windows native authentication for 
the database or run utility ocfgutil.exe with arguments username and 
password. The utility stores the username and password in the following registry 
location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOraConfig

When Windows native authentication is not enabled, Oracle Remote Configuration 
Agent retrieves the username and password from this registry key to log in to the 
database.

To view information on Oracle Database threads using Oracle Administration 
Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

2. Right-click the SID, where SID is a specific instance name, such as orcl.

3. Choose Process Information.

The Process Information dialog appears, listing name, type, user, thread ID, and 
CPU usage for each Oracle Database thread.

4. To terminate a thread, select it and click Kill Thread.
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8
Tuning Windows to Optimize Oracle

Database

This chapter describes how to tune the Windows Server operating system to ensure 
that Oracle Database is running in the best possible environment.

This chapter contains these topics:

■ Windows Tuning Overview

■ Large Page Support

■ User Threads

■ Reduce Priority of Foreground Applications on Server Console

■ Configure Windows Server to Be an Application Server

■ Disable Unnecessary Services

■ Remove Unused Network Protocols

■ Reset Network Protocol Bind Order

■ Apply Latest Reliable Windows Server Service Pack

■ Use Hardware or Operating System Striping

■ Multiplex Windows Server Virtual Memory Paging File

■ Close All Unnecessary Foreground Applications

Note: For the sake of brevity, this discussion uses the collective 
term Windows Server when a statement applies to Windows 2000 
Server and Windows NT Server. 
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Windows Tuning Overview
Windows Server operating systems offer considerably fewer tuning adjustments 
than UNIX. This difference constrains systems administrators when they try to 
optimize Windows Server performance, but it also makes Windows Server easier to 
use.

There are still ways, however, to make Windows Server a better application server 
environment for Oracle Database. Most of the operating system specific procedures 
described in this chapter enable Oracle Database to reserve more system resources, 
such as CPU, memory, and disk I/O. 

In addition, because Oracle Database is a high-performance database management 
system that effectively uses resources of your Windows computer, it should not also 
serve as any of the following:

■ Primary or backup domain controller

■ File or print server

■ Remote access server

■ Router

These configurations consume network, memory, and CPU resources. In addition, 
the Windows computer that is running Oracle Database should not be locally 
accessed with a high frequency or intensively used for local user processing, unless 
it has enough resources to accommodate all this activity.

Large Page Support
Large page support is a new feature of Oracle Database 10g. It provides a 
performance boost for memory-intensive database instances running on Windows 
Server 2003. By taking advantage of newly introduced operating system support, 
Oracle Database 10g can now make more efficient use of processor memory 
addressing resources. Specifically, when large page support is enabled, the CPUs in 

Note: Information presented in this chapter does not apply to 
Oracle Database installations on Windows NT Workstation. It does 
apply to Oracle Database installations on Windows NT Server and 
Windows NT Server 4.0, Enterprise Edition. Windows NT Server 
4.0, Enterprise Edition includes capability for using additional 
products. One such product is Microsoft Cluster Server, which is 
required to implement Oracle Fail Safe.
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the system will be able to access the Oracle Database buffers in RAM more quickly. 
Instead of addressing the buffers in 4KB increments, the CPUs are told to use 4MB 
page sizes when addressing the database buffers.

This feature is particularly useful when the Oracle buffer cache is several gigabytes. 
Smaller-sized configurations will still see a gain when using large pages, but the 
gain will not be as great as when the database is accessing large amounts of 
memory.

To enable large page support, set ORA_LPENABLE to 1 in the Oracle key of the 
Windows Server 2003 registry.

User Threads
Oracle Database for Windows executes in a single process with multiple threads 
servicing user requests and background tasks. These threads are scheduled by the 
Windows operating system. In some circumstances, performance can be improved 
by running Oracle in user-thread mode. User threads are light-weight, 
application-scheduled threads, also referred to in Windows terminology as fibers. In 
user-thread mode, Oracle threads are scheduled not by the operating system, but by 
Oracle itself. Oracle can then use its knowledge about contention around shared 
resources to achieve more efficient and scalable thread scheduling.

When to Use User-Thread Mode
User-thread mode should only be enabled as a means to improve the performance 
of an optimized Oracle Database. That is, you should first attempt to optimize the 
default configuration of Oracle Database for Windows as discussed elsewhere in 
this chapter.

User-thread mode gives performance gains only when an opportunity exists to 
improve the scheduling of Oracle threads. This situation typically occurs when an 
Oracle instance has fully utilized the CPU and is running a load that contains a high 
ratio of concurrent user requests to number of CPUs. Oracle wait events may 
provide clues that such opportunities exist.

Almost every wait event has a scheduling component. Each time a thread waits for 
a certain event, part of the wait time can be due to scheduling. Some of the 
scheduling delay may be mandatory. For example, if the system is heavily loaded, 

See Also: Oracle Database Performance Tuning Guide for more 
information on Oracle wait events
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then there will be scheduling delay because not all runnable threads can run on a 
given CPU at the same time. But some of the delay may be due to sub-optimal 
scheduling. By enabling user threads, you allow Oracle to optimize the scheduling 
of different tasks and therefore improve the average wait time of any wait event 
that has a non-mandatory scheduling component.

For example, the Oracle wait event log file sync measures the time it takes for 
an Oracle thread executing a user task to commit a transaction. This includes the 
time taken to actually write to the log file, measured by log file parallel 
write, and some scheduling delay. Even though the transaction is committed, the 
wait time continues to grow until the thread waiting for log file sync is 
allowed to run again. Therefore, one indicator that user threads should be used is if 
log file sync has a high average wait time and other wait events that are 
included in the log file sync wait time (for example, log file parallel 
write) have a low average wait time.

Another example is the Oracle wait event free buffer waits, which happens 
when the DBWR thread is unable to write out dirty buffers fast enough. One 
possible cause of this wait event is too-seldom scheduling of the DBWR background 
thread. By enabling user-threads, you give Oracle control over when the DBWR 
background thread is scheduled. Oracle can then schedule DBWR often enough to 
keep free buffer waits at a minimum.

Other wait events with a scheduling component include db file sequential 
read, db file parallel read, and db file scattered read. Part of the 
measured time for these wait events is the actual time it takes for the I/O to 
complete. But during the remainder of the wait time a thread is waiting to be 
rescheduled. By looking at disk statistics, using tools like Windows Perfmon, you 
can find out what portion of wait time is I/O latency and what portion is 
scheduling delay. User-thread mode can help reduce the non-mandatory scheduling 
delay.

User-thread mode on Windows is not currently supported in the following 
configurations:

■ Real Application Clusters

■ Microsoft Transaction Server

Note: User-thread mode should be used only after other means of 
reducing free buffer waits have been exhausted. See Oracle 
Database Performance Tuning Guide for more information.
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■ Oracle Data Mining

■ Third party libraries used directly by Oracle

Enabling User-Thread Mode
Follow this procedure to enable user-thread mode:

1. Shut down all instances.

2. Stop all Oracle services (both for the database and for the listener).

3. Exit any SQL*Plus sessions.

4. Make sure that the ORACLE_HOME environment variable is set.

5. Open a command prompt and enter cd /d %ORACLE_HOME%\bin

6. Run enable_fibers.bat

Disabling User-Thread Mode
Follow this procedure to disable user-thread mode:

1. Shut down all instances.

2. Stop all Oracle services (both for the database and for the listener).

3. Exit any SQL*Plus sessions.

4. Make sure that the ORACLE_HOME environment variable is set.

5. Open a command prompt and enter cd /d %ORACLE_HOME%\bin

6. Run disable_fibers.bat

Reduce Priority of Foreground Applications on Server Console
One of the settings provided by default during installation of Windows Server gives 
interactive foreground applications priority over every background process. To 
prevent foreground applications on the server console from taking excessive 
processor time away from Oracle Database, you can reduce priority for foreground 
applications.

See Also: Your Windows documentation for instructions on 
reducing priority of foreground applications
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Configure Windows Server to Be an Application Server
Windows memory manager divides up system memory into three different pools 
described in Table 8–1.

Windows Server memory manager tries to balance each application's usage of 
memory by dynamically paging memory between physical RAM and a virtual 
memory paging file. If an application is particularly memory-intensive (like Oracle 
Database) or if a large number of applications are running concurrently, then 
combined memory requirements of the applications may exceed physical memory 
capacity.

The large proportion of memory reserved for file caching (41%) can be quite 
beneficial to file and print servers. But it may not be advantageous to application 
servers that often run memory-intensive network applications. A Windows Server 
file cache is particularly unnecessary for Oracle Database, which performs its own 
caching through System Global Area.

You can reset the Windows Server memory model from the default file and print 
server, with its large file cache, to a network applications model, with a reduced file 
cache and more physical memory available for Oracle Database.

Disable Unnecessary Services
After you have significantly reduced the file cache as described in "Configure 
Windows Server to Be an Application Server" on page 8-6, you can retrieve 
additional physical memory for Oracle Database by disabling services not needed 
for core operating system functionality. Unnecessary services include:

■ License Logging Service 

■ Plug and Play 

■ Remote Access Autodial Manager 

Table 8–1 Windows Server Memory Shares

Pool Percent of Total Memory

Kernel and other system services 9%

File Cache 41%

Paged Memory 50%

See Also: Your Windows documentation for instructions
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■ Remote Access Connection Manager 

■ Remote Access Server 

■ Telephony Service 

Consult with your systems administrator to identify other unnecessary services.

Do not disable any of the following services:

■ Alerter 

■ Computer Browser 

■ EventLog 

■ Messenger 

■ OracleServiceSID 

■ OracleHOME_NAMETNSListener 

■ OracleStartSID (Oracle8 release 8.0.6 and earlier) 

■ Remote Procedure Call (RPC) Service 

■ Server 

■ Spooler 

■ TCP/IP NetBIOS Helper 

■ Workstation 

Remove Unused Network Protocols 
Remove all unnecessary network protocols on Windows so that processing time can 
be concentrated on servicing only critical protocols.

See Also: Your Windows documentation for instructions on 
disabling unnecessary services

See Also: Your Windows documentation for instructions on 
removing unnecessary network protocols
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Reset Network Protocol Bind Order
If multiple protocols must be installed on the server, you can give the protocol most 
frequently used by Oracle Database highest priority by resetting the network 
protocol bind order.

Apply Latest Reliable Windows Server Service Pack
Microsoft releases operating system patches, called Service Packs, on a quarterly 
basis. Service Packs are collections of bug fixes and product enhancements to the 
basic Windows Server release. In general, apply Service Packs as soon as it is safe to 
do so, since they fix bugs and can improve Windows Server performance or 
functionality.

While Service Packs are supposed to fix bugs, there have been reports (for example, 
the initial release of Windows NT Server 4.0 Service Pack 2) of bugs within the 
patch updates themselves. In general, it is safest to wait a few weeks after a Service 
Pack is released before implementing it. This allows time for other field sites to 
report any problems with the SP release.

The latest Windows Server Service Packs may be downloaded as self-extracting 
archives from http://support.microsoft.com

Unless there are assurances that the Service Pack works without flaws on Windows 
Server, choose to create an Uninstall directory. This enables the Service Pack to be 
removed and the original configuration to be restored.

Service Pack files overwrite similarly-named files in the previous Windows Server 
configuration. However, Service Pack files can be overwritten in turn by setup 
programs that copy files from the original installation media.

For example, installing a new network protocol or printer driver usually requires 
copying files from original Windows Server installation media. When Service Pack 
files are comprehensively or selectively overwritten, the Service Pack must be 
re-applied.

Use Hardware or Operating System Striping
Compared to CPU and memory speeds, hard disk drives are extremely slow. Now 
that hard disk drives are relatively inexpensive, Oracle recommends that Windows 
Server use logical volumes comprised of striped physical disks. Data striping is an 

See Also: Your Windows documentation for instructions on 
resetting network protocol bind order
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effective means of reducing the impact of relatively slow hard drives by distributing 
file I/O across a number of hard drives simultaneously.

Striping data across a number of disks is one example of a redundant array of 
inexpensive disks (RAID). There are several different types of RAID, also referred to 
as RAID levels, ranging from high performance to high reliability. The three most 
common RAID levels in Oracle Database installations are RAID-0, RAID-1, and 
RAID-5. Descriptions of each RAID level follow Table 8–2, which shows each level's 
read and write penalties.

Disk Striping
RAID level 0 enables high-performance, fault-intolerant disk striping. Multiple 
physical hard disks are aggregated into a logical whole, either by a disk controller 
or through the operating system (for example, Windows 2000 Server striped 
volumes). Data operations against the logical volume are broken down into as 
many chunks as there are physical drives in the array, making simultaneous use of 
all disks. Given identical hard disks, if one hard disk has a throughput rate of 
DISKRATE operations/second, then a RAID 0 logical volume has a rate of:

(DISKRATE * [number of physical  drives in array]) operations/second

The downside of RAID 0 is its lack of fault tolerance. If one disk in the logical 
volume fails, the whole volume fails and must be restored from a backup.

Disk Mirroring
RAID level 1 enables fault tolerant disk mirroring with some chance of a 
performance penalty. Essentially, every write to a mirrored disk is duplicated on 
another drive dedicated to this purpose (the mirror drive). If the mirrored disk fails, 
the mirror drive is brought online in real time. After the faulted drive is replaced, 
the mirror configuration can be reestablished.

Table 8–2 RAID Levels in Oracle Database Installations

RAID Level Read Penalty1

1 Read penalty is ratio of I/O operations to read requests.

Write Penalty2

2 Write penalty is ratio of I/O operations to write requests.

0 (Disk Striping) 1:1 1:1

1 (Disk Mirroring) 1:1 2:1

0 + 1 1:1 2:1

5 (Distributed Data Gathering) 1:1 4:1
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The read penalty for RAID level 1 is nominally 1:1, but it may benefit from split 
reads on some controllers. When the controller knows which mirror can be accessed 
fastest, for example, it can lower seek times by directing I/O operations to that disk.

Disk Striping + Mirroring
RAID level 0+1 enables mirroring of an array of striped hard disks. This is a blend 
of RAID 0 and RAID 1, offering high-performing fault tolerance.

Distributed Data Guarding
RAID level 5, also known as disk striping with parity, eliminates the costly 
requirement to mirror. In RAID 5, multiple hard disks are aggregated into a striped 
logical volume, similar to RAID 0, but each drive contains parity information such 
that any single drive failure is tolerated. With one failed drive, a RAID-5 system can 
allow continued access to data, although access times are greatly reduced due to 
on-the-fly rebuilding of bytes from parity information. RAID-5 solutions usually 
allow hot-swapping of faulty drives with replacements, triggering a rebuild of the 
failed drive's data onto the replacement from parity information. 

The write penalty of 4:1 results from 2 reads and 2 writes during parity calculation.

Multiple Striped Volumes for Sequential and Random Access
If there are enough physical disks in Windows Server, create at least two striped 
volumes (in addition to a standalone hard disk or striped volume for the operating 
system). One striped volume can be used for sequential data access, and the other 
can be used for random data access.

Oracle Database redo logs and archived redo logs, for example, are written in 
sequential order. Because of reduced head movement, hard disks perform best 
when reading or writing sequential data.

Oracle Database data files, however, are usually accessed in random order. Random 
access in a hard disk results in significant head movement, translating to slower 
data access.

Unless redo logs are separated from datafiles (at physical device level), undo file 
I/O contention may result, increasing access times for both types of files.
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Multiplex Windows Server Virtual Memory Paging File
Some virtual memory paging is likely even if Oracle Database is the only network 
application running on Windows Server, because Windows Server memory 
manager will attempt to move seldom-used pages to disk to free up more physical 
memory for hot pages.

Multiplexing the Windows Server virtual memory paging file is a good strategy to 
boost overall system performance. Splitting the paging file onto at least two 
different physical volumes (or logical volumes as long as underlying physical 
volumes do not overlap) provides a significant performance boost to virtual 
memory swapping operations.

Even though this is a good technique to increase speed of virtual memory paging, 
too much paging activity is still a performance hit and should be corrected by 
adding more RAM to the server.

General Page File Sizing Tip
Oracle recommends that total combined size of your page files be at least equal to 
physical RAM on your computer. Configurations where combined size is two to 
four times the size of physical RAM are not uncommon. Minimize paging as much 
as possible. But situations in which the operating system runs out of or low on 
paging space are to be avoided at all costs. Adequately-sized paging files spaced 
across physical disks spread out I/O most efficiently, because the operating system 
spreads paging evenly across page files. 

Close All Unnecessary Foreground Applications
Once procedures in previous sections have been applied, remember to close any 
unnecessary foreground applications. First, remove all applications from Startup 
folders of Windows Server console operators. Second, minimize the window when 
executing long-running scripts from a command prompt, so that Windows Server 
can focus on the operation and not on a flood of window repaint messages. Third, 
disable screen savers, which can quickly saturate the CPU. If a screen saver must be 
run, choose Blank Screen, which uses the least amount of processing time.

Note: Internal read/write batch size for Windows is 4K.
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9
Authenticating Database Users with

Windows

This chapter describes authentication of Oracle Database users with Windows 
operating systems. 

This chapter contains these topics:

■ Windows Native Authentication Overview

■ Windows Authentication Protocols

■ User Authentication and Role Authorization Methods

■ Operating System Authentication Enabled at Installation
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Windows Native Authentication Overview
Oracle Database can use Windows user login credentials to authenticate database 
users. Benefits include:

■ Enabling users to connect to Oracle Database without supplying a username or 
password

■ Centralizing Oracle Database user authentication and role authorization 
information in Windows NT or Windows 2000, which frees Oracle Database 
from storing or managing user passwords or role information

The Windows native authentication adapter (automatically installed with Oracle 
Net Services) enables database user authentication through Windows. This enables 
client computers to make secure connections to Oracle Database on a Windows 
server. The server then permits the user to perform database actions on the server.

Windows Authentication Protocols
The Windows native authentication adapter works with Windows authentication 
protocols to enable access to Oracle Database. 

■ Kerberos is the default authentication protocol for Windows 2000. 

■ NT LAN Manager (NTLM) is the default protocol for Windows NT 4.0.

If the user is logged on as a Windows 2000 domain user from a Windows 2000 
computer, then Kerberos is the authentication mechanism used by the NTS adapter.

For all other users, NTLM is the authentication mechanism used by the NTS 
adapter. 

If authentication is set to NTS on a standalone Windows 2000 or Windows NT 4.0 
computer, ensure that Windows service NT LM Security Support Provider is 

Note: Current user database links are not supported with 
Windows native authentication.

Note: This chapter describes using Windows native 
authentication methods with Windows 2000 and Windows NT 4.0. 
For information on Secure Sockets Layer (SSL) protocol and Oracle 
Internet Directory, see Oracle Advanced Security Administrator's 
Guide and Oracle Internet Directory Administrator's Guide.
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started. If this service is not started on a standalone Windows 2000 or Windows NT 
4.0 computer, then NTS authentication fails. This issue is applicable only if you are 
running Windows 2000 or Windows NT 4.0 in standalone mode.

Client computers do not need to specify an authentication protocol when 
attempting a connection to Oracle Database. Instead, Oracle Database determines 
the protocol to use, completely transparent to the user. The only Oracle Database 
requirement is to ensure that parameter SQLNET.AUTHENTICATION_SERVICES 
contains nts in the following file on both the client and database server:

ORACLE_BASE\ORACLE_HOME\network\admin\sqlnet.ora

This is the default setting for both after installation. For Oracle8 release 8.0.x 
releases, you must manually set this value.

If typical, your Oracle Database network includes client computers and database 
servers, and computers on this network may use different Oracle Database software 
releases on different Windows operating systems on different domains. This 
combination of different releases means that the authentication protocol being used 
can vary. 

Table 9–1 lists Oracle Database software and Windows operating system releases 
required to enable Kerberos as the default authentication protocol:

For all other combinations of Windows operating system and Oracle Database 
software releases used in your network, the authentication protocol used is NTLM.

User Authentication and Role Authorization Methods
This section describes how user login credentials are authenticated and database 
roles are authorized in Windows NT 4.0 or Windows 2000 domains. User 
authentication and role authorization are defined in Table 9–2.

Table 9–1 Software Requirements to Enable Kerberos Authentication Protocol

Location Windows Software Oracle Database Software

Client Computer Windows NT 4.0 or Windows 2000 Oracle8i Client or later

Database Computer Windows NT 4.0 or Windows 2000 Oracle8i Database or later 

Domain Windows 2000 None

See Also: Microsoft Windows documentation for more 
information on each authentication protocol
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Oracle Database supports user authentication and role authorization in Windows 
NT 4.0 domains. Table 9–3 provides descriptions of these basic features.

Authentication and Authorization Methods To Use
Table 12–4 describes user authentication and role authorization methods to use 
based on your Oracle Database environment:

Table 9–2 User Authentication and Role Authorization Defined

Feature Description More Information

User 
authentication

Process by which the database uses the user's 
Windows login credentials to authenticate the 
user.

Oracle 2 Day DBA 

Role 
authorization

Process of granting an assigned set of roles to 
authenticated users.

Oracle 2 Day DBA 

Table 9–3 Basic Features of User Authentication and Role Authorization

Feature Description

Authentication 
of external 
users

Users are authenticated by the database using the user's Windows login 
credentials enabling them to access Oracle Database without being 
prompted for additional login credentials. 

Authorization 
of external 
roles

Roles are authorized using Windows local groups. Once an external role is 
created, you can grant or revoke that role to a database user. Initialization 
parameter OS_ROLES is set to false by default. You must set OS_ROLES 
to true to authorize external roles.

Table 9–4 User Authentication and Role Authorization Methods

Method Database Environment

Enterprise users 
and roles

You have many users connecting to multiple databases. 

Enterprise users have the same identity across multiple databases. 
Enterprise users require use of a directory server.

Use enterprise roles in environments where enterprise users assigned to 
these roles are located in many geographic regions and must access 
multiple databases. Each enterprise role can be assigned to more than one 
enterprise user in the directory. If you do not use enterprise roles, then 
you have to assign database roles manually to each database user. 
Enterprise roles require use of a directory server.
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Operating System Authentication Enabled at Installation
When you install Oracle Database, a special Windows local group called ORA_DBA 
is created (if it does not already exist from an earlier Oracle Database installation), 
and your Windows username is automatically added to it. Members of local group 
ORA_DBA automatically receive the SYSDBA privilege.

Membership in ORA_DBA enables you to: 

■ Connect to local instances of Oracle Database without a password with the 
command

CONNECT / AS SYSDBA

■ Connect to remote instances of Oracle Database without a password with the 
command

CONNECT /@net_service_name AS SYSDBA 

where net_service_name is the net service name of the remote instance of 
Oracle Database

■ Perform database administration procedures such as starting and shutting 
down local databases

■ Add additional Windows users to ORA_DBA, enabling them to have the SYSDBA 
privilege

External users 
and roles

You have a smaller number of users accessing a limited number of 
databases. External users must be created individually in each database 
and do not require use of a directory server.

External roles must also be created individually in each database, and do 
not require use of a directory server. External roles are authorized using 
group membership of the users in local groups on the system.

See Also: Oracle Advanced Security Administrator's Guide for more 
information on Enterprise users and roles

Table 9–4 User Authentication and Role Authorization Methods

Method Database Environment
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10
Administering External Users and Roles on

Windows

External users and roles are in general defined by something external to Oracle 
Database. In a Windows environment, they are defined by the operating system. 

This chapter describes external user and external role creation and management 
using either Oracle Administration Assistant for Windows or by a combination of 
Oracle Database command line tools, Registry Editor, and other Windows tools.

This chapter contains these topics:

■ Oracle Administration Assistant for Windows

■ Manually Administering External Users and Roles

Note: Both methods can also administer external users and roles 
in Windows 2000 domains, but cannot be used to administer an 
enterprise user or an enterprise role. See Oracle Advanced Security 
Administrator's Guide for more information on tools available for 
administering enterprise users and roles.
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Oracle Administration Assistant for Windows
Oracle Administration Assistant for Windows runs from Microsoft Management 
Console and enables you to configure the following Oracle Database users and 
roles so that the Windows operating system can authenticate them, and they can 
access Oracle Database without a password: 

■ Regular Windows domain users and global groups as external users

■ Windows database administrators (with the SYSDBA privilege)

■ Windows database operators (with the SYSOPER privilege) 

In addition, Oracle Administration Assistant for Windows can create and grant 
local and external database roles to Windows domain users and global groups. 

With Oracle Administration Assistant for Windows, none of the following need be 
done manually: 

■ Create local groups that match the database system identifier and role

■ Assign domain users to these local groups

■ Authenticate users in SQL*Plus with CREATE USER username IDENTIFIED 
EXTERNALLY 

This section describes how to perform the following tasks with Oracle 
Administration Assistant for Windows:

■ Adding a Computer and Saving Your Configuration

■ Granting Administrator Privileges for All Databases on a Computer

■ Granting Operator Privileges for All Databases on a Computer

■ Connecting to a Database

■ Viewing Database Authentication Parameter Settings

■ Creating an External Operating System User

■ Creating a Local Database Role

■ Creating an External Operating System Role

■ Granting Administrator Privileges for a Single Database

■ Granting Operator Privileges for a Single Database
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Managing a Remote Computer
If you want to use Oracle Administration Assistant for Windows to manage a 
remote computer, you must have administrator privileges for the remote computer. 
Oracle Administration Assistant for Windows always creates users in Oracle 
Database with the domain name as the prefix. If you are managing Oracle7 release 
7.x or later databases remotely, you must set registry parameter OSAUTH_PREFIX_
DOMAIN to true on the remote computer. This parameter is located in

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME  

If a Windows 2000 computer is not identified with a Domain Name System (DNS) 
domain name, you will receive the following error message:

Calling query w32RegQueries1.7.0.17.0  RegGetValue
Key = HKEY_LOCAL_MACHINE
SubKey = SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Value = Domain
Query Exception: GetValueKeyNotFoundException
Query Exception Class: class oracle.sysman.oii.oiil.OiilQueryException
...

To assign a DNS name:

1. Choose Start > Settings > Control Panel > System > Network Identification > 
Property > More > Primary DNS.

2. Enter a domain name, such as US.ORACLE.COM.

Note: Oracle Administration Assistant for Windows runs from 
Microsoft Management Console, which is automatically included in 
Windows 2000. If you are using Windows NT 4.0, you must do one 
of the following:

■ Install Microsoft Windows NT 4.0 Option Pack, which includes 
Microsoft Management Console

■ Download Microsoft Management Console from the Microsoft 
Web site: http://www.microsoft.com
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Adding a Computer and Saving Your Configuration
When you use Oracle Administration Assistant for Windows for the first time, it 
adds the local computer to its navigation tree. You can then add other computers.

To add a computer to the Microsoft Management Console tree:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Microsoft Management Console starts.

2. Double-click Oracle Managed Objects.

The Computer icon appears.

3. Right-click Computers.

4. Choose New > Computer.

The Add Computer dialog appears.

5. Specify the domain and computer name for the computer on which Oracle 
Database is installed.

6. Click OK.

7. Double-click Computers to display the computer you added.

8. Double-click the computer you added. Several nodes for authenticating 
database administrators and operators appear. 
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The OS Database Administrators - Computer node creates an operating 
system-authenticated database administrator with SYSDBA privileges for every 
database instance on the computer. The OS Database Operators - Computer 
node creates an operating system-authenticated database operator with 
SYSOPER privileges for every database instance on the computer.

9. Save your configuration in a console file by choosing Save in the Console main 
menu. You can now authenticate database administrators and operators for all 
instances on the computer.

Granting Administrator Privileges for All Databases on a Computer
To grant database administrator (SYSDBA) privileges to database administrators 
(DBAs) for all databases on a computer:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Oracle Administration Assistant for Windows starts.

2. Right-click OS Database Administrators - Computer.

3. Click Add/Remove.

The OS Database Administrators - Computer for hostname dialog appears.
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4. Select the domain of the user to which to grant SYSDBA privileges from the 
Domain list. 

5. Select the user. 

6. Click Add.

The user now appears in the OS Database Administrators - Computer window. 

7. Click OK.
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Granting Operator Privileges for All Databases on a Computer
To grant database operator (SYSOPER) privileges to DBAs for all databases on a 
computer:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Oracle Administration Assistant for Windows starts.

2. Right-click OS Database Operators - Computer.

3. Click Add/Remove.

The OS Database Operators - Computer for hostname dialog appears.
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4. Select the domain of the user to which to grant SYSOPER privileges from the 
Domain list. 

5. Select the user.

6. Click Add. 

The user now appears in the OS Database Operators - Computer window. 

7. Click OK. 

Connecting to a Database
To enable Secure Sockets Layer (SSL) when connecting to Oracle Database, start the 
Oracle Database service and the listener service in the same user account as the 
wallet created in Oracle Wallet Manager. Do not use the default user account in the 
Windows Services dialog. If the Oracle Database service and the listener service are 
started in the default user accounts, then SSL does not work, and the listener does 
not start. Support for SSL is an Oracle Advanced Security feature. Oracle Wallet 
Manager is also an Oracle Advanced Security feature.

To connect to a database:

1. Right-click the database instance you want to access in the Microsoft 
Management Console scope pane. In the example here, a connection is to be 
made to ORCL:

See Also: Oracle Advanced Security Administrator's Guide for more 
information on SSL support
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2. Choose Connect Database.

If you connect to Oracle Database, the following Windows nodes appear 
beneath the instance. If these nodes do not appear, double-click the instance.

■ External OS Users

■ Local Roles

■ External OS Roles
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■ OS Database Administrators

■ OS Database Operators

Troubleshooting Connection Problems
When connecting to a local computer, Oracle Administration Assistant for Windows 
first tries to connect to the database as a SYSDBA, using the Bequeath networking 
protocol. When connecting to a remote computer, Oracle Administration Assistant 
for Windows first tries to connect to the database using Windows native 
authentication as a SYSDBA, using the TCP/IP networking protocol (port 1521 or 
the deprecated 1526). If it is unsuccessful, one or more dialogs appear and prompt 
you to enter information to connect to the database.

The dialog shown here appears because the Windows domain user with which you 
are attempting to connect to Oracle Database is not recognized as an authenticated 
user with SYSDBA privileges. Enter an Oracle Database username and password to 
access the database. To avoid being prompted with this dialog again, configure your 
domain user to be a database administrator authenticated by the Windows 
operating system.

The next dialog appears either because you are not using the TCP/IP networking 
protocol to connect to a remote installation of Oracle Database or because Oracle 
Database is not running. Using a protocol other than TCP/IP (Named Pipes for 
example) causes this dialog to appear each time you attempt a remote connection.
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If you do not want this dialog to appear each time, then change to the TCP/IP 
protocol and make sure the Oracle Net Services listener for the database is listening 
on the default port 1521 (or the deprecated default port 1526). Otherwise, this dialog 
appears every time. Ensure also that Oracle Database is started.

1. Enter the net service name with which to connect to Oracle Database. You must 
enter a net service name regardless of the authentication method you select. 

2. If you want to access the database with an Oracle Database username and 
password, select the Database Authenticated option. This username and 
password must exist in Oracle Database and have the SYSDBA privilege.

3. If you want to access the database with the Windows domain user with which 
you are currently logged in, select the OS Authenticated Connection as SYSDBA 
option. This domain user must already be recognized by Windows as an 
authenticated user with SYSDBA privileges. Otherwise, your logon fails.

Note: Oracle Net Services provides a Trace Assistant tool that 
helps diagnose connection problems by converting existing trace 
file text into a more readable format. See "Using the Trace Assistant 
to Examine Trace Files" in Oracle Net Services Administrator's Guide.
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Viewing Database Authentication Parameter Settings
To view database authentication parameter settings:

1. Right-click the database.

2. Choose Properties.

3. The Properties dialog appears displaying the following parameter values:

■ OS_AUTHENT_PREFIX

■ OS_ROLES

OS_AUTHENT_PREFIX is an init.ora file parameter that authenticates external 
users attempting to connect to Oracle Database with the user's Windows username 
and password. The value of this parameter is attached to the beginning of every 
user's Windows username. 

By default, the parameter is set to none ("") during Oracle Database creation. 
Therefore, a Windows domain username of frank is authenticated as username 
frank. If you set this parameter to xyz, then Windows domain user frank is 
authenticated as user xyzfrank.

OS_ROLES is an init.ora file parameter that, if set to true, enables the Windows 
operating system to manage authorization of an external role for a database user. 
By default, OS_ROLES is set to false. You must set OS_ROLES to true and restart 
Oracle Database before you can create external roles. If OS_ROLES is set to false, 
Oracle Database manages granting and revoking of roles for database users. 

If OS_ROLES is set to true, and you assign an external role to a Windows global 
group, then it is granted only at the Windows global group level, and not at the 
level of the individual user in this global group. This means that you cannot revoke 
or edit the external role assigned to an individual user in this global group through 
the Roles tab of the User Name Properties dialog at a later time. Instead, you must 
use the field in the Assign External OS Roles to a Global Group dialog to revoke the 
external role from this global group (and therefore all its individual users). 

External roles assigned to an individual domain user or local roles (with OS_ROLES 
set to false) assigned to an individual domain user or Windows global group are 
not affected by this issue. They can be edited or revoked. 

If OS_ROLES is set to true, you cannot grant local roles in the database to any 
database user. You must grant roles through Windows. See "Creating a Local 
Database Role" on page 10-23 and "Creating an External Operating System Role" on 
page 10-29 for more information.
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Creating an External Operating System User
The External OS Users node of Oracle Administration Assistant for Windows 
enables you to authenticate a Windows user to access Oracle Database as an 
external user without being prompted for a password. External users are typically 
regular database users (not database administrators) to which you assign standard 
database roles (such as CONNECT and RESOURCE), but do not want to assign 
SYSDBA (database administrator) or SYSOPER (database operator) privileges. 

To create an external operating system user:

1. Follow the steps in "Connecting to a Database" on page 10-9 to connect to a 
database.

2. Right-click External OS Users. A contextual menu appears.

3. Choose Create.
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Create External OS User Wizard starts, and the first of three wizard dialogs 
appears. The first dialog is for Windows Users and Groups.

4. In Domain Users and Groups select the domain in which your Windows 
domain users and global groups are located. 

5. Select the Windows domain users and global groups to which to grant access to 
the database. 
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6. Click Add. The selected users and groups now appear in the New External OS 
Users list. 

7. Click Next. The Profile and Tablespace dialog appears. 

8. In the Assigned Profile list, select a profile for the new external users. A profile 
is a named set of resource limits. If resource limits are enabled, Oracle Database 
limits database usage and instance resources to whatever is defined in the user's 
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profile. You can assign a profile to each user and a default profile to all users 
who do not have specific profiles.

9. In Tablespace Quota double-click the tablespace to assign a tablespace quota. 

10. Click Next. The Roles dialog appears.

11. In Available Roles select the database roles to grant to the new external users. 

12. Click Grant.
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13. Click Finish.

14. Right-click the external user for which you want to view information and select 
Properties. 

The assigned properties appear. 

Creating a Local Database Role
The Local Roles node of Oracle Administration Assistant for Windows enables you 
to create a role and have it managed by the database. Once a local role is created, 
you can grant or revoke that role to a database user. To create a local database role:

1. Follow the steps in "Connecting to a Database" on page 10-9 to connect to a 
database.

2. Right-click Local Roles for the database for which you want to create a local 
role.

3. Choose Create.

Create Local Role Wizard starts, and the first of three wizard dialogs appears. 
The first dialog is for Name and Authentication.

Note: If you select a Windows global group for authentication 
when using Oracle Administration Assistant for Windows, all users 
currently in the group are added to Oracle Database. If at a later 
time, you use a Windows tool to add or remove users in this 
Windows global group, these updates are not reflected in Oracle 
Database. The newly added or removed users must be explicitly 
added or removed in Oracle Database with Oracle Administration 
Assistant for Windows. 
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4. Enter a local role name to use. 

5. In Authentication select None if you want a user to use this local role without 
being required to enter a password. 

Select Password if you want use of this role to be protected by a password. 
These roles can only be used by supplying an associated password with the SET 
ROLE command. See Oracle 2 Day DBA for additional information. 
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Enter the password to use with this role. 

Confirm the password by entering it a second time. 

6. Click Next. The System Privileges dialog appears.

7. In Available System Privileges select the system privileges you want to assign 
to the local role. 

8. Click Grant to grant the selected system privileges to the local role. 
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The Granted System Privileges field displays the list of system privileges 
granted to the local role. To revoke a system privilege, make an appropriate 
selection, then choose Revoke. 

9. If you want to grant Admin Option to this role, click the value in the Admin 
Option column to display a list. This enables you to select Yes. 

10. Click Next. The Roles dialog appears.
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11. In Available Roles select the roles you want to assign to the local role. Both 
local roles and external roles appear in this list. 

12. Click Grant to grant the selected roles to the role. 

The Granted Roles field displays the list of roles granted to the role. Both local 
roles and external roles can appear in this list. To revoke roles, make 
appropriate selections, then choose Revoke. 

13. Click Finish.

Creating an External Operating System Role
The External OS Roles node of Oracle Administration Assistant for Windows 
enables you to create an external role and have it managed by the Windows 
operating system. Once an external role is created, you can grant or revoke that role 
to a database user. To create an external role:

1. Follow the steps in "Connecting to a Database" on page 10-9 to connect to a 
database.

2. Right-click External OS Roles for the database for which to create an external 
role.

3. Choose Create.

Create External OS Role Wizard starts, and the first of three wizard dialogs 
appears. The first dialog is for Name. Authentication: External appears in this 
dialog to indicate that only external roles can be created.

Note: Create External OS Role Wizard is available only if 
init.ora parameter OS_ROLES is set to true. If it is set to false, 
then you must first change it to true and then restart Oracle 
Database.



Oracle Administration Assistant for Windows

10-22 Oracle Database Platform Guide

4. Enter an external role name to use. An external role is a role that is managed by 
the Windows operating system. 

5. Click Next.

The System Privileges dialog appears.
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6. In Available System Privileges select the system privileges you want to assign 
to the external role. 

7. Choose Grant to grant the selected system privileges to the external role. 

8. The Granted System Privileges field displays the list of system privileges 
granted to the external role. To revoke a system privilege, make an appropriate 
selection, then click Revoke. 
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9. If you want to grant Admin Option to this role, choose the value in the Admin 
Option column to display a list. This enables you to select Yes. 

10. Click Next.

The Roles dialog appears.

11. In Available Roles select the roles you want to assign to the external role. Both 
local roles and external roles appear in this list.

12. Click Grant to grant the selected roles to the external role.
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The Granted Roles field displays the list of roles granted to the external role.

13. Click Finish. 

Granting Administrator Privileges for a Single Database
The OS Database Administrators node of Oracle Administration Assistant for 
Windows enables you to authorize a Windows user with SYSDBA privileges for a 
specific instance on a computer. To grant administrator (SYSDBA) privileges for a 
single database: 

1. Follow the steps in "Connecting to a Database" on page 10-9 to connect to a 
database.

2. Right-click OS Database Administrators.

3. Choose Add/Remove.

The OS Database Administrators for instance dialog appears. In the example 
shown here, the instance is MARK: 
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4. In Domain Users and Groups select the domain of the user to which to grant 
SYSDBA privileges from the Domain list. 

5. Select the user. 

The user now appears in OS Database Administrators. 

6. Click OK.

Granting Operator Privileges for a Single Database
The OS Database Operators node of Oracle Administration Assistant for Windows 
enables you to authorize a Windows user with SYSOPER privileges for a specific 
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instance on a computer. To grant operator (SYSOPER) privileges for a single 
database:

1. Follow the steps in "Connecting to a Database" on page 10-9 to connect to a 
database.

2. Right-click OS Database Operators.

3. Choose Add/Remove.

The OS Database Operators for instance dialog appears. In the example 
shown here, the instance is MARK:
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4. In Domain Users and Groups select the domain of the user to which to grant 
SYSOPER privileges from the Domain list. 

5. Select the user.

6. Click Add. 

The user now appears in OS Database Operators. 

7. Click OK. 

Manually Administering External Users and Roles
Instead of using Oracle Administration Assistant for Windows, you can manually 
configure administrators, operators, users, and roles to be authenticated by the 
operating system. Manual configuration involves using Oracle Database command 
line tools, editing the registry, and creating local groups in Active Directory Users 
and Computers. 

All of the following can be manually configured to access Oracle Database without 
a password: 

■ External operating system users 

■ Windows database administrators (with SYSDBA privilege)

■ Windows database operators (with SYSOPER privilege)

In addition, you can manually create and grant local and external database roles to 
Windows domain users and global groups. 

This section describes:

■ Manually Creating an External Operating System User

■ Manually Granting Administrator and Operator Privileges for Databases

■ Manually Creating an External Role

■ Manually Migrating Users

Note: In Windows NT you create local groups in User Manager.
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Manually Creating an External Operating System User
This section describes how to authenticate external operating system users (not 
database administrators) using Windows, so that a password is not required when 
accessing the database. When you use Windows to authenticate external operating 
system users, your database relies solely on the operating system to restrict access 
to database usernames. 

In the following procedure, two Windows usernames are authenticated:

■ Local user frank

■ Domain user frank on domain sales

Local user frank logs into its local Windows client computer to access an instance 
of Oracle Database, which can be on a different computer. To access other databases 
and resources on other computers, the local user must provide a username and 
password each time.

Domain user frank on domain sales logs into a sales domain that includes 
many other Windows computers and resources, one of which contains an instance 
of Oracle Database. The domain user can access all the resources the domain 
provides with a single username and password.

The procedure is divided into two sets of tasks performed on different computers:

■ External User Authentication Tasks on the Oracle Database Server

■ External User Authentication Tasks on the Client Computer

External User Authentication Tasks on the Oracle Database Server
1. Add parameter OS_AUTHENT_PREFIX to your init.ora file.

The OS_AUTHENT_PREFIX value is prefixed to local or domain usernames 
attempting to connect to the server with the user's operating system name and 
password. The prefixed username is compared with Oracle Database 
usernames in the database when a connection request is attempted. Using 
parameter OS_AUTHENT_PREFIX with Windows native authentication 

Note:  Use extreme care when manually configuring 
administrators, operators, users, and roles to be authenticated by 
the operating system. If possible, use Oracle Administration 
Assistant for Windows to perform configuration procedures. 
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methods is the recommended method for performing secure, trusted client 
connections to your server.

2. Set a value for OS_AUTHENT_PREFIX. Your choices are:

■ Any character string

If you specify xyz, as in this procedure's example, then xyz is prefixed to 
the beginning of the Windows username (for example, xyzfrank for local 
user frank or xyzsales\frank for domain user frank on domain 
sales). String values are case insensitive.

■ "" (two double quotes with no space between)

This option is recommended, because it eliminates the need for any prefix 
to Windows usernames (for example, frank for local user frank or 
sales\frank for domain user frank on domain sales).

■ No value specified

If you do not specify a value for OS_AUTHENT_PREFIX, it defaults to OPS$ 
(for example, OPS$frank for local user frank or OPS$sales\frank for 
domain user frank on domain sales).

3. Create a Windows local username for frank with the Computer Management 
tool, or create a domain username for frank with Active Directory Users and 
Computers (if the appropriate name does not currently exist). See your 
Windows documentation for detailed instructions.

4. Do this step only if you are not authenticating a domain name with a user (for 
example, just frank instead of frank on domain sales). Otherwise, go to 
step 8.

a. Start Registry Editor from the command prompt:

C:\> regedt32

b. Go to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID, where ID is 
the Oracle home directory you want to edit. 

c. Choose Edit > Add Value.

The Add Value dialog appears:

Note: In Windows NT you can create both local and domain 
usernames in User Manager.
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d. Enter OSAUTH_PREFIX_DOMAIN in the Value Name field.

e. Choose REG_EXPAND_SZ from the Data Type list.

f. Click OK.

The String Editor dialog appears:

5. Enter true in the String field to enable authentication at the domain level.

There may be multiple frank usernames on your network, including local user 
frank, domain user frank on sales, and possibly several domain users 
frank on other domains. Entering true enables the server to differentiate 
among them. Entering false causes the domain to be ignored and local user 
frank to become the default value of the operating system user returned to the 
server.

6. Click OK.

Registry Editor adds the parameter. 

7. Choose Exit from the Registry menu.

Registry Editor exits.
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8. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

9. Start SQL*Plus:

C:\> sqlplus /NOLOG

10. Connect to the database with the SYSTEM database administrator (DBA) name:

SQL> CONNECT 
Enter user-name: SYSTEM/password

Unless you have changed it, the SYSTEM password is MANAGER by default.

11. Create a local external user by entering:

SQL> CREATE USER xyzfrank IDENTIFIED EXTERNALLY;

where xyz is the value you chose for initialization parameter OS_AUTHENT_
PREFIX, and frank is the Windows local username.

12. Grant a local external user database roles by entering:

SQL> GRANT RESOURCE TO xyzfrank;
SQL> GRANT CONNECT TO xyzfrank;

13. Create a domain external user by entering:

SQL> CREATE USER "XYZSALES\FRANK" IDENTIFIED EXTERNALLY;

where XYZ is the value you chose for initialization parameter OS_AUTHENT_
PREFIX, and SALES\FRANK is the domain name and Windows domain 
username. Double quotes are required and the entire syntax must be in 
uppercase.

14. Grant a domain external user database roles by entering:

SQL> GRANT RESOURCE TO "XYZSALES\FRANK";
SQL> GRANT CONNECT TO "XYZSALES\FRANK";

Double quotes are required and the entire syntax must be in uppercase.

15. Connect to the database with the SYSDBA name:

SQL> CONNECT / AS SYSDBA

16. Shut down the database:

SQL> SHUTDOWN
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17. Restart the database:

SQL> STARTUP

This causes the change to parameter OS_AUTHENT_PREFIX to take effect.

External User Authentication Tasks on the Client Computer
1. Create Windows local or domain username frank with the same username and 

password that exist on the Windows server (if the appropriate name does not 
currently exist).

2. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

3. Use Oracle Net Configuration Assistant to configure a network connection from 
your client computer to the Windows server on which Oracle Database is 
installed. See Oracle Net Services Administrator's Guide for instructions.

4. Start SQL*Plus:

C:\> sqlplus /NOLOG

5. Connect to your Windows server:

SQL> CONNECT /@connect_identifier

where connect_identifier is the net service name for Oracle Database.

Oracle Database searches the data dictionary for an automatic login username 
corresponding to the Windows local or domain username, verifies it, and 
enables connection as xyzfrank or xyzsales\frank.

6. Verify that you have connected to Oracle Database as local or domain user 
frank by viewing the roles assigned in steps 12 or 14 of "External User 
Authentication Tasks on the Oracle Database Server".

SQL> SELECT * FROM USER_ROLE_PRIVS;

which outputs for local user frank:

USERNAME                       GRANTED_ROLE                   ADM DEF OS_
------------------------------ ------------------------------ --- --- ---
XYZFRANK                       CONNECT                        NO  YES NO 
XYZFRANK                       RESOURCE                       NO  YES NO 
2 rows selected.
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or, for domain user frank:

USERNAME                       GRANTED_ROLE                   ADM DEF OS_
------------------------------ ------------------------------ --- --- ---
XYZSALES\FRANK                 CONNECT                        NO  YES NO 
XYZSALES\FRANK                 RESOURCE                       NO  YES NO 
2 rows selected.

Because the Oracle Database username is the whole name xyzfrank or 
xyzsales\frank, each object created by xyzfrank or xyzsales\frank 
(that is, table, view, index, and so on) is prefixed by this name. For another user 
to reference the table shark owned by xyzfrank, for example, the user must 
enter:

SQL> SELECT * FROM xyzfrank.shark 

Manually Granting Administrator and Operator Privileges for Databases
This section describes how to enable Windows to grant the database administrator 
(SYSDBA) and database operator (SYSOPER) privileges to database administrators. 
With this privilege, database administrators can issue the following commands 
from a client computer and connect to Oracle Database without entering a 
password:

CONNECT / AS SYSOPER
CONNECT / AS SYSDBA

To enable this feature, the Windows local or domain username of the database 
administrator must belong to one of the Windows local groups listed in Table 10–1.

Note: Automatic authorization is supported for all Oracle Net 
protocols.

Table 10–1 Windows Local Groups with SYSDBA and SYSOPER Privileges

Local Group Privileges

ORA_OPER SYSOPER privileges for all databases on a computer

ORA_DBA1 SYSDBA privileges for all databases on a computer

ORA_SID_OPER SYSOPER privileges for a single database (identified by SID)

ORA_SID_DBA SYSDBA privileges for a single database (identified by SID)
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The manual procedure for enabling database administrators to connect as SYSOPER 
or SYSDBA without a password is divided into two sets of tasks performed on 
different computers:

■ SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server

■ SYSDBA/SYSOPER Authentication Tasks on the Client Computer

SYSDBA/SYSOPER Authentication Tasks on the Oracle Database Server
1. Create a Windows local group corresponding to the privileges you want 

Windows to grant (see Table 10–1).

2. Add your database administrator usernames to this group.

3. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

4. Start Registry Editor from the command prompt:

C:\>regedt32

5. Go to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

where ID is the Oracle home that you want to edit.

6. Set parameter OSAUTH_PREFIX_DOMAIN to true.

SYSDBA/SYSOPER Authentication Tasks on the Client Computer
1. Create a Windows local or domain username with the same username and 

password that exist on the Windows server (if the appropriate username does 
not currently exist).

2. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

3. Use Oracle Net Configuration Assistant to configure a network connection from 
your client computer to the Windows server on which Oracle Database is 
installed. See Oracle Net Services Administrator's Guide for instructions.

1 ORA_DBA is automatically created during installation. See section "Operating System Authentication 
Enabled at Installation" on page 9-5 for information.

See Also: Your Windows documentation for instructions on 
managing users and groups
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4. Start SQL*Plus:

C:\> sqlplus /NOLOG

5. Connect to Oracle Database:

SQL> SET INSTANCE net_service_name

where net_service_name is the Oracle Net net service name for Oracle 
Database.

6. If you specified ORA_DBA or ORA_SID_DBA in step 1 of "SYSDBA/SYSOPER 
Authentication Tasks on the Oracle Database Server", then enter either of the 
following:

SQL> CONNECT / AS SYSOPER
SQL> CONNECT / AS SYSDBA

If you specified ORA_OPER or ORA_SID_OPER in step 1, then enter:

SQL> CONNECT / AS SYSOPER

You are now connected to the Windows server. If you connect with SYSDBA, 
you are given DBA privileges.

Manually Creating an External Role
This section describes how to grant Oracle Database roles to users directly through 
Windows (known as external roles). When you use Windows to authenticate users, 
Windows local groups can grant these users external roles. 

All privileges for these roles are active when the user connects. When using external 
roles, all roles are granted and managed through the operating system. You cannot 
use both external roles and Oracle Database roles at the same time. 

Consider the following example. With external roles enabled, you log on to a 
Windows domain with domain username sales\frank (sales is the domain 
name and frank is the domain username). You then connect to Oracle Database as 
Oracle Database user scott. In this case, you receive the roles granted to 
sales\frank but not the roles granted to scott.

The procedure for manually creating an external role is divided into two sets of 
authorization tasks performed on different computers:

■ External Role Authorization Tasks on the Oracle Database Server

■ External Role Authorization Tasks on the Client Computer
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External Role Authorization Tasks on the Oracle Database Server
1. Add initialization parameter OS_ROLES to the init.ora file. 

2. Set OS_ROLES to true. 

The default setting for this parameter is false. 

3. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

4. Start SQL*Plus:

C:\> sqlplus /NOLOG

5. Connect to your Windows server:

SQL> CONNECT / AS SYSDBA

6. Create a new database role. You can give this new role whatever name you 
want. In this example the role is named DBSALES3:

SQL> CREATE ROLE DBSALES3 IDENTIFIED EXTERNALLY;

7. Grant to DBSALES3 whatever Oracle Database roles are appropriate to your 
database environment:

SQL> GRANT DBA TO DBSALES3 WITH ADMIN OPTION;
SQL> GRANT RESOURCE TO DBSALES3 WITH ADMIN OPTION;
SQL> GRANT CONNECT TO DBSALES3 WITH ADMIN OPTION;

8. Connect to the database as SYSDBA:

SQL> CONNECT / AS SYSDBA

9. Shut down the database:

SQL> SHUTDOWN

10. Restart the database:

SQL> STARTUP

11. Create a Windows local group with the following syntax:

ORA_sid_rolename[_D][_A] 

where

■ sid identifies the database instance
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■ rolename identifies the database role granted

■ D indicates that this database role is to be a default role of the database user

■ A indicates that this database role includes ADMIN OPTION 

Characters D and A are optional. If specified, they must be preceded by an 
underscore.

For this example, ORA_orcl_dbsales3_D is created.

12. Add one or more Windows local or domain usernames to this group.

You can create multiple database roles and grant them to several possible 
Windows groups with differing options, as shown in the following table. Users 
connecting to the ORCL instance and authenticated by Windows as members of 
all four of these Windows local groups will have the privileges associated with 
dbsales3 and dbsales4 by default (because of option _D). If these users first 
connect as members of dbsales3 or dbsales4 and use the SET ROLE 
command, then they can also gain access to database roles dbsales1 and 
dbsales2. But if these users try to connect with dbsales1 or dbsales2 
without first connecting with a default role, they are unable to connect. Finally, 
these users can grant dbsales2 and dbsales4 to other roles (because of 
option _A). 

See Also: Your Windows documentation for instructions on 
managing users and groups

Database Roles Windows Groups

dbsales1 ORA_ORCL_dbsales1 

dbsales2 ORA_ORCL_dbsales2_a 

dbsales3 ORA_ORCL_dbsales3_d 

dbsales4 ORA_ORCL_dbsales4_da 

Note: When Oracle Database converts the group name to a role 
name, it changes the name to uppercase.
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External Role Authorization Tasks on the Client Computer
1. Create a Windows local or domain username with the same username and 

password that exist on the Windows server (if the appropriate username does 
not currently exist).

2. Ensure that parameter SQLNET.AUTHENTICATION_SERVICES in file 
sqlnet.ora contains nts.

3. Use Oracle Net Configuration Assistant to configure a network connection from 
your client computer to Oracle Database. See Oracle Net Services Administrator's 
Guide for instructions.

4. Start SQL*Plus:

C:\> sqlplus /NOLOG

5. Connect to the correct instance:

SQL> SET INSTANCE connect_identifier

where connect_identifier is the net service name for the Oracle Database 
connection that you created in Step 3.

6. Connect to Oracle Database:

SQL> CONNECT scott/tiger AS SYSDBA

You are connected to the Windows server over net service with Oracle Database 
username scott/tiger. Roles applied to Oracle Database username scott 
consist of all roles defined for the Windows username that were previously 
mapped to the database roles (in this case, ORA_DBSALES3_D). All roles 
available under an authenticated connection are determined by the Windows 
username and the Oracle-specific Windows local groups to which the user 
belongs (for example, ORA_SID_DBSALES1 or ORA_SID_DBSALES4_DA).

Note: OSDBA and OSOPER are generic names for two special 
operating system groups that control database administrator logins 
when using operating system authentication. Windows-specific 
names for OSDBA and OSOPER are described in "Manually 
Granting Administrator and Operator Privileges for Databases" on 
page 10-44. See Oracle Database Administrator's Guide for more 
information on OSDBA and OSOPER.
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Manually Migrating Users
You can migrate local or external users to enterprise users with User Migration 
Utility. Migrating from a database user model to an enterprise user model provides 
solutions to administrative, security, and usability challenges in an enterprise 
environment. In an enterprise user model, all user information is moved to an 
LDAP directory service, which provides the following benefits:

■ Centralized storage and management of user information

■ Centralized user authentication

■ Enhanced security

User Migration Utility is a command-line tool. Its syntax is of the form:

C:\ umu parameters

To get a list of User Migration Utility parameters, enter:

C:\ umu help=yes

See Also: "Using the User Migration Utility" in Oracle Advanced 
Security Administrator's Guide 
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11
Storing Oracle Wallets in the Windows

Registry

This chapter describes storing and retrieving of Oracle Wallets in the Windows 
registry.

This chapter contains these topics:

■ Storing Private Keys and Trust Points

■ Storing User's Profile

■ Registry Parameters for Wallet Storage
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Storing Private Keys and Trust Points
Oracle Wallets store private keys, trust points, and digital certificates used in 
public key applications for authentication and encryption. Oracle Wallet Manager 
creates and manages Oracle Wallets. Oracle public key applications use obfuscated 
Oracle Wallets for authentication and encryption. 

Storing User's Profile
In a Windows 2000 or Windows NT 4.0 domain, a user's profile is stored on the local 
computer. When a local user logs on to that computer, that user's profile on the local 
computer is uploaded into the user profile in that computer's registry. When a user 
logs out, that user's profile stored on the local file system is updated, ensuring that 
the domain user or local user always has the most recent user profile version.

Registry Parameters for Wallet Storage
Parameter WALLET_LOCATION in file sqlnet.ora specifies the location of the 
obfuscated Oracle Wallet for use by Oracle PKI applications. For example, the 
WALLET_LOCATION parameter for storing an Oracle Wallet in the registry in:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP

would be:

WALLET_LOCATION =  (SOURCE= (METHOD=REG) (METHOD_DATA= (KEY=SALESAPP)))

Continuing the example, the encrypted Oracle Wallet would be stored in the 
registry in:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP\EWALLET.P12 

and the obfuscated Oracle Wallet would be stored in:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\SALESAPP\CWALLET.SSO

Note: Oracle Wallet Manager is a feature of Oracle Advanced 
Security, a separately licensable option to Oracle Database.
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On Windows operating systems, if there is no value specified for parameter 
WALLET_LOCATION, then Oracle PKI applications first look for the obfuscated 
wallet in registry key:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\DEFAULT

If no obfuscated wallet is found there, Oracle PKI applications look for it in the file 
system of the local computer at location:

%USERPROFILE%\ORACLE\WALLETS

Regardless of location, wallets are always stored in the same format. All 
functionality is the same except for the location of the wallets.

Oracle Wallet Manager
Oracle Wallet Manager creates and manages Oracle Wallets. If you want to use the 
Windows registry for Oracle Wallets, then you must select the Use Windows System 
Registry check box. If Windows System Registry is selected, the tool shows a list of 
existing keys when it opens a wallet or saves a new wallet. The list appears in: 

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS

You can select one of the existing locations or enter the name for a new location 
(registry key). If you enter a new key called key1, for example, then the tool creates 
the following registry key:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1

The encrypted wallet will be stored in:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1\EWALLET.P12

The obfuscated wallet will be stored in:

\\HKEY_CURRENT_USER\SOFTWARE\ORACLE\WALLETS\KEY1\CWALLET.SSO

If you do not select the Use Windows System Registry check box, then the tool 
displays all the available drives and directories on the local computer. You can 
select one of the existing directories or enter a new directory. The tool stores the 
encrypted or obfuscated wallet in the selected directory or creates the directory if it 
does not exist.
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12
Oracle PKI Integration with Windows

This chapter describes integration of Oracle public key infrastructure (PKI) with 
Windows 2000 public key infrastructure (Windows PKI) on Windows operating 
systems. 

This chapter contains these topics:

■ Oracle Public Key Infrastructure

■ Windows Public Key Infrastructure
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Oracle Public Key Infrastructure
Oracle public key infrastructure (PKI) is used by Oracle Enterprise Security 
Manager, LDAP-enabled Oracle Enterprise Manager, Oracle's Secure Socket Layer 
(SSL) authentication, Oracle Database, and Oracle Application Server. 

Oracle PKI includes the following components:

■ Oracle Wallets

■ Oracle Wallet Manager (OWM)

Oracle Wallets store digital certificates, trust points, and private keys used in 
public key applications for encryption, decryption, digital signature, and 
verification. 

Windows Public Key Infrastructure
This section describes Windows public key infrastructure.

This section contains these topics:

■ Microsoft Certificate Stores

■ Microsoft Certificate Services

■ Using Microsoft Certificate Stores with Oracle PKI Applications

Microsoft Certificate Stores
Microsoft Certificate Stores are repositories for storing digital certificates and their 
associated properties. Windows 2000 stores digital certificates and certificate 
revocation lists in logical and physical stores. Logical stores contain pointers to 
public key objects in physical stores. Logical stores enable public key objects to be 
shared between users, computers, and services without requiring storage of 
duplicates of objects for each user, computer, or services. Public key objects are 

Note: Microsoft Certificate Store integration works only with 
digital certificates that use Microsoft Enhanced Cryptographic 
Provider. To create these certificates, you need to install Windows 
High Encryption Pack and select Microsoft Enhanced 
Cryptographic Provider. Also, when there are more than one of 
these certificates available for the same key usage (signature/key 
exchange), the first certificate retrieved will be used for Oracle SSL. 
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physically stored in the registry of the local computer or, for some user certificates, 
in Active Directory. Standard system certificate stores defined by Microsoft include:

■ MY or Personal

■ CA

■ ROOT

MY or Personal holds a user's certificates for which the associated private key is 
available. The MY certificate store maintains certificate properties that indicate the 
Cryptographic Service Provider (CSP) associated with the private key. An 
application uses this information to obtain the private key from the CSP for the 
associated certificate. CA holds issuing or intermediate certificate authority (CA) 
certificates. ROOT holds only self-signed CA certificates for trusted root CAs.

Microsoft Certificate Services
Microsoft Certificate Services (MCS) consists of the following modules: 

■ Server Engine

■ Intermediary

■ Policy

Server Engine handles all certificate requests. It interacts with other modules at each 
processing stage to ensure that the proper action is taken based on the state of the 
request. The Intermediary module receives requests for new certificate from clients 
and then submits them to Server Engine. The Policy module contains the set of rules 
controlling the issuance of certificates. This module may be upgraded or 
customized as needed. 

Using Microsoft Certificate Stores with Oracle PKI Applications
Wallet Resource Locator (WRL) specifies that parameter WALLET_LOCATION in file 
sqlnet.ora identifies a particular PKI. You can choose between using Oracle 
Wallet or Microsoft Certificate Stores by setting parameter WALLET_LOCATION in 
sqlnet.ora. To use credentials from Microsoft Certificate Stores, set parameter 
WALLET_LOCATION in sqlnet.ora to: 

WALLET_LOCATION = (SOURCE = (METHOD=MCS))

The Oracle application uses Oracle's TCP/IP with SSL protocol (TCPS) to connect to 
Oracle Server. The SSL protocol uses X.509 certificates and trust points from the 
user's Microsoft Certificate Store for SSL authentication.
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13
Oracle Database Specifications for

Windows

Oracle Database for Windows uses initialization parameters to enable various 
features of the database every time an instance is started.

This chapter contains these topics:

■ Initialization Parameter File Overview

■ Sample File

■ SGA_MAX_SIZE Parameter

■ Initialization Parameters Without Windows-Specific Values

■ Displaying Initialization Parameter Values

■ Uneditable Database Initialization Parameters

■ Calculating Database Limits
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Initialization Parameter File Overview
An initialization parameter file is an ASCII text file containing parameters. By 
changing parameters and values in an initialization parameter file, you can specify, 
for example:

■ Amount of memory Oracle Database uses

■ Whether to archive filled online redo logs

■ Which control files currently exist 

Every database instance has a corresponding initialization parameter file and an 
ORACLE_SID registry parameter that points to the system identifier for the 
instance.

The initialization parameter filename takes the form init.ora. A single instance 
might have several initialization parameter files, each having some differences that 
affect system performance. 

Location of the Initialization Parameter File
If you do not specify a different initialization file with option PFILE at database 
startup, then by default Oracle Database uses initialization parameter files located 
in 

ORACLE_HOME\admin\db_name\pfile\init.ora

Note: Your init.ora file for initialization parameters is set by 
Oracle Universal Installer during database installation. These 
parameter settings may vary depending on your hardware 
configuration. For descriptions of all initialization parameters and 
instructions for setting and displaying their values, see Oracle 
Database Reference.

Note: If you create a database manually using a SQL script, you 
are required to create an initialization parameter file or copy an 
existing initialization parameter file and modify the contents. If you 
use Database Configuration Assistant to create a database, the 
initialization parameter file is automatically created for you.
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Editing The Initialization Parameter File
To customize Oracle Database functions, you may be required to edit the 
initialization parameter file. Use only an ASCII text editor to modify the file. 

Database Configuration Assistant Renames init.ora
When you create a database using Database Configuration Assistant, a server 
parameter file (SPFILE) is created from the initialization parameter file, and the 
initialization parameter file is renamed. Oracle does not recognize the renamed file 
as an initialization parameter file, and it is not used after the instance is started.

If you want to modify an instance created with Database Configuration Assistant 
after it starts up, you must use ALTER SYSTEM statements. You cannot change the 
SPFILE itself, because it is a binary file that cannot be browsed or edited using a text 
editor. The location of the newly-created SPFILE is ORACLE_BASE\ORACLE_
HOME\database. The SPFILE filename is spfileSID.ora. 

Sample File
Oracle Database provides an annotated sample initialization parameter file with 
alternative values for initialization parameters. These values and annotations are 
preceded by comment signs (#), which prevent them from being processed. To 
activate a particular parameter, remove the preceding # sign. To de-activate a 
particular parameter, edit the initialization parameter file to add a comment sign. 
The sample file is called initsmpl.ora. and is located in

ORACLE_BASE\ORACLE_HOME\admin\sample\pfile. 

If you installed a starter database, the initialization parameter file used by the 
starter database is located in the same directory. You can use either initsmpl.ora 
or the starter database init.ora as a basis for creating a new Oracle Database 
initialization parameter file.

To use sample file initsmpl.ora as part of database creation:

1. Rename the sample file init.ora.

2. Edit this file to reflect the correct location of your database control files and the 
name of your database, as a minimum.

See Also: "Managing Initialization Parameters Using a Server 
Parameter File" in Oracle Database Administrator's Guide
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Here are two examples of activation and de-activation of alternative parameters. 
Several initialization parameters are specified with three different values to create a 
small, medium, or large System Global Area, respectively. The parameter that 
creates a small SGA is active in this first example:

  db_block_buffers = 200  # SMALL 
# db_block_buffers = 550  # MEDIUM 
# db_block_buffers = 3200 # LARGE 

To create a medium-sized SGA, comment out the small parameter definition and 
activate the medium parameter definition. Edit the initialization parameter file as in 
this second example:

# db_block_buffers = 200  # SMALL 
  db_block_buffers = 550  # MEDIUM 
# db_block_buffers = 3200 # LARGE 

SGA_MAX_SIZE Parameter
Parameter SGA_MAX_SIZE holds the maximum size that System Global Area (SGA) 
can reach for a particular instance. Beginning with Oracle9i release 1 (9.0.1), Oracle 
Database can change its SGA configuration while the instance is running. This 
allows sizes of buffer cache, shared pool, and large pool to be changed without 
instance shutdown. 

Oracle Database can start instances underconfigured and allow the instance to use 
more memory by growing SGA up to a maximum of SGA_MAX_SIZE. If no SGA_
MAX_SIZE value is specified, then Oracle Database selects a default value that is the 
sum of all components specified or defaulted at initialization time. If SGA_MAX_
SIZE specified in the initialization parameter file is less than the sum of all 
components specified or defaulted to at initialization time, then the setting of SGA_
MAX_SIZE in the initialization parameter file is ignored. 

See Also:

■ Oracle Database Performance Tuning Guide for more information 
about SGA initialization parameters. 

■ Oracle Database Concepts for more information about SGA and 
its components
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Memory allocated for the SGA of an instance is displayed on instance startup when 
using Oracle Enterprise Manager (or SQL*Plus). You can also display the SGA size 
of the current instance by using the SQL*Plus SHOW statement with the SGA 
clause. 

Initialization Parameters Without Windows-Specific Values
Oracle Database Reference describes default values for many initialization parameters 
as being operating system-specific. However, not all parameters that it describes as 
having operating system-specific values affect Windows. In these cases, Windows 
uses either the default value set in the Oracle Database kernel or does not use the 
parameter. Table 13–1 describes these initialization parameters:

Table 13–1 Initialization Parameters Without Windows-Specific Values

Parameter Description

AUDIT_FILE_DEST Not supported on Windows and should not be added to the 
initialization parameter file

DB_WRITER_PROCESSES Supported, but typically unnecessary due to Windows asynchronous 
I/O capabilities

COMPATIBLE_NO_RECOVERY Uses default value set in Oracle Database kernel (no Windows-specific 
value)

BACKGROUND_CORE_DUMP Specifies whether Oracle Database includes SGA in core file for Oracle 
Database background processes

SHADOW_CORE_DUMP Specifies whether Oracle Database includes SGA in core file for 
foreground (client) processes

CORE_DUMP_DEST Specifies directory where Oracle Database dumps core files

CPU_COUNT Oracle Database automatically sets value to number of processors 
available for your Oracle Database instance

HI_SHARED_MEMORY_ADDRESS Not applicable to Windows

SHARED_MEMORY_ADDRESS Not applicable to Windows

LARGE_POOL_SIZE Uses maximum value limited by available memory

LOG_BUFFER Starter database uses value set in Oracle Database kernel (no 
Windows-specific value). The Custom database creation option of 
Database Configuration Assistant enables you to customize the value 
for this parameter.

SPIN_COUNT Uses default value set in Oracle Database kernel (no Windows-specific 
value)
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Displaying Initialization Parameter Values
Windows-specific parameter values can be viewed by using an ASCII editor to open 
the initialization parameter file: 

ORACLE_BASE\ORACLE_HOME\admin\db_name\pfile\init.ora

To display any parameter value (whether set in the initialization parameter file or 
the Oracle Database kernel), enter the following command at the SQL*Plus 
command prompt:

SQL> SHOW PARAMETER parameter_name

where parameter_name is the name of a specific initialization parameter.

Uneditable Database Initialization Parameters
Check the initialization parameters in Table 13–2 when creating a new database. 
They cannot be modified after you have created the database. See Chapter 4, 
"Postinstallation Database Creation on Windows" for details on creating a new 
database, including the part of the procedure where you modify these parameters. 

Table 13–2 Uneditable Database Initialization Parameters

Parameter Description

CHARACTER SET1 

1 Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See Chapter 4, 
"Postinstallation Database Creation on Windows" for an example of using this clause.

Specifies database Globalization Support character set to use. 
This parameter can be set only when you create the database.

DB_BLOCK_SIZE Specifies size in bytes of standard Oracle Database blocks.

DB_NAME Specifies name of the database to be created. Database name is 
a string of eight characters or less. You cannot change the name 
of a database.
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Calculating Database Limits
Use size guidelines in this section to calculate Oracle Database limits.

Table 13–3 Block Size Guidelines

Type Size

Maximum block size 16,384 bytes or 16 kilobytes (KB)

Minimum block size 2 kilobytes (KB)

Maximum blocks for each file 4,194,304 blocks

Maximum possible file size with 16 K 
sized blocks

64 Gigabytes (GB)
(4,194,304 * 16,384) = 64 gigabytes (GB)

Table 13–4 Maximum Number of Files for Each Database

Block Size Number of Files

2 KB 20,000

4 KB 40,000

8 KB 65,536

16 KB 65,536

Table 13–5 Maximum File Sizes

Type Size

Maximum file size for a FAT file 4 GB

Maximum file size in NTFS 16 Exabytes (EB)

Maximum database size 65,536 * 64 GB equals approximately 4 Petabytes (PB)

Maximum control file size 20,000 blocks

Table 13–6 Shadow Process Memory

Release Number Memory

Oracle9i release 2 (9.2) 444 KB

Oracle9i release 1 (9.0.1) 444 KB

Oracle8i release 8.1.7 335 KB
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Oracle8i release 8.1.6 335 KB

Oracle8 release 8.1.3 265 KB

Oracle8 release 8.0.5 254 KB

Oracle8 release 8.0.4 254 KB

Table 13–6 (Cont.) Shadow Process Memory

Release Number Memory
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14
Configuration Parameters and the Registry

This chapter describes use of the registry for various Oracle Database for Windows 
components. It also lists recommended values and ranges for configuration 
parameters.

This chapter contains these topics:

■ About Configuration Parameters

■ Registry Overview

■ Registry Parameters

■ Oracle Real Application Clusters Registry Parameters

■ Modifying a Registry Value with regedt32

■ Adding a Registry Parameter with regedt32

■ Adding or Modifying Registry Parameters with Oracle Administration 
Assistant for Windows

■ Modifying Oracle Counters for Windows Performance Monitor Parameters
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About Configuration Parameters
Oracle Database for Windows uses configuration parameters to locate files and 
specify runtime parameters common to all Oracle products. When an Oracle 
program or application requires a translation for a particular configuration variable, 
Oracle Database for Windows uses the associated parameter. All Oracle parameters 
are stored in the registry.

Registry Overview
Oracle Database for Windows stores its configuration information in a repository 
(the registry) that is organized in a tree format. The tree format consists of keys in 
the registry and parameter values for the keys. Keys and parameter values can be 
viewed and modified in Registry Editor.

Keys are folders that appear in the left pane of a Registry Editor window. A key 
contains subkeys or parameters.

Parameters in Registry Editor appear as a string, consisting of three components:

■ Parameter name

■ Value class or type of entry

■ Value itself

For example, parameter ORACLE_SID can have the following entry in the registry:

ORACLE_SID:reg_sz:orcl1

Value classes for Oracle Database for Windows parameters are:

■ String value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or a 
REG_MULTI_SZ (for multiple strings) prefix to identify a parameter value entry 
as a data string

Caution: Although Registry Editor lets you view and modify 
registry keys and parameter values, you normally are not required 
to do so. In fact, you can render your system useless if you make 
incorrect changes. Therefore, only advanced users should edit the 
registry! Back up your system before making any changes in the 
registry.
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■ Binary value with a REG_DWORD prefix to identify a value entry as a dword 
(hexadecimal data) entry

Most Oracle Database for Windows parameter values are string types. Use Oracle 
Universal Installer defaults when a type is not given.

Registry Parameters
This section describes Oracle Database for Windows registry parameters for the 
following keys. Other products, such as Oracle Enterprise Manager, have additional 
keys and parameters that are not described in this chapter. 

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME

■ HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

■ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services 

To modify these registry values, see "Modifying a Registry Value with regedt32" on 
page 14-11.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME
Each time you install Oracle products into a new Oracle home on your computer, 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME is created. This 
subkey contains parameter values for most Oracle products.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME includes the following 
parameters for an Oracle home directory. Depending on products you install, 
additional parameters can also be created. See your Windows development 
manuals.

MSHELP_TOOLS
Specifies the location of Windows help files. The default value is ORACLE_
BASE\ORACLE_HOME\mshelp.

Note: See Chapter 2, "Multiple Oracle Homes and Optimal 
Flexible Architecture" for details on the PATH variable and registry 
values when you are working with multiple Oracle homes.
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NLS_LANG
Specifies supported language, territory, and character set. This parameter specifies 
the language in which messages appear, the territory and its conventions for 
calculating week and day numbers, and the character set displayed. Oracle 
Universal Installer sets this value during installation based on the language setting 
of the operating system. See Oracle Database Globalization Support Guide for a list of 
values.

ORA_CWD
Specifies current working directory. For example, if you set this parameter and then 
use ORADIM, a log file called oradim.log is created in this directory. This parameter 
must be manually set.

ORA_SID_AUTOSTART
Starts Oracle Database when OracleServiceSID service is started. The default value 
is true.

ORA_SID_PFILE
Specifies full path to initialization parameter file. The default value is ORACLE_
BASE\admin\DB_NAME\pfile\init.ora 

ORA_SID_SHUTDOWN
When set to true, the default value, this parameter shuts down the instance of 
Oracle Database identified by SID when OracleServiceSID is stopped 
manually—using either the Control Panel or Net stop command.

ORA_SID_SHUTDOWN_TIMEOUT
Sets maximum time (in seconds) to wait for shutdown to complete before the 
service for a particular SID stops. The default value is 30.

ORA_SID_SHUTDOWNTYPE
Specifies mode in which Oracle Database is shut down when you stop 
OracleServiceSID. Valid values are a (abort), i (immediate), and n (normal). The 
default value is i.
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ORA_TZFILE
Specifies location of time zone file. Each file contains:

■ Valid time zone names

■ Offset from UTC

■ Abbreviation for standard time

■ Abbreviation for daylight savings time

ORACLE_BASE\ORACLE_HOME\oracore\zoneinfo\timezone.dat is the 
default value. It contains most commonly used time zones and is smaller for better 
database performance. The optional file, timezlrg.dat, includes time zones not 
defined in the default; but its use may affect database performance. To enable use of 
the optional file, the database administrator must:

1. Shut down Oracle Database.

2. Set ORA_TZFILE to the full path name of the location of timezlrg.dat file.

3. Restart Oracle Database.

To view time zone names, use SQL*Plus to make the following query:

SELECT * from v$timezone_names 

Once the larger file is used, it must stay in use unless the user is sure that no data 
uses one of the added time zones. Also, all databases that share information must 
use the same time zone file. 

ORACLE_AFFINITY
Specifies Windows processor affinity of each thread within the Oracle Database 
process. This parameter must be manually added. Oracle recommends consulting 
Oracle Support Services before changing this parameter. The format is:

name1:cpumask1;name2:cpumask2

Each name setting must be the name of a background thread, user for 
non-background (shadow) threads, or def for any thread type not handled 
specifically.

The name mask sets the affinity mask of the Oracle Database process. Valid 
background thread names include DBW0, LGWR, PMON, SMON, ARCH, RECO, CKPT, 
TRWR, SNP0 through SNP9, P000 through P481, and any other name found in the 
NAME column of the v$bgprocess data dictionary view.
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Each affinity setting must be a valid affinity mask (or its numeric equivalent) for the 
corresponding name. Process affinity masks are used only when Oracle services are 
first started. Each thread's affinity is set only when the individual thread is started 
(for example, at database startup time for the background threads).

ORACLE_BASE
Specifies the top-level Oracle directory (for example, C:\oracle) that contains 
ORACLE_HOME, \admin, and \oradata. The default is ORACLE_BASE.

ORACLE_GROUP_NAME
Specifies the name of the group containing icons of the Oracle products installed. 
The parameter is added to your registry when you first install Oracle products, 
even if Oracle Universal Installer does not create a program group for Oracle 
products you have installed (for example, if you have installed only Oracle Net 
software). The default value is Oracle - HOME_NAME.

ORACLE_HOME
Specifies Oracle home directory in which Oracle products are installed. This 
directory is immediately beneath the Oracle base directory in the Oracle directory 
hierarchy. The default value is the drive letter and name that you specify during 
installation.

ORACLE_HOME_KEY
The HKEY_LOCAL_MACHINE location of Oracle parameters. The default value is 
software\oracle\HOMEID.

ORACLE_HOME_NAME
Specifies home name of Oracle home directory in which Oracle products are 
installed. The default value is the name that you specify during installation.

ORACLE_PRIORITY 
Determines Windows scheduling priorities of threads within the Oracle Database 
management system process. The format is:

name1:priority1;name2:priority2 . . .

The name class sets the priority class of the Oracle Database process. Threads can 
be assigned priority either collectively or individually. The collective name user 
designates non-background (shadow) threads; the collective name def designates 



Registry Parameters

Configuration Parameters and the Registry 14-7

any thread type not handled specifically. Valid individual background thread names 
include DBW0, LGWR, PMON, SMON, ARCH0, RECO, CKPT, TRWR, SNP0 through SNP9, 
and any other name found in the NAME column of the v$bgprocess data 
dictionary view. 

The default value is class:normal; def:normal.

ORACLE_SID
Specifies the name of the Oracle Database instance on the host computer. The value 
of this parameter is the SID for the instance. The default value is specified by the 
entry in the Database Identification window of Oracle Universal Installer.

OSAUTH_PREFIX_DOMAIN
Enables user authentication. When it is set to true, it enables the server to 
differentiate between one username and another, whether they are local users, 
domain users, or domain users on another domain in your network. When it is set 
to false, the domain is ignored, and the local user becomes the default value of the 
operating system user returned to the server. The default value is false.

OSAUTH_X509_NAME
Enables client users to access Oracle Database as X.509-compliant enterprise users. 
This parameter is required only if you want to use enterprise users and roles in an 
Oracle Database computer running in a Windows 2000 domain. The default value is 
false.

RDBMS_ARCHIVE
Specifies the location of backup database files. The default value is ORACLE_
BASE\ORACLE_HOME\database\archive.

RDBMS_CONTROL
Specifies the location of backup database control files. The default value is 
ORACLE_BASE\ORACLE_HOME\database.

Note: ORACLE_PRIORITY is not automatically created for you in 
the registry. When it is not defined in the registry, Windows default 
values are used for thread priorities.
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SQLPATH
Specifies the location of SQL scripts. The default value is ORACLE_BASE\ORACLE_
HOME\dbs.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
This subkey contains the following parameters:

INST_LOC
Specifies the location of Oracle Universal Installer files. The default value is System 
Drive:\program files\oracle\inventory.

OO4O
Specifies the location of Oracle Objects for OLE message files. The default value is 
ORACLE_BASE\ORACLE_HOME\oo4o\mesg.

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet contains four keys:

■ Control

■ Enum

■ HardwareProfiles

■ Services

The first three are used by the operating system. You can edit only the Services 
subkey, which contains:

■ Parameters for Oracle Counters for Windows Performance Monitor

■ Parameters for Oracle Database Services

Parameters for Oracle Counters for Windows Performance Monitor
Oracle Counters for Windows Performance Monitor parameters appear in:

HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\ORACLEver\PERFORMANCE

where ORACLEver refers to whatever version of Oracle Database is installed.
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For Oracle Counters for Windows Performance Monitor to display information for 
Oracle Database performance objects, it must log in to the database. Modify the 
following parameters if the default information is not applicable or if you want to 
access another database:

■ Hostname displays the SID of the database that Oracle Counters for Windows 
Performance Monitor will connect to. The default value is blank, causing Oracle 
Counters for Windows Performance Monitor to connect to the default database 
on the computer. 

If you specify a different SID, you must also add a connect descriptor for that 
SID to your tnsnames.ora file. Oracle recommends that you use Oracle Net 
Configuration Assistant, but you can also copy, paste, and modify the following 
example: 

SERVICE_NAME =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = HOST_NAME)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVER = DEDICATED)
      (SERVICE_NAME = SERVICE_NAME)
    )
  )

■ Password displays the encrypted password for the username to access the 
database. The default value is MANAGER (encrypted).

■ Username displays the username to access the database. The default value is 
SYSTEM.

Oracle Counters for Windows Performance Monitor requires the following 
parameters as entry points:

■ Close specifies the close entry point for the DLL. The default value is 
CloseOracleverPerformanceData.

■ Collect specifies the collect entry point for the DLL. The default value is 
CollectOracleverPerformanceData.

Note: Modify only the hostname, password, and username 
values to point to any database. Oracle recommends that you use 
OPERFCFGver. See "Using OPERFCFGver" on page 14-20.
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■ Library specifies the name of the Oracle Counters for Windows Performance 
Monitor DLL. The default value is ORAPERFver.dll

■ Open specifies the open entry point for the DLL. The default value is 
OpenOracleverPerformanceData.

The following parameters specify Oracle Counters for Windows Performance 
Monitor log file and object configuration files:

■ LOGFILE specifies the name of the Oracle Counters for Windows Performance 
Monitor log file. This log file reports any errors, such as Oracle Database objects 
not appearing or database access problems. The default value is ORACLE_
BASE\ORACLE_HOME\dbs\operfver.log.

■ PERF_FILE_NAME specifies the location of the PERFver.ora file, which 
contains all performance objects displayed by Oracle Counters for Windows 
Performance Monitor. The default value is ORACLE_BASE\ORACLE_
HOME\dbs\perfver.ora

Parameters for Oracle Database Services
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES subkey 
contains additional subkeys that correspond to each Oracle Database service.

Each service subkey contains the following parameters:

■ DisplayName specifies the service name of the instance whose SID is SID. The 
default value is the name of the service. For example, OracleServiceORCL1, 
where ORCL1 is the SID.

■ ImagePath specifies the fully qualified path name of the executable started by 
the service and any command-line arguments passed into the executable at 
runtime. The default value is the path to the executable file of the product.

■ ObjectName specifies the logon user account and computer to which the 
service should log on. The default value is LocalSystem.

Oracle Real Application Clusters Registry Parameters
Oracle Real Application Clusters registry values are based on the clusterware. If you 
are not using the clusterware, then some of this information may not be applicable 
to your particular cluster environment.



Modifying a Registry Value with regedt32

Configuration Parameters and the Registry 14-11

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\OCR
This subkey contains the following values:

■ OCRROOT points to the location of the Oracle Cluster Registry file 

■ LOCAL_ONLY which is set to False for a cluster installation and True for a 
single-instance database installation

Modifying a Registry Value with regedt32

To edit Oracle-related settings:

1. Start Registry Editor in one of two ways:

■ From the command prompt, enter:

C:\> regedt32

■ Choose Start > Run, enter regedt32 in the Open field, and click OK.

The Registry Editor window appears.

2. Navigate to the values you want to view or modify by double-clicking 
appropriate keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.

The String Editor dialog appears:

Note: Oracle Real Application Clusters is not supported on 
Windows XP.

Caution: Do not edit your registry unless absolutely necessary. If 
an error occurs in your registry, then Oracle Database for Windows 
can stop functioning, and the registry itself can become unusable.
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4. Make any necessary edits.

5. Click OK.

6. Choose Exit from the Registry menu.

Adding a Registry Parameter with regedt32
To add a parameter to the registry:

1. Start Registry Editor in one of two ways:

■ From the command prompt, enter:

C:\> regedt32

■ Choose Start > Run, enter regedt32 in the Open field, and click OK.

The Registry Editor window appears.

2. Navigate to the key to which you want to add the new value.

3. Choose Add Value from the Edit menu.

The Add Value dialog appears:
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4. In the Value Name field, type the name of the value that you want to add to the 
currently selected key.

5. In the Data Type list, select the data type that you want to assign to the added 
value:

■ REG_SZ, REG_EXPAND_SZ (for an expandable string), or REG_MULTI_SZ 
(for multiple strings) for a data string

■ Binary value with a REG_DWORD prefix to identify a value entry as a DWORD 
(hexadecimal data) entry

6. Click OK.

The String Editor dialog appears:

7. Type the value for the parameter.

8. Click OK.

Registry Editor adds the parameter. 

9. Choose Exit from the Registry menu.
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Adding or Modifying Registry Parameters with Oracle Administration 
Assistant for Windows

Instead of using regedt32 to add, edit, and delete parameters for an Oracle home, 
you can use the Oracle Home Configuration snap-in, one of several snap-ins 
included as part of Oracle Administration Assistant for Windows. You must have 
Microsoft Management Console on your computer to use this product. 

See "HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME" on 
page 14-3 for more information about Oracle home parameters.

Starting Oracle Administration Assistant for Windows
To start Oracle Administration Assistant for Windows:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Oracle Administration Assistant for Windows starts.

2. Expand Oracle Homes.

3. Right-click the Oracle home that you want to modify.

4. Click Properties. The Properties dialog appears.
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Adding Oracle Home Parameters
To add an Oracle home parameter:

1. Click Add in the Properties dialog.

The Add Value dialog appears.
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2. Enter the name in the Parameter Name field.

3. Enter the value in the Parameter Value field.

4. Click OK.

5. Click Apply.

Editing Oracle Home Parameters
To change the default SID, select the SID from the Default SID list in the Properties 
dialog. To edit one of the other parameters:

1. Select the parameter in the Other Settings list in the Properties dialog.

2. Click Edit.

Note: With Oracle Administration Assistant for Windows, you 
can add parameters only with a datatype of REG_SZ. Use 
regedt32 to add parameters with a datatype of REG_EXPAND_
SZ, REG_MULTI_SZ, or REG_DWORD.
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The Edit Value dialog appears.

3. Modify the value.
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4. Click OK.

5. Click Apply.

Deleting Oracle Home Parameters
To delete an Oracle home parameter:

1. Select the parameter in the Other Settings list in the Properties dialog.

2. Click Delete.

Modifying Oracle Counters for Windows Performance Monitor 
Parameters

Instead of using regedt32 to modify Oracle Counters for Windows Performance 
Monitor's Hostname, Password, and Username parameters, you can use 
OPERFCFGver or Oracle Administration Assistant for Windows.

Using OPERFCFGver 
OPERFCFGver is an Oracle Database tool that you run from the command prompt. 
Use this syntax:

OPERFCFGver [-U username] [-P password] [-D TNS_Alias_for_database]

where:

■ username is the username registry parameter value that Oracle Counters for 
Windows Performance Monitor uses to log in to the database. You must have a 
DBA privilege on this database.

■ password is the password registry parameter value for username.

■ TNS_Alias_for_database is the net service name that Oracle Counters for 
Windows Performance Monitor uses to connect to the database. It affects the 
Hostname registry parameter. The net service name corresponds to the SID of 
the database that you want to monitor. The -D command can be specified 
without providing a database name value.

The -U, -P, and -D commands are all optional.

See Also:  "Parameters for Oracle Counters for Windows 
Performance Monitor" on page 14-8 for more information about 
Hostname, Password, and Username parameters
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The following examples illustrate use of OPERFCFGver. First, to change username 
to dba_admin, password to frank, and leave database name at its current value, 
you would enter:

C:\> OPERFCFGver -U dba_admin -P frank

To change username to dba_admin, password to frank, and database name to 
prod, you would enter:

C:\> OPERFCFGver -U dba_admin -P frank -D prod

To change password to frank for the current username and database name, you 
would enter:

C:\> OPERFCFGver -P frank

In the final example, you change Hostname to a blank value, causing Oracle 
Counters for Windows Performance Monitor to connect to the default database on 
the computer. The current username and password must be valid user accounts on 
this database. Enter:

C:\> OPERFCFGver -D

Using Oracle Administration Assistant for Windows
Oracle Counters for Windows Performance Monitor snap-in is part of Oracle 
Administration Assistant for Windows. You must have Microsoft Management 
Console on your computer in order to use this product.

To use Oracle Counters for Windows Performance Monitor snap-in:

1. Choose Start > Programs > Oracle - HOME_NAME > Configuration and 
Migration Tools > Administration Assistant for Windows.

Oracle Administration Assistant for Windows starts.

2. Right-click Performance Monitor.

3. Click Properties.

The Performance Monitor Properties dialog appears.

4. Modify the text in the Username, Password, or Database fields.

5. Click Apply.
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15
Developing Applications for Windows

This chapter points to sources of information on developing applications for 
Windows and outlines a procedure for building and debugging external 
procedures.

This chapter contains these topics:

■ Finding Information on Application Development for Windows

■ Developing Windows Applications

■ Building External Procedures

■ Debugging External Procedures

■ Accessing Text Files with UTL_FILE

■ Accessing Web Data with Intercartridge Exchange 
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Finding Information on Application Development for Windows 
This section describes where to find information on developing applications 
specifically for Windows. These products are included on your Oracle Database 
Server CD-ROM.

Java Enhancements
Oracle Database includes an integrated Java Virtual Machine and JServer 
Accelerator. Oracle Database also provides Oracle Java Database Connectivity 
(JDBC) Drivers. For more information, see Oracle Database Java Developer's Guide.

XML Support
Oracle XML products include XML Developer's Kit (XDK) and Oracle XML SQL 
Utility. For more information:

■ Oracle XML Developer's Kit Programmer's Guide

■ Oracle XML API Reference

Support for Internet Applications
Oracle Database support for internet applications includes Oracle Portal, which 
enables you to publish your data to the Web, Oracle HTTP Server, and PL/SQL 
Embedded Gateway, which offers PL/SQL procedures stored in Oracle Database 
that can be started through browsers. For more information:

■ Oracle Portal Installation Guide and Tutorial

■ Oracle Enterprise Manager Grid Control Installation and Basic Configuration

Application Wizards
Oracle Application Wizards allow developers to create database applications easily 
and quickly. They improve ease-of-use and reduce development time by generating 
much of the code for database connectivity. For information and downloads:

■ http://otn.oracle.com/software/

Note: Oracle Portal is available on a separate CD-ROM and 
included with Oracle Database for Windows.
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Oracle COM/COM+ Integration Feature
Oracle COM/COM+ integration feature enables Java stored procedure developers 
and COM/COM+ developers to load COM+ objects from Oracle Database. For 
more information:

■ Oracle COM Automation Feature Developer's Guide

■ Oracle Objects for OLE Developer's Guide

Oracle Services For Microsoft Transaction Server
Oracle Database for Windows permits enhanced deployment of COM/COM+ 
components in Microsoft Transaction Server, using Oracle Database as the resource 
manager. For more information:

■ Oracle Services for Microsoft Transaction Server Developer's Guide

Pro*C/C++ and Pro*COBOL Applications
■ Pro*C/C++ Getting Started for Windows

■ Pro*COBOL Getting Started for Windows

■ Oracle Call Interface Programmer's Guide

OLE DB
■ Oracle Provider for OLE DB Developer's Guide

Developing Windows Applications
Oracle Database provides a comprehensive set of APIs for Windows application 
developers and is well suited for both Java and COM/COM+ development. Oracle 
Database is integrated with Microsoft's development and deployment components, 
known as Windows Distributed interNet Applications Architecture (DNA). 
Performance and data access on Windows is enhanced in the following areas:

Note: Oracle ODBC Driver is updated on a regular basis. The 
newest release available is included on your CD-ROM. To 
download the latest release, visit: http://otn.oracle.com/software/ 

Select Oracle ODBC Drivers from the Select a Utility or Driver list.
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■ Wide variety of data access methods for Windows and internet applications

■ Wizards and assistants to speed application development

■ COM/COM+/DCOM integration through two APIs: Oracle Objects for OLE or 
Oracle Provider for OLE DB

■ Microsoft Transaction Server integration: Oracle Services for Microsoft 
Transaction Server

■ Platform extensions for internet application development

Developers are able to deploy their database applications more quickly by using the 
data access method with which they are familiar, rather than having to learn a new 
one. An Oracle Database server can communicate with Windows clients in a variety 
of methods, as described in Table 15–1.

By using Oracle Database data access interfaces, developers can take advantage of 
specific Oracle Database features. These interfaces also offer flexibility and 
adherence to open standards.

Oracle COM/COM+ interfaces include the following features:

■ OO4O can be used from any programming environment that supports 
Microsoft COM/COM+ technology, such as Visual Basic, Visual C++, VBA in 
Excel, Active Server Pages, PowerBuilder, Delphi, Internet Information Server 
(IIS), and Microsoft Transaction Server. OO4O is developed specifically for use 
with Oracle Database servers.

■ Oracle Provider for OLE DB gives ActiveX Data Objects (ADO) developers high 
performance and efficient access to Oracle Database. A native OLE DB provider, 
it offers data access optimizations and access to Oracle-specific database 
features.

Table 15–1 Oracle Data Access Methods

Development 
Environment Data Access Method

Java JDBC 

SQLJ 

COM/COM+ Oracle Objects for OLE (OO4O) 

Oracle Provider for OLE DB 

COM/COM+ Automation Feature 
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■ COM/COM+ Automation Feature APIs make it easy for PL/SQL developers to 
incorporate COM/COM+ objects into their routines. An extension of this 
feature, Oracle COM/COM+ Integration, enables Java stored procedures and 
COM/COM+ developers to load COM/COM+ objects through OLE 
Automation or custom COM/COM+ interfaces in Oracle Database. 

Developing Internet Applications
Oracle Database provides Windows extensions for internet development, enabling 
access from any client, such as:

■ Any browser

■ Windows or Macintosh client

■ FTP client

■ Database client

■ COM/COM+ client

■ E-mail client

Oracle Database data access interfaces and development tools, along with Microsoft 
Transaction Server integration, can be used to build internet applications, as 
illustrated in Figure 15–1, "Microsoft Transaction Server and Oracle Database 
Integration". 
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Figure 15–1 Microsoft Transaction Server and Oracle Database Integration

Building External Procedures
This section describes how to create and use external procedures on Windows. The 
following files are located in ORACLE_BASE\ORACLE_HOME\rdbms\extproc:

■ extern.c is the code example shown in "Writing an External Procedure"

■ make.bat is the batch file that builds the dynamic link library

■ extern.sql automates the instructions described in "Registering an External 
Procedure" and "Executing an External Procedure"
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External Procedures Overview
External procedures are functions written in a third-generation language (C, for 
example) and callable from within PL/SQL or SQL as if they were a PL/SQL 
routine or function. External procedures let you take advantage of strengths and 
capabilities of a third-generation programming language in a PL/SQL environment.

The main advantages of external procedures are: 

■ Performance, because some tasks are performed more efficiently in a 
third-generation language than in PL/SQL, which is better suited for SQL 
transaction processing

■ Code re-usability, because dynamic link libraries (DLLs) can be called directly 
from PL/SQL programs on the server or in client tools such as Oracle Forms

You can use external procedures to perform specific processes:

■ Solving scientific and engineering problems

■ Analyzing data

■ Controlling real-time devices and processes

To create and use an external procedure, perform the following sequential steps:

■ Installing and Configuring

■ Writing an External Procedure

■ Building a DLL

■ Registering an External Procedure

■ Executing an External Procedure

Note: Oracle Database also provides a special purpose interface, 
the call specification, that lets you call external procedures from 
other languages, as long as they are callable by C.

Caution: Special security precautions are warranted when 
configuring a listener to handle external procedures. See 
"Modifying Configuration of External Procedures for Higher 
Security" on page C-4 and Oracle Net Services Administrator's Guide 
for more information.
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Installing and Configuring
This section describes installation and configuration of Oracle Database and Oracle 
Net.

Installing Oracle Database
Follow the steps in Oracle Database Installation Guide for Windows to install these 
products on your Windows server:

■ Oracle Database Enterprise Edition, Oracle Database Standard Edition, or 
Oracle Database Personal Edition. Each type contains PL/SQL, from which 
external procedures are called, and the PL/SQL external procedure program 
(EXTPROC), which runs external procedures.

■ Oracle Net Services

■ Oracle Protocol Support

Configuring Oracle Net Services
During database server installation, Oracle Net Configuration Assistant configures 
listener.ora and tnsnames.ora files for external procedure calls. 

When an application calls an external procedure, Oracle Net Listener starts an 
external procedure agent called EXTPROC. Using a network connection established 
by the listener, the application passes the following information to EXTPROC:

■ DLL name

■ External procedure name

■ Parameters (if necessary)

Note: You must have a C compiler and linker installed on your 
system to build DLLs.

Note: You can combine the instructions described in the fourth 
and fifth tasks into one SQL script that automates the task of 
registering and executing your external procedure. See ORACLE_
BASE\ORACLE_HOME\rdbms\extproc\extern.sql for an 
example of a SQL script that combines these steps.
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EXTPROC then loads the DLL, runs the external procedure, and passes back any 
values returned by the external procedure.

If you overwrite default listener.ora and tnsnames.ora files, then you must 
manually configure the following files for the external procedure behavior 
described previously to occur:

■ ORACLE_BASE\ORACLE_HOME\network\admin\listener.ora

■ ORACLE_BASE\ORACLE_HOME\network\admin\tnsnames.ora 

Writing an External Procedure
Using a third-generation programming language, you can write functions to be 
built into DLLs and started by EXTPROC. The following is a simple Microsoft 
Visual C++ example of an external procedure:

#include <windows.h>
#define NullValue -1
/*
  This function tests if x is at least as big as y.
*/
long __declspec(dllexport) find_max(long x, 
 short x_indicator, 
long y, 
short y_indicator, 
 short *ret_indicator)
{
   /* It can be tricky to debug DLL's that are being called by a process
      that is spawned only when needed, as in this case.  
      Therefore try using the DebugBreak(); command.  
      This will start your debugger.  Uncomment the line with DebugBreak(); 
      in it and you can step right into your code.

Caution: Additional security may be required for the listener in a 
production environment. See Oracle Net Services Administrator's 
Guide for more information.

Note: Because external procedures are built into DLLs, they must 
be explicitly exported. In this example, the DLLEXPORT storage 
class modifier exports the function FIND_MAX from a dynamic link 
library.
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   */
   /* DebugBreak();  */

   /* First check to see if you have any nulls. */
   /* Just return a null if either x or y is null. */

   if ( x_indicator==NullValue || y_indicator==NullValue) {
      *ret_indicator = NullValue;   
      return(0);
   } else { 
      *ret_indicator = 0;       /* Signify that return value is not null. */
      if (x >= y) return x;
      else return y;
   }
}

Building a DLL
After writing your external procedure(s) in a third-generation programming 
language, use the appropriate compiler and linker to build a DLL, making sure to 
export the external procedures as noted previously. See your compiler and linker 
documentation for instructions on building a DLL and exporting its functions. 

For the example in Task 2, you can build the external procedure find_max into a 
DLL called extern.dll by going to ORACLE_BASE\ORACLE_
HOME\rdbms\extproc and typing make. After building the DLL, you can move it 
to any directory on your system.

Starting with Oracle9i release 2, however, the default behavior of EXTPROC is to 
load DLLs only from ORACLE_HOME\bin or ORACLE_HOME\lib. To load DLLs 
from other directories, you must set environment variable EXTPROC_DLLS to a 
colon (:) separated list of DLL names qualified with their complete paths. The 
preferred way to set this environment variable is through the ENVS parameter in 
listener.ora.

Registering an External Procedure
Once you have built a DLL containing your external procedure(s), you must register 
your external procedure(s) with Oracle Database:

To create a PL/SQL library to map to the DLL:

See Also: Oracle Database Application Developer's Guide - 
Fundamentals for more information on EXTPROC
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1. Start SQL*Plus:

C:\> sqlplus

2. Connect to the database with appropriate username and password.

3. Create the PL/SQL library using the CREATE LIBRARY command:

SQL> CREATE LIBRARY externProcedures AS 'C:\oracle\ora92\rdbms\ 
extproc\extern.dll';

where externProcedures is an alias library (essentially a schema object in 
the database), and C:\oracle\ora92\rdbms\extproc\extern.dll is the 
path to the Windows operating system dllextern.dll. This example uses 
C:\oracle as your Oracle base and \ora92 as your Oracle home.

4. Create a PL/SQL program unit specification.

Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause 
instead of declarations and a BEGIN...END block. The EXTERNAL clause is the 
interface between PL/SQL and the external procedure. The EXTERNAL clause 
identifies the following information about the external procedure:

■ Name

■ DLL alias

■ Programming language in which it was written

■ Calling standard (defaults to C if omitted)

In the following example, externProcedures is a DLL alias. You need the 
EXECUTE privilege for this library. The external procedure to call is find_max. 
If enclosed in double quotation marks, it becomes case-sensitive. The 
LANGUAGE term specifies the language in which the external procedure was 
written.

CREATE OR REPLACE FUNCTION PLS_MAX(
  x BINARY_INTEGER,
  y BINARY_INTEGER)
RETURN BINARY_INTEGER AS
  EXTERNAL LIBRARY externProcedures

Note: The DBA must grant the EXECUTE privilege on the PL/SQL 
library to users who want to call the library's external procedure 
from PL/SQL or SQL.
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  NAME "find_max"
  LANGUAGE C
  PARAMETERS (
    x long,                  -- stores value of x
    x_INDICATOR short,       -- used to determine if x is a NULL value
    y long,                  -- stores value of y
    y_INDICATOR short        -- used to determine if y is a NULL value
  RETURN INDICATOR short );  -- need to pass pointer to return value's
                             -- indicator variable to determine if NULL
-- This means that my function will be defined as:
    -- long max(long x, short x_indicator,
    -- long y, short y_indicator, short * ret_indicator)

Executing an External Procedure
To run an external procedure, you must call the PL/SQL program unit (that is, the 
alias for the external function) that registered the external procedure. These calls can 
appear in any of the following:

■ Anonymous blocks

■ Standalone and packaged subprograms

■ Methods of an object type

■ Database triggers

■ SQL statements (calls to packaged functions only)

In "Registering an External Procedure", PL/SQL function PLS_MAX registered 
external procedure find_max. Follow these steps to run find_max:

1. Call PL/SQL function PLS_MAX from a PL/SQL routine named UseIt:

SET SERVER OUTPUT ON
CREATE OR REPLACE PROCEDURE UseIt AS
         a integer;
         b integer;
         c integer;
BEGIN
         a := 1;
         b := 2;
         c := PLS_MAX(a,b);
         dbms_output.put_line('The maximum of '||a||' and '||b||' is  '||c);
END;
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2. Run the routine:

SQL> EXECUTE UseIt;

Debugging External Procedures
Usually, when an external procedure fails, its C prototype is faulty. That is, the 
prototype does not match the one generated internally by PL/SQL. This can happen 
if you specify an incompatible C datatype. For example, to pass an OUT parameter 
of type REAL, you must specify float *. Specifying float, double *, or any other 
C datatype will result in a mismatch. 

In such cases, you might get a lost RPC connection to external procedure 
agent error, which means that agent extproc terminated abnormally because the 
external procedure caused a core dump. To avoid errors when declaring C 
prototype parameters, refer to Oracle Data Cartridge Developer's Guide.

Using Package DEBUG_EXTPROC
To help you debug external procedures, PL/SQL provides utility package DEBUG_
EXTPROC. To install the package, run script dbgextp.sql, which you can find in 
the PL/SQL demo directory. 

To use the package, follow instructions in dbgextp.sql. Your Oracle Database 
account must have EXECUTE privileges on the package and CREATE LIBRARY 
privileges.

To debug external procedures: 

1. From Windows Task Manager, in the Processes dialog, select ExtProc.exe. 

2. Right click, and select Debug. 

3. Click OK in the message window. 

If you have built your DLL in a debug fashion with Microsoft Visual C++, then 
Visual C++ is activated. 

4. In the Visual C++ window, select Edit > Breakpoints. 

Use the breakpoint identified in dbgextp.sql in the PL/SQL demo directory.
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Accessing Text Files with UTL_FILE
Package UTL_FILE allows your PL/SQL programs to read and write operating 
system text files. It provides a restricted version of standard operating system 
stream file I/O, including open, put, get, and close operations. When you want to 
read or write a text file, you call the function fopen, which returns a file handle for 
use in subsequent procedure calls. For example, the procedure put_line writes a 
text string and line terminator to an open file, and the procedure get_line reads a 
line of text from an open file into an output buffer.

FSEEK, a UTL_FILE subprogram, adjusts the file pointer forward or backward 
within the file by the number of bytes specified. In order for UTL_FILE.FSEEK to 
work correctly, the lines in the file must have platform-specific line terminator 
characters. On Windows platforms the correct line terminator characters are 
<CR><LF>.

Accessing Web Data with Intercartridge Exchange
This section discusses the following topics:

■ Configuring Intercartridge Exchange

■ Using Intercartridge Exchange

■ UTL_HTTP Exception Conditions

■ Exception Conditions and Error Messages

See Also:

■ ORACLE_BASE\ORACLE_
HOME\rdbms\extproc\readme.doc (explains how to run 
the sample and provides debugging advice)

■ PL/SQL User's Guide and Reference

■ Oracle Database Java Developer's Guide

■ "Calling External Procedures" in Oracle Database Application 
Developer's Guide - Fundamentals

■ Oracle Data Cartridge Developer's Guide

See Also: PL/SQL Packages and Types Reference for more 
information on UTL_FILE
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Configuring Intercartridge Exchange
You must add a parameter to the registry before using Intercartridge Exchange.

1. Start Registry Editor from the command prompt:

C:\> regedt32

The Registry Editor window appears.

2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that you 
are using. The location of this parameter is determined by how many Oracle 
home directories are on your computer. If you have only one home directory, 
add HTTP_PROXY to 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0. 

If you have more than one home directory, add it to 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_HOME_NAME 

3. Choose Add Value from the Edit menu.

The Add Value dialog appears.

4. Type HTTP_PROXY in the Value Name field and REG_SZ in the Data Type field.

5. Click OK.

6. Type www-proxy.your-site in the String field.

Note: For another way to configure your registry, see "Modifying 
a Registry Value with regedt32"  on page 14-11
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In this example, the Web site is marketing.com. You will enter the domain name 
of your actual Web site.

Using Intercartridge Exchange
Intercartridge Exchange enables you to use a stored package called UTL_HTTP to 
make Hypertext Transfer Protocol (HTTP) calls from PL/SQL, SQL, and SQL*Plus 
statements.

UTL_HTTP can do both of the following:

■ Access data on the Internet

■ Call Oracle Web Application Server cartridges

UTL_HTTP contains two similar entry points, known as packaged functions, that 
turn PL/SQL and SQL statements into HTTP callouts:

■ UTL_HTTP.REQUEST

■ UTL_HTTP.REQUEST_PIECES

Both packaged functions perform the following tasks:

■ Take a string universal resource locator (URL) of a site

■ Contact that site

■ Return data (typically HTML) obtained from that site

Declarations to use with both packaged functions are described in the following 
subsections.
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Packaged Function UTL_HTTP.REQUEST
UTL_HTTP.REQUEST uses a URL as its argument and returns up to the first 2000 
bytes of data retrieved from that URL. Specify UTL_HTTP.REQUEST as follows:

FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;

To use UTL_HTTP.REQUEST from SQL*Plus, enter:

SQL> SELECT UTL_HTTP.REQUEST('HTTP://WWW.ORACLE.COM/') FROM DUAL;

which returns:

UTL_HTTP.REQUEST('HTTP://WWW.ORACLE.COM/')                         
------------------------------------------------------
<html>
<head><title>Oracle Home Page</title>
<!--changed Jan. 16, 19
1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES
UTL_HTTP.REQUEST_PIECES uses a URL as its argument and returns a PL/SQL 
table of 2000 bytes of data retrieved from the given URL. The final element can be 
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a 
PL/SQL table of type UTL_HTTP.HTML_PIECES. 

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is 
specified as:

type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2,
  max_pieces natural default 32767)
return html_pieces;

A call to REQUEST_PIECES can look like this example. Note the use of PL/SQL 
table method COUNT to discover the number of pieces returned; it can be zero or 
more:

declare pieces utl_http.html_pieces;
begin 
  pieces := utl_http.request_pieces('http://www.oracle.com/'); 
   for i in 1 .. pieces.count loop
     .... -- process each piece
   end loop;
end;
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The second argument to UTL_HTTP.REQUEST_PIECES (MAX_PIECES) is optional. 
MAX_PIECES is the maximum number of pieces (each 2000 characters in length, 
except for the last, which can be shorter) that UTL_HTTP.REQUEST_PIECES 
returns. If provided, that argument is usually a positive integer. 

For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, 
except perhaps the last) from the URL. The block prints the number of pieces 
retrieved and the total length, in bytes, of the data retrieved. 

set serveroutput on

declare 
  x utl_http.html_pieces;
begin
  x := utl_http.request_pieces('http://www.oracle.com/', 100);
  dbms_output.put_line(x.count || ' pieces were retrieved.');
  dbms_output.put_line('with total length ');
  if x.count < 1 
  then dbms_output.put_line('0');
  else dbms_output.put_line
((2000 * (x.count - 1)) + length(x(x.count)));
  end if;
end;

which displays:
Statement processed.
4 pieces were retrieved.
with total length 
7687

Elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are 
successive pieces of data obtained from the HTTP request to that URL. 

UTL_HTTP Exception Conditions
This subsection describes exceptions (errors) that can be raised by packaged 
functions UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.

UTL_HTTP.REQUEST
PRAGMA RESTRICT_REFERENCES enables display of exceptions:

create or replace package utl_http is
function request (url in varchar2) return varchar2;
pragma restrict_references (request, wnds, rnds, wnps, rnps);
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UTL_HTTP.REQUEST_PIECES
PRAGMA RESTRICT_REFERENCES enables display of exceptions:

create or replace package utl_http is
type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2, 
   max_pieces natural default 32767)
return html_pieces;
pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exception Conditions and Error Messages
If initialization of the HTTP callout subsystem fails for environmental reasons (such 
as lack of available memory), then exception UTL_HTTP.INIT_FAILED is raised:

init_failed exception;

If the HTTP call fails due to failure of the HTTP daemon or because the argument to 
REQUEST or REQUEST_PIECES cannot be interpreted as a URL (because it is NULL 
or has non-HTTP syntax), then exception UTL_HTTP.REQUEST_FAILED is raised:

request_failed exception;

Unless explicitly caught by an exception handler, these first two exceptions are 
reported by a generic message that shows them as "user-defined" exceptions, even 
though they are defined in this system package:

ORA-06510: PL/SQL: unhandled user-defined exception

If any other exception is raised during processing of the HTTP request (for example, 
an out-of-memory error), then function UTL_HTTP.REQUEST or UTL_
HTTP.REQUEST_PIECES reraises that exception.

If no response is received from a request to the given URL, because the function 
made no contact with a site corresponding to that URL, then a formatted HTML 
error message may be returned:

<HTML>
<HEAD>
<TITLE>Error Message</TITLE>
</HEAD>
<BODY>
<H1>Fatal Error 500</H1>
Can't Access Document: http://home.nothing.comm.
<P>
<B>Reason:</B> Can't locate remote host:  home.nothing.comm.
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<P>
<P><HR>
<ADDRESS><A HREF="http://www.w3.org">
CERN-HTTPD3.0A</A></ADDRESS>
</BODY>
</HTML>

If UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES raises an exception or 
returns an HTML-formatted error message, yet you believe that the URL argument 
is correct, try contacting that same URL with a browser to verify network 
availability from your computer.
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A
Getting Started with Your Documentation

Your Oracle Database documentation set is provided in both HTML and PDF 
formats on a CD included in your CD Pack. Use this CD to browse the library from 
the CD or copy files directly to a local system. 

The library includes a Web-based search tool that enables you to search for 
information about a particular product, parameter, file name, procedure, error 
message, or other area of interest. The search tool also makes it possible to construct 
a "virtual book" drawn from the complete documentation library, but consisting 
only of topics and procedures relevant to your needs. The library also includes a 
comprehensive Master Index, as well as lists of SQL and PL/SQL keywords, 
initialization parameters, catalog views, and data dictionary views.

Instructions for installing the library and viewing its contents are in three README 
files at the root level of the documentation CD-ROMs:

■ README.htm

■ README.pdf

■ README.txt

The contents of the three files are identical; only the format differs.

The following guides are not included on the Oracle Database Online 
Documentation Library CD-ROM for Windows:

Note: The readme.txt file contains UNIX line breaks. If you 
simply double-click it, it will open in Notepad by default, and 
Notepad does not recognize UNIX line breaks. Use write.exe or 
edit.com instead.
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■ Oracle Database Installation Guide for Windows and Oracle Database Release Notes 
for Windows

To access these documents before installation, open start_here.htm in the 
\doc directory on the component CD-ROM. To access these documents after 
installation, choose Start > Programs > Oracle - HOME_NAME > Release 
Documentation or open start_here.htm in the ORACLE_BASE\ORACLE_
HOME\doc directory on your hard drive.

■ Oracle Migration Workbench documentation

■ Oracle Fail Safe documentation

This document is on the Oracle Fail Safe product CD-ROM.

Note: Oracle Migration Workbench is available only at OTN. See 
http://otn.oracle.com/tech/migration/content.html

Note: Oracle Fail Safe is not supported on Windows XP.
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B
Storing Tablespaces on Raw Partitions

This appendix describes how to configure your system to store datafiles for a 
tablespace on raw partitions.

This appendix contains these topics:

■ Raw Partition Overview

■ Creating a Tablespace in a Raw Partition

Note: Oracle Real Application Clusters require additional 
configuration tools. See Oracle Real Application Clusters Installation 
and Configuration Guide for information on creating logical 
partitions and assigning symbolic links. Do not use this appendix 
to create partitions for Oracle Real Application Clusters. 
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Raw Partition Overview
Datafiles for tablespaces can be stored on a file system or on raw partitions. A raw 
partition is a portion of a physical disk that is accessed at the lowest possible level. 
Input/output (I/O) to a raw partition offers approximately a 5% to 10% 
performance improvement over I/O to a partition with a file system on it.

To create a raw partition, you must first generate an extended partition and a logical 
partition. An extended partition points to raw space on the disk that can be 
assigned multiple logical partitions for database files. An extended partition also 
avoids the four-partition limit by letting you define large numbers of logical 
partitions to accommodate applications using the Oracle Database server. Logical 
partitions can then be given symbolic link names to free up drive letters.

Physical Disk
A physical disk represents the entire disk and points to the following:

\Device\Harddiskx\Partition0

Symbolic link name \\.\PhysicalDrivex is automatically defined by Windows 
for every hard disk in the computer. For example, a computer with three hard disks 
will have the following symbolic links: 

\\.\PhysicalDrive0 
\\.\PhysicalDrive1 
\\.\PhysicalDrive2 

Internally, these names expand to the following:

\\.\PhysicalDrive0 =\Device\Harddisk0\Partition0 
\\.\PhysicalDrive1 =\Device\Harddisk1\Partition0 
\\.\PhysicalDrive2 =\Device\Harddisk2\Partition0 

Partition0 is special, because it represents the entire physical disk regardless of 
any partitioning scheme on that disk. Windows writes a signature on the first block 
of all disks it recognizes. To avoid overwriting that block, Oracle Database skips the 
first block of a physical raw partition that is used for an Oracle Database datafile.

Note: Although you can use physical disks, Oracle recommends 
that you use logical partitions.
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Logical Partition
Logical partitions point to drives other than \Device\Harddiskx\Partition0. 
They are initially assigned names with drive letters (\\.\drive_letter:) and 
typically re-assigned symbolic link names (\\.\symbolic link name). For 
example, \\.\D: may be assigned a symbolic link name of \\.\ACCOUNTING_1. 
Regardless of whether a drive letter or symbolic link name is used, logical partitions 
are defined to represent a specific partition in a disk rather than the entire disk. 
Internally, these names can expand to: 

\\.\D:= \Device\Harddisk2\Partition1 
\\.\ACCOUNTING_1= \Device\Harddisk3\Partition2 

Physical Disk and Logical Partition Considerations
Consider the following when deciding which raw partition to use:

■ Physical disks are automatically defined by Windows to represent the entire 
disk, and should never be defined by the user. 

■ Logical partitions must be defined by the user to represent a specific partition in 
a disk. These partitions should be logical partitions or drives contained in an 
extended partition. They should never be defined as Partition0. 

■ Using an entire disk (Partition0) for an Oracle Database datafile and using a 
partition that occupies the entire disk for an Oracle Database datafile are not the 
same thing. Even when a partition occupies the entire disk, there is still a small 
space on the disk that is not part of the partition. 

■ If you are using an entire disk for an Oracle Database datafile (Partition0), 
then use the pre-defined physical raw names that Windows provides. 

■ If you are using a specific partition and it occupies the entire disk, then use a 
logical partition.

■ If you are using a specific partition created with Windows disk-management 
tools, then define and use a symbolic link name rather than a logical partition 
number (even if it occupies the entire disk).

Note: Oracle Database does not skip the first block of a logical 
raw partition used for an Oracle Database datafile. 
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Compatibility Issues
 You can create logical partitions, but define physical disk convention names for 
them. For example:

\\.\PhysicalDriveACCOUNTING_1 = \Device\Harddisk2\Partition1 
\\.\PhysicalDriveACCOUNTING_2 = \Device\Harddisk3\Partition1 

Oracle Database then handles datafiles using the physical disk convention even 
though it really is a logical partition. This will not cause any data corruption or loss 
as long as you continue to use physical disk naming conventions. Oracle 
recommends that you convert to the logical partition at your earliest convenience.

You can also create logical names representing Partition0, but this is definitely 
not recommended. For example:

\\.\ACCOUNTING_1 = \Device\Harddisk1\Partition0 

This poses severe problems, because Disk Management typically writes a signature 
into the first block of every disk, and consequently may overwrite a portion of the 
datafile header. It can also cause data loss. Never use Partition0 with the logical 
partition convention.

Physical and logical partition conventions are not compatible with one another 
because of the extra block that is skipped for physical raw conventions. This also 
means you cannot simply use OCOPY to copy from a physical disk to a logical 
partition, because contents of these partitions are incompatible.

To convert from a physical convention to a logical convention, you must:

1. Perform a full database export to a (local) file system. 

2. Create logical partitions and define logical names for these partitions. 

3. Recreate the database by using the new logical partitions. 

4. Perform the full database import to the newly-created database. 

If your database installation uses physical disk conventions with logical partitions, 
Oracle recommends converting to the logical partition conventions at your earliest 
convenience, using the preceding steps.

Note: For both physical and logical raw conventions, use OCOPY 
to transfer the contents of a raw partition to a standard file system 
for backup purposes.
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Creating a Tablespace in a Raw Partition
To create a tablespace using a datafile located in a raw partition:

1. Start SQL*Plus:

C:\> sqlplus

2. Connect to the Oracle Database repository database:

Enter user-name: SYSTEM/password

where password for user account SYSTEM is MANAGER by default. If you have 
changed this password, substitute the correct password for MANAGER.

3. Create the tablespace: 

SQL> CREATE TABLESPACE tablespace DATAFILE '\\.\datafile' SIZE xm;

where:

■ tablespace is the tablespace name 

■ '\\.\' is the drive letter or symbolic link name assigned to the raw 
partition

■ x is the tablespace size in megabytes (Twenty megabytes is a good starting 
place.)

For example, to create a tablespace named accounting_1 that was assigned a 
symbolic link name of accounting_1, enter the following:

SQL> CREATE TABLESPACE accounting_1 DATAFILE '\\.\accounting_1' SIZE 502M;

See Also: Your Windows documentation for information on 
creating extended and logical partitions.

Note: If you are creating a database with the SQL script, modify 
datafiles that are stored on raw partitions with a naming 
convention of \\.\drive_letter: or \\.\symbolic link 
name.
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C
Oracle Net Services Configuration on

Windows

This appendix describes Oracle Net Services configuration for Windows. For more 
generic information on Oracle Net Services configuration, see Oracle Net Services 
Administrator's Guide.

This appendix contains these topics:

■ Understanding Oracle Net Services Registry Parameters and Subkeys

■ Listener Requirements

■ Understanding Optional Configuration Parameters

■ Advanced Network Configuration
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Understanding Oracle Net Services Registry Parameters and Subkeys
The registry contains entries for Oracle Net Services parameters and subkeys. To 
successfully add or modify Oracle Net Services configuration parameters, you must 
understand where they are located and the rules that apply to them.

Oracle Net Service Subkeys
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services contains 
subkeys that correspond to services. Depending on what is installed, your Oracle 
Net Services consist of all or a subset of the following: 

■ OracleHOME_NAMEClientCache 

■ OracleHOME_NAMECMAdmin 

■ OracleHOME_NAMECMan 

■ OracleHOME_NAMETNSListener 

Each service subkey contains the parameters shown in Table C–1. 

Listener Requirements
In Oracle Database 10g, the listener is set to start automatically at system restart. If 
you intend to use only the listener for all of your databases, ensure that only the 
Windows service for the listener, as listed in the Control Panel, is set to start 
automatically. 

Oracle usually recommends that you only have a single net listener service running 
on a Windows computer at any one time. This single listener can support multiple 
databases. If you need to have two different net listener services running on a 
Windows computer at the same time, make sure that they are configured to listen 
on different TCP/IP port numbers.

Table C–1 Service Subkey Parameters

Parameter Description

DisplayName Specifies service name.

ImagePath Specifies fully qualified path name of executable invoked by service 
and any command line arguments passed to executable at runtime. 

ObjectName Specifies logon user account and computer to which service should log 
on.
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If the same IP address and port are used for different listeners, you might expect 
that the second and subsequent listeners would fail to bind. Instead, Windows 
allows them all to listen on the same IP address and port, resulting in unexpected 
behavior of the listeners. This is a suspected Windows operating system problem 
with TCP/IP and has been reported to Microsoft. 

Understanding Optional Configuration Parameters
You can use the following parameters on Windows:

■ LOCAL 

■ TNS_ADMIN 

■ USE_SHARED_SOCKET

Oracle Net Service first checks for the parameters as environment variables, and 
uses the values defined. If environment variables are not defined, it searches for 
these parameters in the registry.

LOCAL
You can use parameter LOCAL to connect to Oracle Database without specifying a 
connect identifier in the connect string. The value of parameter LOCAL is any 
connect identifier, such as a net service name. For example, if parameter LOCAL is 
specified as finance, you can connect to a database from SQL*Plus with:

SQL> CONNECT scott/tiger

rather than

SQL> CONNECT scott/tiger@finance

Oracle Net checks if LOCAL is defined as an environment variable or as a parameter 
in the registry, and uses finance as the service name. If it exists, Oracle Net 
connects.

TNS_ADMIN
You can add parameter TNS_ADMIN to change the directory path of Oracle Net 
Services configuration files from the default location of ORACLE_
HOME\network\admin. For example, if you set TNS_ADMIN to ORACLE_
BASE\ORACLE_HOME\test\admin, the configuration files are used from ORACLE_
BASE\ORACLE_HOME\test\admin.
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USE_SHARED_SOCKET
You can set parameter USE_SHARED_SOCKET to true to enable use of shared 
sockets. If this parameter is set to true, the network listener passes the socket 
descriptor for client connections to the database thread. As a result, the client does 
not need to establish a new connection to the database thread and database 
connection time improves. Also, all database connections share the port number 
used by the network listener, which can be useful if you are setting up third-party 
proxy servers.

This parameter only works in dedicated server mode in a TCP/IP environment. If 
this parameter is set, you cannot use the 9.0 listener to spawn Oracle7 release 7.x 
databases. To spawn a dedicated server for an instance of Oracle Database not 
associated with the same Oracle home as the listener and have shared socket 
enabled, you must also set parameter USE_SHARED_SOCKET for both Oracle 
homes.

Advanced Network Configuration
The following sections describe advanced configuration procedures specifically for 
Oracle Net Services on Windows operating systems.

Configuring Authentication Method
Oracle Net Services provides authentication methods for Windows operating 
systems using Windows Native Authentication.

Configuring Security for Named Pipes Protocol
The network listener service may be unable to open the Named Pipe created by 
Oracle Names unless service OracleHOME_NAMETNSListener has a valid user ID 
and password associated with it. 

Modifying Configuration of External Procedures for Higher Security
This section supplements generic information provided in Oracle Net Services 
Administrator's Guide to configure a listener on Windows operating systems to 
exclusively handle external procedures. For a higher level of security, you are 
instructed to start the listener for external procedures from a user account with 

See Also: Your Windows documentation for instructions on 
setting up network listener permissions
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lower privileges than the oracle user. For Windows operating systems, this 
requires that you change the user account from LocalSystem to a local, unprivileged 
user for the OracleHOME_NAMETNSListenerextproc_listener_name 
service.

To change the listener account:

1. Create a new user account and grant it Log on as a Service privilege.

2. Stop service OracleHOME_NAMETNSListenerextproc_listener_name. 

3. Select OracleHOME_NAMETNSListenerextproc_listener_name service 
in the Services dialog and then display the properties of the service.

Note: The following instructions assume that you have performed 
steps 1 through 5 in the section "Modifying Configuration of 
External Procedures for Higher Security" in Oracle Net Services 
Administrator's Guide.

Note: Ensure that this user account does not have general access 
to files owned by oracle. Specifically, this user should not have 
permission to read or write to database files or to the Oracle 
Database server address space. In addition, this user should have 
read access to the listener.ora file, but must not have write 
access to it.

See Also: Your Windows documentation for instructions on 
accessing the Services dialog and stopping services

Note: If the OracleHOME_NAMETNSListenerextproc_
listener_name service does not exist, issue the following 
command from the command prompt: 

lsnrctl start extproc_listener_name 

This creates the OracleHOME_NAMETNSListenerextproc_
listener_name service. When you return to the list of services, 
stop this service before proceeding to the next step of this 
procedure.
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4. Select This Account and enter the username and password.

5. Start the listener by clicking Start. You must start the listener in this way 
because you cannot use the Listener Control utility to start the listener running 
as an unprivileged local user.

Note: You can also use NET START OracleHOME_
NAMETNSListenerextproc_listener_name to start the 
listener from the command prompt. Running the listener with 
lower privileges prevents you from using Listener Control utility 
SET commands to alter the configuration of this listener in file 
listener.ora. You can perform other administrative tasks on 
this listener with the Listener Control utility, including stopping the 
listener. Oracle recommends that you complete listener.ora file 
configuration prior to running the listener. 
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D
Error Messages on Windows

This appendix lists error messages, causes, and corrective actions that are specific to 
operation of Oracle Database for Windows. This appendix also includes database 
connection issues.

This appendix contains these topics:

■ ORA-09275: CONNECT INTERNAL No Longer Supported

■ OSD-04000 to OSD-04599: Windows-Specific Oracle Database Messages

■ DIM-00000 to DIM-00039: ORADIM Command Syntax Errors

■ Database Connection Issues

Note: The ora.hlp file, which was shipped in previous releases, 
is no longer available. See this Appendix, Oracle Database Error 
Messages, and Oracle Enterprise Manager Messages Manual for 
information on error messages.
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ORA-09275: CONNECT INTERNAL No Longer Supported
ORA-09275

Connect internal is not a valid DBA connection
Cause:  CONNECT INTERNAL is no longer supported.

Action:  If NTS is enabled, you can connect to the database as CONNECT / AS 
SYSDBA. If NTS is not enabled, you can connect as CONNECT SYS/password 
AS SYSDBA. You can also connect as an existing user with the appropriate pass-
word.

OSD-04000 to OSD-04599: Windows-Specific Oracle Database 
Messages 

Error messages in this section are Oracle Database operating system-dependent 
(OSD) messages displayed in response to an error condition in Windows. Each 
message in this section triggers an Oracle Database error message.

Error messages appear first in summary tables consisting of error numbers and the 
corresponding error message. Following the tables is a more detailed discussion of 
errors, including causes and corrective actions.

■ File I/O Errors: OSD-04000 to OSD-04099

■ Memory Errors: OSD-04100 to OSD-04199

■ Process Errors: OSD-04200 to OSD-04299

■ Loader Errors: OSD-04300 to OSD-04399

■ Semaphore Errors: OSD-04400 to OSD-04499

■ Miscellaneous Errors: OSD-04500 to OSD-04599

File I/O Errors: OSD-04000 to OSD-04099

4000 Logical block size mismatch

4001 Invalid logical block size

4002 Unable to open file

4003 Unable to read file header block

4004 Invalid file header

4005 SetFilePointer() failure, unable to read from file

4006 ReadFile() failure, unable to read from file
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4007 Truncated read

4008 WriteFile() failure, unable to write to file

4009 Truncated write

4010 <create> option specified, file already exists

4011 GetFileInformationByHandle() failure, unable to obtain file info

4012 File size mismatch

4013 Unable to read line from file

4014 Unable to close file

4015 An asynchronous I/O request returned an error

4016 Error queuing an asynchronous I/O request

4017 Unable to open the specified RAW device

4018 Unable to access the specified directory or device

4019 Unable to set file pointer

4020 Unable to set eof file marker

4021 Unable to read file

4022 Unable to write file

4023 SleepEx() failure, unable to Sleep

4024 Unable to delete file

4025 Invalid question asked

4026 Invalid parameter passed

Memory Errors: OSD-04100 to OSD-04199

4100 malloc() failure, unable to allocate memory

4101 Invalid SGA: SGA not initialized

4102 Unable to open/create file for shared memory object

4103 Unable to attach to SGA: SGA does not exist

4104 Unable to map shared memory (SGA) into the address space

4105 Shared memory (SGA) mapped to wrong address

4106 Unable to allocate memory with VirtualAlloc

4107 Unable to deallocate memory with VirtualFree

4108 Unable to protect memory with VirtualProtect

File I/O Errors: OSD-04000 to OSD-04099
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Process Errors: OSD-04200 to OSD-04299

4200 Unable to begin another thread

4201 No pid structure supplied to spdcr()

4202 DosSetPriority() failure, unable to set process priority

4203 DosKillProcess() failure, unable to kill process

4204 Invalid pid

4205 CreateProcess() failure, unable to spawn process

4207 Invalid priority specified in CONFIG parameter ORACLE_PRIORITY

4208 OpenProcess() failure, unable to open process handle

4209 Incorrect or unknown background image name given to spdcr()

4210 Timeout waiting for thread semaphore

4211 Thread information not found

4212 Maximum number of ORACLE threads reached

4213 ORACLE thread unable to DuplicateHandle()

4214 ORACLE thread unable to CreateEvent()

4215 Bad function code supplied to ssthreadop

4216 Unable to find file handle for that thread

4217 Unable to retrieve system username for current user

4218 Cannot post thread

4219 Bad thread list semaphore

4221 Target thread is currently busy

4222 Unable to get the threads context

4223 Unable to set the threads context

4224 Unable to suspend the target thread

4225 Unable to resume the target thread

Loader Errors: OSD-04300 to OSD-04399

4300 Unable to read complete record from datafile

4301 Record size too large

4302 Invalid record type, load options, or both
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File I/O Errors: OSD-04000 to OSD-04099
OSD-04000

Logical block size mismatch
Cause:  Database block size specified in initialization parameter file does not 
match block size of actual database files.

Action:  Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause:  Logical block size is not a multiple of 512 bytes, or it is too large. 

Action:  Change the value of DB_BLOCK_SIZE in the initialization parameter 
file.

Semaphore Errors: OSD-04400 to OSD-04499

4400 Unable to acquire internal semaphore for process

4401 WaitForSingleObject() failure, unable to obtain semaphore

Miscellaneous Errors: OSD-04500 to OSD-04599

4500 Illegal option specified

4501 Internal buffer overflow

4502 Translations nested too deep

4503 Text contains no translatable elements

4505 stdin not responding

4506 Unable to spawn process via system()

4510 Operating system roles are not supported

4511 Unable to get date and time from the operating system

4512 Unable to translate the 'USERNAME' config.ora variable on server

4513 'remote_os_authent' init.ora variable not set to true

4514 The Windows Group name is too long for internal buffer

4515 This command is not implemented at this time
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OSD-04002
Unable to open file
Cause:  Specified path or filename is invalid, or destination device is full. This 
error can also be caused by insufficient Windows file handles. 

Action:  Make sure path and file exist, and device has free space. If this fails, 
then increase number of Windows file handles. 

OSD-04003
Unable to read file header block
Cause:  Media has been damaged. 

Action:  Recover file, if necessary, and verify that Windows is functioning cor-
rectly. 

OSD-04004
Invalid file header
Cause:  File is damaged. 

Action:  Recover file. 

OSD-04005
SetFilePointer() failure, unable to read from file
Cause:  Unexpected return from Windows system service SetFilePointer(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04006
ReadFile() failure, unable to read from file
Cause:  Unexpected return from Windows system service ReadFile(). 

Action:  Check operating system error code and Windows documentation.

OSD-04007
Truncated read
Cause:  System encountered an unexpected end-of-file, which is due to 
damaged media. 

Action:  Verify that file is not damaged. 

OSD-04008
WriteFile() failure, unable to write to file
Cause:  Unexpected return from Windows system service WriteFile(). 

Action:  Check operating system error code and Windows documentation. 
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OSD-04009
Truncated write
Cause:  Destination device is full, or media is damaged.

Action:  Verify that device has free space and that file is not damaged. 

OSD-04010
<create> option specified, file already exists
Cause:  File you attempted to create already exists.

Action:  Delete existing file or use REUSE option in SQL statement. 

OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause:  Unexpected return from Windows system service 
GetFileInformationByHandle().

Action:  Check operating system error code and Windows documentation. 

OSD-04012
File size mismatch
Cause:  File to be re-used is either too large or too small.

Action:  Specify correct file size or delete existing file. 

OSD-04013
Unable to read line from file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 

OSD-04014
Unable to close file
Cause:  Media has been damaged. 

Action:  Recover file, if necessary, and verify that Windows is functioning cor-
rectly. 
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OSD-04015
Asynchronous I/O request returned an error
Cause:  Unexpected return from Windows system service. 

Action:  Check operating system error code and Windows documentation. 

OSD-04016
Error queuing an asynchronous I/O request
Cause:  Unexpected return from Windows system service. 

Action:  Check operating system error code and Windows documentation. 

OSD-04017
Unable to open the specified RAW device
Cause:  An invalid path or filename was specified, or device is full.

Action:  Make sure file exists and device is not full; verify that operating sys-
tem is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause:  An invalid path name was specified. 

Action:  Make sure directory or device exists and is accessible. 

OSD-04019
Unable to set file pointer
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 

OSD-04020
Unable to set eof file marker
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 
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OSD-04021
Unable to read file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 

OSD-04022
Unable to write file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 

OSD-04023
SleepEx() failure, unable to Sleep
Cause:  Unexpected return from Windows system service. 

Action:  Check operating system error code and Windows documentation. 

OSD-04024
Unable to delete file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check operating system error code (if available) and Windows docu-
mentation. If no operating system error code is presented, then verify that 
media is not damaged. 

OSD-04025
Invalid question asked
Cause:  This is an internal error, not normally expected to occur.

Action:  Contact Oracle Support Services. 

OSD-04026
Invalid parameter passed
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 
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Memory Errors: OSD-04100 to OSD-04199
OSD-04100

Malloc() failure, unable to allocate memory
Cause:  Program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04101
Invalid SGA: SGA not initialized
Cause:  System Global Area (SGA) has been allocated but not initialized.

Action:  Wait until STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause:  Unexpected return from Windows system service CreateFile(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause:  SGA does not exist. 

Action:  Start up an Oracle Database instance.

OSD-04104
Unable to map shared memory (SGA) into the address space
Cause:  Unexpected return from Windows system service MapViewOfFileEx(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause:  Unexpected return from Windows system service MapViewOfFileEx(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause:  Program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 
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OSD-04107
Unable to deallocate memory with VirtualFree
Cause:  Unexpected return from Windows system service VirtualFree(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04108
Unable to protect memory with VirtualProtect
Cause:  Unexpected return from Windows system service VirtualProtect(). 

Action:  Check operating system error code and Windows documentation.

Process Errors: OSD-04200 to OSD-04299
OSD-04200

Unable to begin another thread
Cause:  Program has run out of system resources. 

Action:  Shut down all unnecessary processes; install more memory in the com-
puter.

OSD-04201
No pid structure supplied to spdcr()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause:  Unexpected return from Windows system service DosSetPriority(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04203
DosKillProcess() failure, unable to kill process
Cause:  Unexpected return from Windows system service DosKillProcess(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04204
Invalid pid
Cause:  Process ID not recognized by system; process previously terminated.

Action:  Verify that process ID is correct and that process is active. 
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OSD-04205
CreateProcess() failure, unable to spawn process
Cause:  Unexpected return from Windows system service CreateProcess().

Action:  Check operating system error code and Windows documentation.

OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause:  Priority specified is invalid or out of range. 

Action:  Specify a valid setting for ORACLE_PRIORITY. 

OSD-04208
OpenProcess() failure, unable to open process handle
Cause:  Unexpected return from Windows system service OpenProcess(). 

Action:  Check operating system error code and Windows documentation. 

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause:  Unexpected background name given to spdcr(). 

Action:  Contact Oracle Support Services. 

OSD-04210
Timeout waiting for thread semaphore
Cause:  An Oracle Database thread died holding the semaphore. 

Action:  Restart Oracle Database instance. 

OSD-04211
Thread information not found
Cause:  An Oracle Database thread died without deleting its information. 

Action:  Restart Oracle Database instance. 

OSD-04212
Maximum number of Oracle threads reached
Cause:  Maximum number of Oracle Database threads for the instance is 
reached.

Action:  Wait until some connections exit before trying again. 
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OSD-04213
Oracle thread unable to DuplicateHandle()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04214
Oracle thread unable to CreateEvent()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04215
Bad function code supplied to ssthreadop
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04216
Unable to find file handle for that thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04217
Unable to retrieve system username for current user
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04218
Cannot post thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04219
Bad thread list semaphore
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 
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OSD-04221
Target thread is currently busy
Cause:  Target thread is processing an Oracle Database utility command.

Action:  Wait and resend command.

OSD-04222
Unable to get the threads context
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04223
Unable to set the threads context
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04224
Unable to suspend the target thread
Cause:  Check operating system error code.

Action:  Remedy operating system error.

OSD-04225
Unable to resume the target thread
Cause:  Check operating system error code.

Action:  Remedy operating system error.

Loader Errors: OSD-04300 to OSD-04399
OSD-04300

Unable to read complete record from datafile
Cause:  Datafile ended in the middle of a record. This error occurs when 
loading files with a fixed record length. 

Action:  Verify that datafile is of correct length and contains complete records. 

OSD-04301
Record size too large
Cause:  Specified record size is too large to load. 

Action:  Reduce record size and reload data. 
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OSD-04302
Invalid record type, load options, or both
Cause:  Control file's Windows file processing options string contains an invalid 
option or keyword. 

Action:  Set Windows file processing options string to an acceptable value. 

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400

Unable to acquire internal semaphore for process
Cause:  Oracle Database has exceeded the maximum number of connections. 

Action:  Delete any unused connections and try again. 

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphore
Cause:  Unexpected return from Windows system service 
WaitForSingleObject(). 

Action:  Check operating system error code and Windows documentation. 

Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500

Illegal option specified
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04501
Internal buffer overflow
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04502
Translations nested too deep
Cause:  Program encountered too many intermediate translations while 
attempting to translate a configuration variable. 

Action:  Simplify values of configuration parameters to include fewer interme-
diate translations. 
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OSD-04503
Text contains no translatable elements
Cause:  Program cannot recognize variables in text to be translated.

Action:  Check and, if necessary, correct text to be translated. 

OSD-04505
stdin not responding
Cause:  System is unable to receive input from standard input stream.

Action:  Verify that process has access to an input device. 

OSD-04506
Unable to spawn process via system()
Cause:  System is out of memory or executable is invalid. 

Action:  Shut down unnecessary processes; install more memory in the com-
puter. Verify name of executable. 

OSD-04510
Operating system roles are not supported
Cause:  An attempt was made to use an operating system role. 

Action:  Only use roles that were created 'IDENTIFIED BY PASSWORD' as 
opposed to 'IDENTIFIED EXTERNALLY'. 

OSD-04511
Unable to get date and time from the operating system 
Cause:  Unexpected return from GetLocalTime() call. 

Action:  Verify that system time is correct on the computer. 

OSD-04512
Unable to translate the 'USERNAME' config.ora variable on server
Cause:  'USERNAME' configuration parameter variable on host is not properly 
set. 

Action:  Verify 'USERNAME' variable is set. 
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OSD-04513
'remote_os_authent' init.ora variable not set to TRUE
Cause:  For remote operating system logon to function, 'REMOTE_OS_AUTHENT' 
parameter must be set to TRUE. 

Action:  Shut down and start up instance with 'REMOTE_OS_AUTHENT = 
TRUE' in initialization parameter file. 

OSD-04514
The Windows Group name is too long for internal buffer
Cause:  Windows Group name is too long.

Action:  Use a shorter Windows group name.

DIM-00000 to DIM-00039: ORADIM Command Syntax Errors
ORADIM is a command-line tool for starting and stopping database instances that is 
only available on Oracle Database for Windows. It is not available on any other 
platform.

Oradim Errors DIM-0000 to DIM-0039

00000 ORADIM completed with no errors

00001 ORADIM: <command> [options]. Refer to manual.

00002 The specified command was invalid.

00003 An argument is missing for the parameter

00004 SID or service name was not specified.

00005 SID with more than 64 characters specified.

00006 Missing SID

00007 Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is AUTO or 
MANUAL.

00008 A valid service name is OracleService appended with a SID

00009 SID name is mandatory. 

00010 SYSTEM\CurrentControlSet\Services\OracleService key does not exist.

00011 The specified service does not exist.

00012 A PFILE is necessary for AUTOSTART option.

00013 Service start mode could not be set in the registry.

00014 Cannot open the Windows NT Service Control Manager.
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00015 Cannot start already-running ORACLE - shut it down first.

00016 Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC or INST.

00017 Instance shutdown mode must be one of the following: a for abort, i for immediate or n for 
normal.

00018 Failed to stop Oracle Service.

00019 Create Service Error.

00020 A service for this name exists.

00021 Registry open failed.

00023 Create an instance by specifying the following options:

00024 -NEW -SID sid | -SRVC srvc | -ASMSID sid | -ASMSRVC srvc [-SYSPWD pass]

00025 [-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | -SPFILE]

00026 [-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS osusr/ospass]

00027 Edit an instance by specifying the following options:

00028 -EDIT -SID sid | -ASMSID sid [-SYSPWD pass]

00029 [-STARTMODE auto | manual] [SRVCSTART system | demand] [-PFILE file | -SPFILE]

00030 [-SHUTMODE normal | immediate | abort] [-SHUTTYPE srvc | inst] [-RUNAS osusr/ospass]

00031 Delete instances by specifying the following options:

00032 -DELETE -SID sid | -ASMSID sid | -SRVC srvc | -ASMSRVC srvc

00033 Startup services and instance by specifying the following options:

00034 -STARTUP -SID sid | -ASMSID sid [-SYSPWD pass]

00035 [-STARTTYPE srvc | inst | srvc,inst] [-PFILE filename | -SPFILE]

00036 Shutdown services and instance by specifying the following options:

00037 -SHUTDOWN -SID sid | -ASMSID sid [-SYSPWD pass]

00038 [-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]

00039 Query for help by specifying the following parameters: -? | -h | -help

00040 Invalid option for the -NEW command.

00041 Invalid option for the -EDIT command.

00042 Invalid option for the -DELETE command.

00043 Invalid option for the -STARTUP command.

00044 Invalid option for the -SHUTDOWN command.

00045 Internal error in ORADIM.

00046 Invalid Pfile.

Oradim Errors DIM-0000 to DIM-0039
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DIM-00000
ORADIM completed with no errors.
Cause:  The specified operation completed successfully.

Action:  None.

DIM-00001
ORADIM: <command> [options]. Refer to manual.
Cause:  The specified options were invalid or no arguments were supplied.

Action:  Usage: ORADIM <command> [options]

DIM-00002
The specified command was invalid.
Cause:  Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and 
-SHUTDOWN.

Action:  Use valid command.

DIM-00003
An argument is missing for the parameter.
Cause:  Missing or invalid argument.

Action:  Use a valid argument and invoke the program again.

DIM-00004 
SID or service name was not specified.
Cause:  Either a SID or service name is mandatory.

Action:  Enter a valid SID of 64 characters and retry.

00050 Instance deleted.

00051 Instance created.

00075 Failed to control service.

00076 Failed to delete service.

00077 Failed to change service configuration.

00078 Failed to start service.

Oradim Errors DIM-0000 to DIM-0039
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DIM-00005
SID with more than 64 characters specified.
Cause:  SID with more than 64 characters specified.

Action:  Change SID to 64 unique characters and make sure that there is no 
other service with this name.

DIM-00006
Missing SID.
Cause:  SID was not specified in the arguments.

Action:  Specify a SID.

DIM-00007
Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is 
AUTO or MANUAL.
Cause:  An argument for STARTMODE is missing.

Action:  Enter a valid start mode and retry.

DIM-00008
A valid service name is OracleService appended with a SID
Cause:  The Oracle service name specified is invalid.

Action:  Correct the name of service and retry.

DIM-00009
SID name is mandatory.
Cause:  SID was not specified.

Action:  Enter the SID and retry.

DIM-00010
SYSTEM\CurrentControlSet\Services\OracleService key does not exist.
Cause:  Specified registry key was not found.

Action:  Try reinstalling. If the problem persists, contact Oracle Support Ser-
vices.

DIM-00011
The specified service does not exist.
Cause:  An attempt to edit a service failed.

Action:   Make sure the service exists or user has enough privileges.
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DIM-00012
A PFILE is necessary for AUTOSTART option.
Cause:  A parameter file {PFILE} was not specified.

Action:  Specify a parameter file.

DIM-00013
Service start mode could not be set in the registry.
Cause:  The start mode entry in the registry for the service could not be set.

Action:  Check if the user has privileges to modify registry.

DIM-00014
Cannot open the Windows NT Service Control Manager.
Cause:  The Service Control Manager could not be opened.

Action:  Check for user privileges.

DIM-00015
Cannot start already-running ORACLE - shut it down first.
Cause:  The instance is already started.

Action:  Stop the database before restarting.

DIM-00016
Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC 
or INST.
Cause:  An option for SHUTTYPE was missing or invalid.

Action:  Enter parameter to shut down the instance or the service and retry.

DIM-00017
Instance shutdown mode must be one of the following: a for abort, i for immediate or n 
for normal.
Cause:  Invalid option to shut down the instance was specified.

Action:  Enter the correct mode and retry.

DIM-00018
Failed to stop Oracle Service.
Cause:  An attempt to stop the service failed.

Action:  Retry, check for user privileges.
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DIM-00019
Create service error.
Cause:  Service could not be created.

Action:  Check for user privileges and retry.

DIM-00020
A service for this name exists.
Cause:  An attempt was made to create a service name when it already existed.

Action:  Retry with a different service name or SID.

DIM-00021
Registry open failed
Cause:  An attempt to open the registry failed.

Action:  Check for user privileges and retry the operation.

DIM-00023
Create an instance by specifying the following options:
Cause:  n/a

Action:  n/a

DIM-00024   
-NEW -SID sid | -SRVC srvc | -ASMSID sid | -ASMSRVC srvc [-SYSPWD pass]
Cause:  n/a

Action:  n/a

DIM-00025
[-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | 
-SPFILE]
Cause:  n/a

Action:  n/a

DIM-00026
[-SHUTMODE normal | immediate | abort] [-TIMEOUT secs] [-RUNAS 
osusr/ospass]
Cause:  n/a

Action:  n/a
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DIM00027
Edit an instance by specifying the following options:
Cause:  n/a

Action:  n/a

DIM-00028
-EDIT -SID sid | -ASMSID sid [-SYSPWD pass]
Cause:  n/a

Action:  n/a

DIM-00029
[-STARTMODE auto | manual] [-SRVCSTART system | demand] [-PFILE file | 
-SPFILE]
Cause:  n/a

Action:  n/a

DIM-00030
[-SHUTMODE normal | immediate | abort] [-SHUTTYPE srvc | inst] [-RUNAS 
osusr/ospass]
Cause:  n/a

Action:  n/a

DIM-00031
Delete instances by specifying the following options:
Cause:  n/a

Action:  n/a

DIM-00032
-DELETE -SID sid | -ASMSID sid | -SRVC srvc | -ASMSRVC srvc
Cause:  n/a

Action:  n/a

DIM-00033
Start up services and instance by specifying the following options:
Cause:  n/a

Action:  n/a
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DIM-00034
-STARTUP -SID sid | -ASMSID sid [-SYSPWD pass]
Cause:  n/a

Action:  n/a

DIM-00035
[-STARTTYPE srvc | inst | srvc,inst] [-PFILE filename | -SPFILE]
Cause:  n/a

Action:  n/a

DIM-00036
Shut down services and instance by specifying the following options:
Cause:  n/a

Action:  n/a

DIM-00037
-SHUTDOWN -SID sid | -ASMSID sid [-SYSPWD pass]
Cause:  n/a

Action:  n/a

DIM-00038
[-SHUTTYPE srvc | inst | srvc,inst] [-SHUTMODE normal | immediate | abort]
Cause:  n/a

Action:  n/a

DIM-00039
Query for help by specifying the following parameters: -? | -h | -help
Cause:  n/a

Action:  n/a

DIM-00040
Invalid option for the -NEW command.
Cause:  One or more arguments for creating new service is invalid.

Action:  Specify required option and retry.



DIM-00000 to DIM-00039: ORADIM Command Syntax Errors

Error Messages on Windows D-25

DIM-00041
Invalid option for the -EDIT command.
Cause:  One or more arguments for editing existing service is invalid.

Action:  Specify required option and retry.

DIM-00042
Invalid option for the -DELETE command.
Cause:  One or more arguments for deleting service is invalid.

Action:  Specify required option and retry.

DIM-00043
Invalid option for the -STARTUP command.
Cause:  One or more arguments for starting the instance is invalid.

Action:  Specify required option and retry.

DIM-00044
Invalid option for the -SHUTDOWN command.
Cause:  One or more arguments for shutting down the instance is invalid.

Action:  Specify required option and retry.

DIM-00045
Internal error in ORADIM
Cause:  Unknown.

Action:  Contact Oracle Support Services.

DIM-00046
Invalid Pfile.
Cause:  The parameter filename is invalid.

Action:  Check that the path name is correct.

DIM-00050
Instance deleted
Cause:  The request for deleting instance was successful.

Action:  None.
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DIM-00051
Instance created.
Cause:  The request for creating new instance was successful.

Action:  None.

DIM-00075
Failed to control service.
Cause:  An attempt to control the service failed.

Action:  Check additional error, make sure that user has enough privileges.

DIM-00076
Failed to delete service.
Cause:  The request for service deletion failed.

Action:  Check additional error, make sure that user has enough privileges.

DIM-00077
Failed to change service configuration.
Cause:  An attempt to change configuration failed.

Action:  Check additional error, make sure that user has enough privileges.

DIM-00078
Failed to start service.
Cause:  The request to start service failed.

Action:  Check additional error, make sure that user has enough privileges.

Database Connection Issues
The following are common Oracle Database connection error codes, their causes, 
and suggested remedies.

TNS-12203
TNS: unable to connect to destination
Cause:  OracleServiceSID service, OracleHOME_NAMETNSListener service, or 
both are not running.

Action:  Ensure that both services are started.
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ORA-12560
TNS: lost contact
Cause:  OracleServiceSID service, OracleHOME_NAMETNSListener service, or 
both are not running. You receive this error if you attempt to use any Oracle 
Database utilities, such as SQL*Plus. This error is analogous to the following 
Oracle7 error: ORA-09352: Windows 32-bit Two-Task driver unable to 
spawn new ORACLE task.

Action:  Ensure that both services are started.

ORA-28575
unable to open RPC connection to external procedure agent 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure services.

ORA-06512
at "APPLICATIONS.OSEXEC", line 0
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure services.

ORA-06512
at "APPLICATIONS.TEST", line 4 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure services.

ORA-06512
at line 2 
Cause:  tnsnames.ora and listener.ora files have not been correctly 
configured to use external procedures.

Action:  Reconfigure services.
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ORA-01031 and LCC-00161
Both codes appear at startup
Cause:  Parameter file (init.ora) or Windows services are damaged. These errors 
usually appear when the parameter file cannot be read by Oracle Database at 
database startup. 

Action:  Delete and re-create the SID and services. Make sure you are logged on 
as the user Administrator, or a user within the Windows Administrator's Group 
with full administrative rights. At the command prompt, enter: oradim 
-delete -sid sid where sid is the name of your database (for example, 
orcl). Re-create the SID and services by entering: oradim -new -sid sid 
-startmode auto -pfile full_path_to_init.ora
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E
Using Oracle Database on Windows 2000

This chapter highlights differences between Windows 2000 and Windows NT, with 
emphasis on procedures for common database tasks.

This chapter contains these topics:

■ How to Perform Common Tasks in Windows NT and Windows 2000

■ Other Differences Between Windows NT and Windows 2000
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How to Perform Common Tasks in Windows NT and Windows 2000
Table E–1 lists common database administration tasks and tools required to 
accomplish those tasks in Windows NT and Windows 2000.

Table E–1 How to Perform Common Tasks in Windows NT and Windows 2000

Task Windows NT Windows 2000

Install a domain controller Windows setup Active Directory installation wizard from 
Configure Your Server

Manage user accounts User Manager

Choose Start > Programs > 
Administrative Tools > 
User Manager

Active Directory Users & Computers

Choose Programs > Administrative Tools > Active 
Directory

Manage groups User Manager Active Directory Users & Computers

Manage computer 
accounts

Server Manager

Choose Start > Programs > 
Administrative Tools > 
Server Manager

Active Directory Users & Computers

Add a computer to a 
domain

Server Manager Active Directory Users & Computers

Create or manage trust 
relationships

User Manager Active Directory Domains & Trusts

Manage account policy User Manager Active Directory Users & Computers

Manage user rights User Manager Active Directory Users & Computers: Edit the 
Group Policy object for the domain or 
organizational unit containing the computers to 
which the users rights apply.

Manage audit policy User Manager Active Directory Users & Computers: Edit the 
Group Policy object assigned to the Domain 
Controllers organizational unit.

Set policies on users and 
computers in a site

System Policy Editor

Choose Start > Programs > 
Administrative Tools > 
System Policy Editor

Group Policy, accessed through Active Directory 
Sites & Services

Set policies on users and 
computers in a domain

System Policy Editor Group Policy, accessed through Active Directory 
Users & Computers
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Other Differences Between Windows NT and Windows 2000
This section discusses differences between Windows NT and Windows 2000 that are 
not related to common tasks.

No DNS Domain Name for Windows 2000 Computer
If a Windows 2000 computer is not identified with a DNS domain name, then you 
will receive the following error message:

Calling query w32RegQueries1.7.0.17.0  RegGetValue
Key = HKEY_LOCAL_MACHINE
SubKey = SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Value = Domain

Query Exception: GetValueKeyNotFoundException
Query Exception Class: class oracle.sysman.oii.oiil.OiilQueryException
...

Perform the following steps: 

1. Choose Start > Control Panel > System > Network Identification > Property > 
More > Primary DNS. 

2. Enter a domain name, for example, us.oracle.com.

Set policies on users and 
computers in an 
organizational unit

Not applicable Group Policy, accessed through Active Directory 
Users & Computers

Use Security Groups to 
filter the scope of policy

Not applicable Edit the permissions entry for Apply Group Policy 
on the security tab of the Group Policy Object 
properties sheet

Start Oracle Counters for 
Windows Performance 
Monitor

Choose Start > Programs > 
Oracle - HOME_NAME > 
Configuration and 
Migration Tools > Oracle 
Counters for Windows 
Performance Monitor

Choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools > 
Oracle Counters for Windows Performance 
Monitor

Access services dialog Choose Start > Settings > 
Control Panel > Services

Choose Start > Settings > Control Panel > 
Administrative Tools > Services

Table E–1 (Cont.) How to Perform Common Tasks in Windows NT and Windows 2000

Task Windows NT Windows 2000
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Microsoft Management Console Included in Windows 2000
Microsoft Management Console, available in Windows NT as a separate item from 
Microsoft, is included in Windows 2000.

Raw Partitions
In Windows NT, use Disk Administrator to create raw partitions required for 
Oracle Real Application Clusters.

In Windows 2000, use Computer Management to create basic disks (compatible 
with raw partitions on Windows NT). Choose Start > Programs > Administrative 
Tools > Computer Management.

Services Autostart
Oracle services autostart on Windows NT 4.0. After upgrading to Windows 2000, 
you may find that services start but the database does not start.

The solution is to use ORADIM to delete and re-create the services.

To delete an instance using ORADIM, enter: 

ORADIM -DELETE -SID SIDA, SIDB, SIDC, ... 
ORADIM -DELETE -SRVC SRVCA, SRVCB, SRVC, ... 

where: 

■ SIDA, SIDB, SIDC are values of the SIDs to delete. 

■ SRVCA, SRVCB, SRVC are values of the services to delete. 

During upgrading, the disk is converted to NTFS 5, and a different access 
authorization is used. The new services autostart under the same account, but they 
no longer hold the same Windows permissions as before.
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F
Oracle Database Windows/UNIX Differences

This chapter lists major differences between Oracle Database on Windows and 
UNIX. For Oracle Database developers and database administrators moving from a 
UNIX platform to Windows, this information can be helpful in understanding 
Windows features that are relevant to Oracle Database.

This chapter contains these topics:

■ Automatic Startup and Shutdown

■ Background Processing and Batch Jobs

■ Diagnostic and Tuning Utilities

■ Direct Writes to Disk

■ Dynamic Link Libraries (DLLs)

■ Hot Backups

■ Initialization Parameters: Multiple Database Writers

■ Install Accounts and Groups

■ Installation

■ Memory Resources

■ Microsoft Transaction Server

■ Multiple Oracle Homes and OFA

■ Processes and Threads

■ Raw Partitions

■ Services
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Automatic Startup and Shutdown
On UNIX, several files and scripts in different directories are used to start an 
instance automatically. Other scripts are run on computer shutdown, allowing 
applications such as Oracle Database to shut down cleanly.

For automatic startup on Windows, set registry parameter ORA_SID_AUTOSTART 
to true using an Oracle Database tool such as ORADIM. Enter the following with 
parameters at the command prompt:

C:\> oradim options

To start the listener automatically, set services startup type to automatic.

For automatic shutdown on Windows, set registry parameters ORA_SHUTDOWN and 
ORA_SID_SHUTDOWN to stop the relevant OracleServiceSID and shut down. Set 
registry parameter ORA_SID_SHUTDOWNTYPE to control shutdown mode (default is 
i, or immediate).

Background Processing and Batch Jobs
UNIX provides sophisticated control mechanisms for background processing and 
batch jobs.

For similar functionality on Windows, use the AT command or a GUI version in the 
Microsoft Resource Kit.

Diagnostic and Tuning Utilities
On UNIX, utilities such as sar and vmstat are used to monitor Oracle Database 
background and shadow processes. These utilities are not integrated with Oracle 
Database.

Performance utilities available on Windows include Oracle Counters for Windows 
Performance Monitor, Task Manager, Control Panel, Event Viewer, User Manager, 
and Microsoft Management Console (included only with Windows 2000). 

See Also:

■ Chapter 6, "Administering a Database on Windows"

■ Oracle 2 Day DBA
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Oracle Database is integrated with several of these tools. For example:

■ Oracle Counters for Windows Performance Monitor displays key Oracle 
Database information. This tool is the same in appearance and operation as 
Windows Performance Monitor, except it has been preloaded with Oracle 
Database performance elements.

■ Event Viewer displays system alert messages, including Oracle Database 
startup/shutdown messages and audit trail.

■ Task Manager on Windows displays currently running processes and their 
resource usage, similar to the UNIX ps -ef command or HP OpenVMS SHOW 
SYSTEM. But Task Manager is easier to interpret and the columns can be 
customized. 

Direct Writes to Disk
On both UNIX and Windows platforms, bypassing the file system buffer cache 
ensures data is written to disk.

On UNIX, Oracle Database uses the O_SYNC flag to bypass the file system buffer 
cache. The flag name depends on the UNIX port.

On Windows, Oracle Database bypasses the file system buffer cache completely.

Dynamic Link Libraries (DLLs)
Shared libraries on UNIX are similar to shared DLLs on Windows. Object files and 
archive libraries are linked to generate Oracle Database executables. Relinking is 
necessary after certain operations, such as installation of a patch.

On Windows, Oracle Database DLLs form part of the executable at run time and are 
therefore smaller. DLLs can be shared between multiple executables. Relinking by 
the user is not supported, but executable images can be modified using 
ORASTACK.

See Also:

■ Chapter 3, "Database Tools on Windows"

■ Chapter 7, "Monitoring a Database on Windows"
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Modifying executable images on Windows reduces the chances of running out of 
virtual memory when using a large SGA or when supporting thousands of 
connections. However, Oracle recommends doing this only under the guidance of 
Oracle Support Services.

Hot Backups
A (manual) hot backup is equivalent to backing up a tablespace that is in offline 
backup mode.

Backup strategy on UNIX is as follows: put the tablespace into backup mode, copy 
the files to the backup location, and bring the tablespace out of backup mode.

Windows supports the same backup strategy, but you cannot copy files in use with 
normal Windows utilities. Use OCOPY to copy open database files to another disk 
location. Then use a utility to copy the files to tape. 

Initialization Parameters: Multiple Database Writers
On UNIX, you can specify more than one database writer process with initialization 
parameter DB_WRITERS. Multiple database writers can help, for example, when a 
UNIX port does not support asynchronous I/O.

DB_WRITERS is supported but typically unnecessary on Windows, which has its 
own asynchronous I/O capabilities.

Install Accounts and Groups
UNIX uses the concept of a DBA group. The root account cannot be used to install 
Oracle Database. A separate Oracle Database account must be created manually.

On Windows, Oracle Database must be installed by a Windows username in the 
Administrators group. The username is automatically added to the Windows local 
group ORA_DBA, which receives the SYSDBA privilege. This allows the user to log 
in to the database using CONNECT / AS SYSDBA and not be prompted for a 
password.

Password files are located in the ORACLE_BASE\ORACLE_HOME\database 
directory and are named pwdSID.ora, where SID identifies the Oracle Database 
instance.

See Also: Chapter 13, "Oracle Database Specifications for 
Windows"
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Installation
The following manual setup tasks, all required on UNIX, are not required on 
Windows:

■ Set environment variables

■ Create a DBA group for database administrators

■ Create a group for users running Oracle Universal Installer

■ Create an account dedicated to installing and upgrading Oracle Database 
components

Memory Resources
The resources provided by the UNIX default kernels are often inadequate for a 
medium or large instance of Oracle Database. The maximum size of a shared 
memory segment (SHMMAX) and maximum number of semaphores available 
(SEMMNS) may be too low for Oracle Database recommendations.

On Windows, fewer resources are needed for interprocess communication (IPC), 
because the Oracle Database relational database management system is 
thread-based and not process-based. These resources, including shared memory 
and semaphores, are not adjustable by the user.

Microsoft Transaction Server
UNIX does not support Microsoft Transaction Server.

Windows supports Microsoft Transaction Server beginning with Oracle8. Using 
Oracle Services for Microsoft Transaction Server, you can develop and deploy 
applications based on COM/COM+. Microsoft Transaction Server coordinates 
application transactions for Oracle Database.

See Also: Chapter 6, "Administering a Database on Windows"

See Also: Oracle Database Installation Guide for Windows

See Also: Oracle Services for Microsoft Transaction Server Developer's 
Guide
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Multiple Oracle Homes and OFA
The goal of OFA is to place all Oracle Database software under one ORACLE_
HOME directory and to spread database files across different physical drives as 
databases increase in size. OFA is implemented on Windows and UNIX in the same 
way, and main subdirectory and filenames are the same on both operating systems. 
Windows and UNIX differ, however, in their OFA directory tree top-level names 
and in the way variables are set.

On UNIX, ORACLE_BASE is associated with a user's environment. ORACLE_HOME 
and ORACLE_SID must be set in system or user login scripts. Symbolic links are 
supported. Although everything seems to be in one directory on the same hard 
drive, files may be on different hard drives if they are symbolically linked or have 
that directory as a mount point.

On Windows, ORACLE_BASE is defined in the registry (for example, in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0). ORACLE_HOME and ORACLE_SID 
are variables defined in the registry. Symbolic links like those on UNIX are not 
supported, although Microsoft has announced the intention to support them in a 
future release.

Processes and Threads
On UNIX, Oracle Database uses a process to implement each of such background 
tasks as database writer (DBW0), log writer (LGWR), shared server process 
dispatchers, and shared servers. Each dedicated connection made to the database 
causes another operating system process to be spawned on behalf of that session. 

On Windows, each background process is implemented as a thread inside a single, 
large process. For each Oracle Database instance or system identifier, there is one 
corresponding process for Oracle Database. For example, 100 Oracle Database 
processes for a database instance on UNIX are handled by 100 threads inside one 
process on Windows.

All Oracle Database background, dedicated server, and client processes are threads 
of the master Oracle Database Windows process, and all threads of the Oracle 
Database process share resources. This multithreaded architecture is highly 
efficient, allowing fast context switches with low overhead. 

See Also: Chapter 2, "Multiple Oracle Homes and Optimal 
Flexible Architecture"
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To view processes or end individual threads, use Oracle Administration Assistant 
for Windows. Choose Start > Programs > Oracle - HOME_NAME > Configuration 
and Migration Tools > Administration Assistant for Windows. Right-click the SID 
and choose Process Information.

Raw Partitions
Datafiles for tablespaces may be stored on a file system or on raw partitions. A raw 
partition is a portion of a physical disk that is accessed at the lowest possible level.

UNIX supports raw partitions (logical drives). There is no limitation on the number 
of disk drives.

Windows is limited to using drive letters A-Z, but creating raw partitions lets you 
bypass the disk drive limitation and divide disks into smaller sections.

Use Windows disk management tools to create an extended partition on a physical 
drive. An extended partition points to raw space on the disk that can be assigned 
multiple logical partitions for database files. 

An extended partition avoids the four-partition limit on Windows by allowing you 
to define large numbers of logical partitions to accommodate applications using 
Oracle Database. Logical partitions can then be given symbolic link names to free 
up drive letters.

Note: Microsoft Management Console (MMC) is started when 
Oracle Administration Assistant for Windows is started. Oracle 
Database has integrated several database administration snap-ins 
into MMC.

See Also:

■ Oracle Administration Assistant for Windows online help

■ Chapter 1, "Oracle Database Architecture on Windows"
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Services
Windows services are similar to UNIX daemons.

Oracle Database registers a database instance as a service (OracleServiceSID). 
Services start background processes.

To connect to and use an Oracle Database instance, an Oracle Database service is 
created during database creation and associated with Oracle Database. Once a 
service is created with Oracle Database, the service can run even while no user is 
logged on.

By default, services run under the SYSTEM account. Choose Start > Settings > 
Control Panel > Services to access the Services dialog.

Note: Raw partitions are necessary for shared datafiles in an 
Oracle Real Application Clusters environment, available on 
Windows. Oracle Real Application Clusters, in which Oracle 
Database instances run on all nodes simultaneously, provides 
clustering and high availability. Oracle Real Application Clusters is 
not supported on Windows XP.

See Also: Appendix E, "Using Oracle Database on Windows 
2000"

See Also: Chapter 6, "Administering a Database on Windows"
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Glossary

alert file

A file that contains important information and error messages that are generated 
during database operations.

authenticate

To verify the identity of a user, device, or other entity in a computer system, often as 
a prerequisite for allowing access to resources in a system.

authentication

Identification of a user, device, or other entity in a computer system, often as a 
prerequisite for allowing access to resources in a system.

authorization

Permission given to a user, program, or process to access an object or set of objects. 
In Oracle Database, authorization is done through the role mechanism. A single 
person or a group of people can be granted a role or a group of roles. A role, in turn, 
can be granted other roles.

backup

A representative copy of data. This copy includes important parts of your database 
such as control files, redo log files, and datafiles.

A backup is a safeguard against unexpected data loss; if you lose your original data, 
then you can use the backup to make the data available again. A backup is also a 
safeguard against an application error; if an application makes incorrect changes, 
then you can restore the backup.
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certificate authority

A certificate authority (CA) is a trusted third party that certifies the identity of other 
entities such as users, databases, administrators, clients, and servers. The certificate 
authority verifies the user's identity and grants a certificate, signing it with one of 
the certificate authority's private keys. 

COM/COM+

Microsoft's Component Object Model is an object-oriented programming 
architecture and a set of operating system services. These services notify running 
application components of significant events and ensure that they are authorized to 
run. COM/COM+ is intended to make it relatively easy to create business 
applications that work well with Microsoft Transaction Server in Windows NT and 
Windows 2000.

connect descriptor

A specially formatted description of the destination for a network connection. A 
connect descriptor contains destination services and network route information. 
The destination service is indicated by using its service name for Oracle9i or 
Oracle8i databases or its Oracle system identifier for Oracle8 release 8.0 databases. 
The network route provides, at a minimum, the location of the listener through use 
of a network address.

connect identifier

A net service name or service name, that maps to a connect descriptor. Users 
initiate a connect request by passing a username and password along with a 
connect identifier in a connect string for the services to which they wish to connect, 
for example:

CONNECT username/password@connect_identifier

connect string

See net service name.

control files

Files that record the physical structure of a database and contain the database name, 
the names and locations of associated databases and online redo log files, the time 
stamp of the database creation, the current log sequence number, and checkpoint 
information.
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credentials

A username, password, or certificate used to gain access to the database.

data dictionary

A set of read-only tables that provide information about a database.

database alias

See net service name.

decryption

Process of converting contents of a message that has gone through encryption 
(ciphertext) back into its original readable format (plaintext).

digital certificates

ITU X.509 v3 standard data structures that securely bind an identity to a public key. 
A certificate is created when an entity's public key is signed by a trusted identity, a 
certificate authority. The certificate ensures that the entity's information is correct 
and that the public key actually belongs to that entity.

digital signature

Digital signatures are created when a public key algorithm is used to sign messages 
with senders' private keys. A digital signature assures that a document is authentic, 
has not been forged by another entity, has not been altered, and cannot be 
repudiated by the sender.

DLL

See dynamic link library.

downgrade

To convert the data in Oracle Database to an earlier Oracle release. See upgrade and 
migrate.

dynamic link library

An executable file that a Windows application can load when needed.

encryption

Process of disguising a message, rendering it unreadable to any but the intended 
recipient.
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enterprise domains

Directory constructs consisting of Oracle Database and enterprise users and roles. 
Enterprise domains are different from Windows 2000 domains, which are 
collections of computers that share a common directory database.

enterprise role

A directory structure which contains global roles on multiple databases, and which 
can be granted to an enterprise user. 

enterprise user

A user that has a unique identity across an enterprise. An enterprise user connects 
to individual databases through a schema and is assigned an enterprise role that 
determines the user's access privileges on databases. 

external procedures

Functions written in a third-generation language (C, for example) and callable from 
within PL/SQL or SQL as if they were PL/SQL functions or procedures.

external role 

Roles created and managed by Windows NT and Windows 20000 operating 
systems. Once an external role is created, you can grant or revoke that role to a 
database user. You must set init.ora parameter OS_ROLES to true and restart 
Oracle Database before you can create an external role. You cannot use both 
Windows operating systems and Oracle Database to grant roles concurrently. 

external routine

A function written in a third-generation language (3GL), such as C, and callable 
from within PL/SQL or SQL as if it were a PL/SQL function or procedure.

external user 

A user authenticated by the Windows 2000 or Windows NT operating system who 
can access Oracle Database without being prompted for a password. External users 
are typically regular database users (non-database administrators) to which you 
assign standard database roles (such as CONNECT and RESOURCE), but do not want 
to assign SYSDBA (database administrator) or SYSOPER (database operator) 
privilege. 

external user 

The Windows operating system can authenticate a user, who can then access Oracle 
Database without being prompted for a password. External users are typically 
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regular database users (non-database administrators) to whom you assign standard 
database roles (such as CONNECT and RESOURCE), but do not want to assign the 
SYSDBA (database administrator) or SYSOPER (database operator) privilege.

global groups 

See Windows global groups. 

global role

A role whose privileges are contained within a single database, but which is 
managed in a directory.

Globalization Support

The Oracle Database architecture that ensures that database utilities, error 
messages, sort order, date, time, monetary, numeric, and calendar conventions 
automatically adapt to the native language and locale.

HOME_NAME

Represents the name of an Oracle home. In Oracle Database 10g, all Oracle homes 
have a unique HOME_NAME.

init.ora

See initialization parameter file.

initialization parameter file

An ASCII text file that contains information needed to initialize a database and 
instance.

instance

Every running Oracle Database is associated with an Oracle Database instance. 
When a database is started on a database server (regardless of the type of 
computer), Oracle Database allocates a memory area called the System Global Area 
and starts one or more Oracle Database processes. This combination of the System 
Global Area and Oracle Database processes is called an instance. The memory and 
processes of an instance manage the associated database's data efficiently and serve 
the users of the database.

instantiate

Produce a more defined version of some object by replacing variables with values 
(or other variables).
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latch

A simple, low-level serialization mechanism to protect shared data structures in the 
System Global Area. 

LDAP

See Lightweight Directory Access Protocol (LDAP). 

Lightweight Directory Access Protocol (LDAP)

A standard, extensible directory access protocol. It is a common language that 
LDAP clients and servers use to communicate. LDAP is a framework of design 
conventions supporting industry-standard directory products, such as Oracle 
Internet Directory. 

listener

The Oracle Database server process that listens for and accepts incoming 
connection requests from client applications. The listener process starts up Oracle 
Database processes to handle subsequent communications with the client; then it 
goes back to listening for new connection requests.

listener.ora

A configuration file that describes one or more Transparent Network Substrate 
(TNS) listeners on a server.

local groups

See Windows local groups.

local roles 

Roles created and managed by the database. Once a local role is created, you can 
grant or revoke that role to a database user. You cannot use Windows NT (for 
external role management) and Oracle Database (for local role management) 
concurrently.

Microsoft Management Console

An application that serves as a host for administrative tools called snap-ins. By 
itself, Microsoft Management Console does not provide any functionality.

Microsoft Transaction Server

A transaction processing system based on COM/COM+ that runs on an Internet or 
network server.
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migrate

To upgrade or downgrade an Oracle Database or convert the data in a non-Oracle 
database into an Oracle Database.

mount

To associate a database with an instance that has been started.

MTS

See Microsoft Transaction Server

multiple Oracle homes

The capability of having more than one Oracle home on a computer.

net service name

The name used by clients to identify an Oracle Net server and the specific system 
identifier or database for the Oracle Net connection. A net service name is mapped 
to a port number and protocol. Also known as a connect string, database alias, host 
string, or service name.

This also identifies the specific SID or database to which the connection is attaching, 
not just the Oracle Net server.

network listener

A listener on a server that listens for connection requests for one or more databases 
on one or more protocols. See listener.

network service

In an Oracle application network, a service performs tasks for its service consumers. 
For example, a Names Server provides name resolution services for clients.

obfuscated

Protected by a process often used by companies for intellectual property written in 
the form of Java programs. The obfuscation process mixes up Java symbols found in 
the code. It leaves the original program structure intact, allowing the program to 
run correctly, while changing the names of the classes, methods, and variables in 
order to hide the intended behavior. Although it is possible to decompile and read 
non-obfuscated Java code, obfuscated Java code is sufficiently difficult to decompile 
to satisfy U.S. government export controls.
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OCI

See Oracle Call Interface.

OFA

See Optimal Flexible Architecture.

Optimal Flexible Architecture

A set of file naming and placement guidelines for Oracle Database software and 
databases.

Oracle Call Interface

An application programming interface that enables you to manipulate data and 
schema in an Oracle Database. You compile and link an Oracle Call Interface 
application in the same way that you compile and link a non-database application. 
There is no need for a separate preprocessing or precompilation step.

ORACLE_HOME

Corresponds to the environment in which Oracle Database products run. This 
environment includes location of installed product files, PATH variable pointing to 
products' binary files, registry entries, net service name, and program groups.

If you install an OFA-compliant database, using Oracle Universal Installer defaults, 
Oracle home (known as \ORACLE_HOME in this guide) is located beneath 
X:\ORACLE_BASE. It contains subdirectories for Oracle Database software 
executables and network files.

Oracle Internet Directory

An Oracle Database-based LDAP V3 directory server, used for centralizing database 
user, Oracle Net network connector, and database listener parameters.

Oracle Net

A component of Oracle Net Services that enables a network session from a client 
application to an Oracle Database server. Once a network session is established, 
Oracle Net acts as a data courier for the client application and the database server. It 
is responsible for establishing and maintaining the connection between the client 
application and database server, as well as exchanging messages between them. 
Oracle Net is able to perform these jobs because it is located on each computer in 
the network.
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Oracle Net Services

A suite of networking components that provide enterprise-wide connectivity 
solutions in distributed, heterogeneous computing environments. Oracle Net 
Services are comprised of Oracle Net, listener, Oracle Connection Manager, Oracle 
Net Configuration Assistant, and Oracle Net Manager.

Oracle PKI

Oracle Advanced Security includes Oracle PKI (public key infrastructure) 
integration for authentication and single sign-on. Oracle-based applications are 
integrated with the PKI authentication and encryption framework, using Oracle 
Wallet Manager. 

Oracle Protocol Support

A product that maps the functions of a given network protocol into Oracle 
Transparent Network Substrate (TNS) architecture. This process translates TNS 
function calls into requests to the underlying network protocol. This allows TNS to 
act as an interface among all protocols. Oracle Net requires Oracle Protocol 
Support.

Oracle services

Windows services that are associated with particular Oracle Database components.

ORACLE_BASE

ORACLE_BASE is the root of the Oracle Database directory tree. If you install an 
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive (for example, C:\oracle).

ORACLE_HOME

Corresponds to the environment in which Oracle Database products run. This 
environment includes the location of installed product files, the PATH variable 
pointing to the binary files of installed products, registry entries, net service names, 
and program groups.

If you install an OFA-compliant database, using Oracle Universal Installer defaults, 
then Oracle home (known as \ORACLE_HOME in this guide) is located beneath 
X:\ORACLE_BASE. It contains subdirectories for Oracle Database software 
executables and network files.

PL/SQL

Procedural language extension to SQL that is part of Oracle Database.
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PL/SQL enables you to mix SQL statements with procedural constructs. You can 
define and run PL/SQL program units such as procedures, functions, and packages.

precompiler

A programming tool that enables you to embed SQL statements in a high-level 
source program.

private keys

In public key cryptography, these are the secret keys. They are used primarily for 
decryption but also for encryption with a digital signature. 

privilege

A right to run a particular type of SQL statement or to access another user's object.

process

A mechanism in an operating system that can run an executable. (Some operating 
systems use the terms job or task.) A process normally has its own private memory 
area in which it runs. On Windows a process is created when an application runs 
(such as Oracle Database or Microsoft Word). In addition to an executable program, 
all processes consist of at least one thread. The Oracle Database master process 
contains hundreds of threads. 

public key

In public key cryptography, this key is made public to all. It is primarily used for 
encryption but can also be used for verifying signatures.

public key cryptography

Public key cryptography involves information encryption and decryption using a 
shared public key paired with private keys. Provides for secure, private 
communications within a public network.

quota

A limit on a resource, such as a limit on the amount of database storage used by a 
database user. A database administrator can set tablespace quotas for each Oracle 
Database username.

raw partitions

Portions of a physical disk that are accessed at the lowest possible disk (block) level.
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recovery

To restore a physical backup is to reconstruct it and make it available to the Oracle 
Database server. To recover a restored backup is to update it using redo records 
(that is, records of changes made to the database after the backup was taken). 
Recovering a backup involves two distinct operations: rolling forward the backup 
to a more current time by applying redo data, and rolling back all changes made in 
uncommitted transactions to their original state.

redo log buffer

A circular buffer in the System Global Area that contains information about 
changes made to the database.

redo log files

Files that contain a record of all changes made to data in the database buffer cache. 
If an instance failure occurs, then the redo log files are used to recover the modified 
data that was in memory.

registry

A Windows repository that stores configuration information for a computer.

remote computer

A computer on a network other than the local computer.

remote database

A database on a computer other than the local database.

replication

The process of copying and maintaining database objects in multiple databases that 
make up a distributed database system.

role

A named groups of related privileges. You can grant a role to users or to another 
role.

schema

A named collection of objects, such as tables, views, clusters, procedures, and 
packages, associated with one or more particular users.
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services

Executable processes installed in the Windows registry and administered by 
Windows. Once services are created and started, they can run even when no user is 
logged on to the computer.

service name

See net service name.

SGA

See System Global Area.

Shared Server Process

A server configuration which allows many user processes to share very few server 
processes. The user processes connect to a dispatcher background process, which 
routes client requests to the next available shared server process. 

SID

See system identifier.

snap-ins

Administrative tools that run within Microsoft Management Console.

snapshot

(1) Information stored in rollback segments to provide transaction recovery and 
read consistency. Rollback segment information can be used to re-create a snapshot 
of a row before an update.

(2) A point-in-time copy of a master table located on a remote site. Read-only 
snapshots can be queried, but not updated. Updateable snapshots can be queried 
and updated. They are periodically refreshed to reflect changes made to the master 
table, and at the snapshot site.

starter database

A preconfigured, ready-to-use database that requires minimal user input to create.

SYSDBA

A special database administration role that contains all system privileges with the 
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits CREATE 
DATABASE actions and time-based recovery.
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SYSOPER

A special database administration role that permits a database administrator to 
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER DATABASE 
BACKUP, ARCHIVE LOG, and RECOVER, and includes the RESTRICTED SESSION 
privilege.

System Global Area

A group of shared memory structures that contain data and control information for 
an Oracle Database instance.

system identifier

A unique name for an Oracle Database instance. To switch between instances of 
Oracle Database, users must specify the desired system identifier. The system 
identifier is included in the CONNECT DATA parts of the connect descriptors in a 
tnsnames.ora file, and in the definition of the network listener in a tnsnames.ora 
file.

SYSTEM

One of two standard database administrator usernames automatically created with 
each database. (The other username is SYS.). The SYSTEM username is the preferred 
username for database administrators to use for database maintenance.

tablespace

A database is divided into one or more logical storage units called tablespaces. 
Tablespaces are divided into logical units of storage called segments, which are 
further divided into extents.

thread

An individual path of execution within a process. Threads are objects within a 
process that run program instructions. Threads allow concurrent operations within 
a process so that a process can run different parts of its program simultaneously on 
different processors. A thread is the most fundamental component that can be 
scheduled on Windows.

tnsnames.ora

A file that contains connect descriptors mapped to net service names. The file can be 
maintained centrally or locally, for use by all or individual clients.
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trace file

Each server and background process can write to an associated trace file. When a 
process detects an internal error, it dumps information about the error to its trace 
file. Some of the information written to a trace file is intended for the database 
administrator, while other information is intended for Oracle Support Services. 
Trace file information is also used to tune applications and instances.

trust points

Trust points or trusted certificates are third party identities that are qualified with a 
level of trust. A trusted certificate is used when an identity is being validated as the 
entity it claims to be. Certificate authorities you trust are called trusted certificates. 
If there are several levels of trusted certificates, a trusted certificate at a lower level 
in the certificate chain does not need to have all its higher level certificates 
reverified.

universal groups

Universal groups are available in Windows 2000, but not in Windows NT. They can 
contain other groups, including other universal groups, local groups, and global 
groups.

upgrade

To convert the data in an Oracle Database into a later release. See downgrade and 
migrate.

username

A name that can connect to and access objects in a database.

view

A selective presentation of the structure and data of one or more tables. Views can 
also be based on other views.

Windows global groups

Groups that can be granted permissions and rights in their own domain, member 
servers and workstations of their domain, and in trusted domains. They can also 
become members of Windows local groups in all these places. But global groups 
can contain user accounts only from their own domains.

Windows local groups

Groups that can be granted permissions and rights only for its own computer or, if 
part of a domain, to the domain controllers of that domain. Local groups can, 
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however, contain user accounts and Windows global groups from both their own 
domain and from trusted domains.

WOW64

Abbreviation for Windows 32-On-Windows 64. WOW64 is an x86 emulator that 
runs on top of 64-bit Windows and allows 32-bit applications to execute.
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A
admin directory, explained, 2-12
Advanced Replication support

data dictionary tables, 5-16
initialization parameter requirements, 5-15
tablespace requirements, 5-14, 5-16

alert files
monitoring a database, 7-2
using, 7-12

ALTER DATABASE ARCHIVELOG 
command, 6-19

application development
and data access, 15-4
finding information, 15-2

architecture
thread-based, 1-2

ARCHIVELOG mode, 6-19
archiving mode

controlling, 6-19
custom database, 6-19
starter database, 6-19

archiving procedures, 6-20
for redo log files, 6-19
specifying an archive destination, 6-20
UNC not allowed, 6-18

audit trail
managing, 7-12
operating system, 3-15

AUDIT_FILE_DEST
parameter, 7-12, 13-5

authentication
automatically enabling during installation, 9-5
enhancements, 9-3

OSAUTH_PREFIX_DOMAIN parameter, 10-40
overview, 9-2
using a password file, 6-14
using Windows native methods, 9-2
viewing parameter settings, 10-14
when to use enterprise users, 9-4
when to use external users, 9-4

authentication protocols
default protocol used, 9-3
with Windows 2000, 9-2
with Windows NT 4.0, 9-2

authorization
when to use enterprise roles, 9-4
when to use external roles, 9-4

auto-starting
Oracle Database services, 6-5

B
background processes

querying, 1-4
BACKGROUND_DUMP_DEST, 7-12
backup

control files, 14-7
databases, 4-16

Backup Wizard
preferred tools, 3-3

bad file
specifying, 3-14

block size
maximum, 13-7

blocks for each file, maximum, 13-7



Index-2

C
commands

ALTER DATABASE ARCHIVELOG, 6-19
ARCHIVE LOG LIST, 6-19
CREATE DATABASE, 4-11
NET START, 4-12
REGEDT32, 4-14

configuration parameters
defined, 14-2
LOCAL, C-3
registry, defined, 14-2
TNS_ADMIN, C-3
USE_SHARED_SOCKET, C-4

configuring
Named Pipes Protocol Adapter, C-4
Oracle Spatial, 5-13
Oracle Text, 5-10

CONNECT /AS SYSDBA
connecting without a password, 9-5
using, 6-8

CONNECT INTERNAL
replacement, 3-2

connecting
LOCAL parameter, C-3
to a database, 6-8

control files
additional backslashes in r. 8.0.4, 4-3
maximum size, 13-7

CREATE DATABASE command, 4-11
CREATE LIBRARY

command, 15-11
custom database

archiving mode, 6-19

D
data dictionary

Advanced Replication tables, 5-16
Data Pump Export

starting, 3-9
Data Pump Import

starting, 3-9
database administrator privileges

for a single database on a computer, 10-34

for all databases on a computer, 10-5
Database Configuration Assistant

preferred tools, 3-3
starting, 3-7

database connection
error messages, D-26

database files
deleting, 4-8

database monitoring
using Oracle Counters for Windows Performance 

Monitor, 7-2
with alert files, 7-12
with Event Viewer, 7-8
with trace files, 7-12

database operator privileges
for a single database on a computer, 10-36
for all databases on a computer, 10-7

database privileges
in Windows local groups, 10-48

database tools
operating system compatibility, 3-2
starting from the command line, 3-8
starting from the Start Menu, 3-6
starting in multiple Oracle Homes, 3-6

databases
backing up, 4-16
connecting to, 6-8
creating manually, 4-4
deleting, 4-8
exporting, 4-6
importing, 4-13
monitoring, 7-2
naming conventions, 4-2
password encryption, 6-18
shutting down, 6-8, 6-9
starting, 6-8

DB_NAME
directory, explained, 2-13

DBVERIFY
starting, 3-9

debugging external procedures, 15-14
developing applications

for Windows, 15-2
diagnostic and tuning utilities

for Windows, 3-18



Index-3

disk striping, 2-18
DisplayName parameter, C-2
DLLs

compared to UNIX shared libraries, F-3
displaying with Task List, 3-19
external procedures, 15-11
Oracle Counters for Windows Performance 

Monitor, 14-9
Oracle Real Application Clusters, 14-10

E
encrypting, database passwords, 6-18
enhanced security, 5-2 to 5-6
enterprise roles

environments in which to use, 9-4
enterprise users

environments in which to use, 9-4
environment variables

ORACLE_HOME, 2-6
TNS_ADMIN, 2-7

error messages
DIM-00000 to DIM-00039, D-17
Intercartridge Exchange, 15-21
ORA-00256, 4-3, 6-18
ORA-01102, 4-2
ORA-09275, D-2
ORA-09291, 4-3, 6-18
ORA-12560, D-27
OSD-04000 to OSD-04099, D-5
OSD-04018, 4-3, 6-18
OSD-04100 to OSD-04199, D-10
OSD-04200 to OSD-04299, D-11
OSD-04300 to OSD-04399, D-14
OSD-04400 to OSD-04499, D-15
OSD-04500 to OSD-04599, D-15

Event Viewer, 7-2
blue (informational) icon, 7-8
defined, 3-15
for monitoring a database, 7-2
integration with Oracle Database, 3-15
logging operating system audit trail, 3-15
managing, 7-12
reading, 7-10
red (stop sign) icon, 7-8

starting, 3-11
using, 7-8
yellow (exclamation point) icon, 7-8

exception conditions, Intercartridge 
Exchange, 15-20

executable images
modifying, 1-4

EXECUTE privileges, on a PL/SQL library, 15-12
Export

databases, 4-6
interactive mode, 4-6, 4-7
parameter mode, 4-6
preferred tools, 3-3
starting, 3-9

Export Wizard
preferred tools, 3-3

extended partition
defined, B-2

EXTERNAL clause, 15-12
external operating system user

creating, 10-15
external OS user

creating, 10-39
external procedures

building a DLL, 15-11
creating a PL/SQL library, 15-11
debugging, 15-14
EXTERNAL clause, 15-12
granting EXECUTE privileges, 15-12
registering with Oracle Database, 15-11
using EXTPROC, 15-9
writing, 15-10

external roles
administering, 10-2, 10-38
creating, 10-29
environments in which to use, 9-4

external users
administering, 10-2, 10-38
creating, 10-15, 10-39
environments in which to use, 9-4

EXTPROC
example, 15-10
explained, 15-9
responsibilities, 15-9



Index-4

F
features

4GT tuning, 1-9
large user populations, 1-9
Oracle PKI, 1-11

file I/O enhancements, 1-5
file permissions, 5-2 to 5-6
files

alert, 7-12
maximum number for each database, 13-7
maximum size possible, 13-7
oracle.key, 2-6
sample init.ora, 13-3
size limitations, 1-5
trace, 7-12

FSEEK
line terminators, 15-15

H
Hostname parameter, 7-3

I
ICX. See Intercartridge Exchange
ImagePath parameter, C-2
Import

databases, 4-13
interactive mode, 4-13, 4-14
parameter mode, 4-13
preferred tools, 3-3

Import Wizard
preferred tools, 3-3

initialization parameter file
defined, 13-2
editing, 13-3
location, 13-2

initialization parameter requirements
Advanced Replication Support, 5-15

initialization parameters
OS_ROLES, 9-4
path in registry, 14-4

instances
modifying, 4-22
Oracle Database, 1-2

running multiple instances, 6-13
integration with Windows

4GT tuning, 1-9
Oracle Fail Safe, 1-11
Oracle PKI, 1-11
Oracle Services for MTS, 1-11

interactive mode
Export, 4-6, 4-7
Import, 4-13, 4-14

Intercartridge Exchange
accessing Web data, 15-15
configuring, 15-16
error messages, 15-21
exception conditions, 15-20
packaged functions, 15-17
stored packages, 15-17
using, 15-17

internet applications
developing, 15-5

K
Kerberos

default use of, 9-3
features, 9-2

keys
defined, 14-2

L
Load Wizard

preferred tools, 3-3
local database role

creating with Oracle Administration Assistant for 
Windows, 10-23

local groups
with database privileges, 10-48

LOCAL networking parameter, C-3
LOG_ARCHIVE_DEST_n, 4-3, 6-18, 6-20
LOG_ARCHIVE_FORMAT parameter, 6-20
LOG_ARCHIVE_START, 6-20

M
mapped drives, 4-3, 6-18
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MAXDATAFILES, 4-10
memory usage, 8-6
Microsoft Certificate Services, 12-3
Microsoft Certificate Stores, 12-2
Microsoft Management Console

defined, 3-15
integration with Oracle Database, 3-15
requirements, 10-3
starting, 3-11

Microsoft ODBC Administration
starting, 3-7

Migration Utility
preferred tools, 3-3
starting, 3-9

MMC. See Microsoft Management Console
monitoring

alert files, 7-2
Event Viewer, 7-2
Management Pack, 7-2
Oracle Counters for Windows Performance 

Monitor, 7-2
Oracle Database events, 3-16
trace files, 7-2

multiple instances, running, 6-13
multiple Oracle homes

benefits, 2-3
introduction, 2-2
overview, 2-2
service naming conventions, 6-2
use of one listener for spawning, 2-3

N
Named Pipes Protocol Adapter

with an Oracle Names Server, C-4
naming conventions for multiple Oracle 

homes, 6-2
NET START command, 4-12
networking parameters

LOCAL, C-3
TNS_ADMIN, C-3
USE_SHARED_SOCKET, C-4

NOARCHIVELOG mode, 6-19
NTFS

file system permission setting, 5-2

NTLM
default use of, 9-3
features, 9-2

NTS. See Windows native authentication

O
ObjectName parameter, C-2
OCOPY

and raw files, 1-5
preferred tools, 3-3

operating system authentication
automatically enabling during installation, 9-5
connecting as SYSDBA without a password, 9-5
OSAUTH_PREFIX_DOMAIN parameter, 10-40

operating systems
audit trail, 3-15
authentication overview, 9-2

OPERFCFGver
starting, 3-9
syntax examples, 14-20

Optimal Flexible Architecture
benefits, 2-8
characteristics of a database, 2-9
default OFA database, 2-14
differences since previous releases, 2-10
introduction, 2-2
nondefault OFA database 1, 2-14
nondefault OFA database 2, 2-16
overview, 2-8
Windows and UNIX differences, 2-18

ORA_DBA local group
adding users to, 9-5

ORA-00256 error, 4-3
Oracle Administration Assistant for Windows

adding a computer to the navigation tree, 10-4
connecting to a database, 10-9
creating a local database role, 10-23
creating an external operating system 

user, 10-15
creating an external role, 10-29
database connection issues, 10-11
defined, 3-16
granting administrator privileges, 10-34
granting operator privileges, 10-36
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integration with Oracle Database, 3-16
managing remote computers, 10-3
saving a navigation tree configuration, 10-4
setting OS_AUTHENT_PREFIX, 10-14
starting, 3-7
using, 10-2, 14-14, 14-21
using the Oracle Counters for Windows 

Performance Monitor snap-in, 14-21
using the Oracle Home Configuration 

snap-in, 14-14
viewing authentication settings, 10-14

Oracle Counters for Windows Performance Monitor
accessing, 7-4
for monitoring a database, 7-2
Hostname parameter, 7-3
integration with Windows, F-3
parameters, 14-8
Password parameter, 7-3
registry information, 7-3
starting, 3-8, 3-11, E-3
troubleshooting information, 7-8
Username parameter, 7-3
using, 3-16, 7-2, 14-21

Oracle Database
connecting to, 6-8
password encryption, 6-18
shutting down, 6-8, 6-9
specifications, 13-7
starting, 6-8

Oracle Database services
auto-starting, 6-5
naming conventions for multiple Oracle 

homes, 6-2
shutting down a database, 6-9
starting, 6-2
stopping, 6-4

Oracle Database Upgrade Assistant
preferred tools, 3-3
starting, 3-7

Oracle Directory Manager
starting, 3-8

Oracle Enterprise Manager
Management Pack, 7-2

Oracle Enterprise Manager Configuration Assistant
starting, 3-7

Oracle Enterprise Manager Console
preferred tools, 3-3
starting, 3-7, 3-9

Oracle home
new-style, defined, 2-7

Oracle Home Configuration snap-in
using, 14-14

Oracle INTYPE File Assistant
starting, 3-7

Oracle Locale Builder
starting, 3-7

Oracle Managed Files, 4-11
Oracle Migration Workbench

starting, 3-8
Oracle Names

Named Pipes Protocol Adapter, C-4
Oracle Net

configuring for external procedures, 15-9
Oracle Net Configuration Assistant

starting, 3-8
Oracle Net Manager

starting, 3-8
Oracle public key infrastructure, 12-2
Oracle Real Application Clusters

registry values, 14-10
Oracle Spatial

configuring, 5-13
Oracle Text

configuring, 5-10
Oracle Universal Installer

changing PATH value, 2-4
Oracle Wallet Manager, 11-3

starting, 3-8
Oracle Wallets, 11-2

storing in the registry, 11-2
storing private keys and trust points, 11-2

ORACLE_BASE
explained, 2-11

ORACLE_HOME
directory structure, 2-12
environment variable, 2-6, 2-7
specifying, 2-13

ORACLE_SID, 4-14, 6-13
OracleHOME_NAMEClientCache, C-2
OracleHOME_NAMECMAdmin, C-2
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OracleHOME_NAMECMan, C-2
OracleHOME_NAMETNSListener, C-2
OracleHOME_NAMETNSListener service, C-4
oracle.key file, 2-6
ORADATA directory, explained, 2-12
ORADIM

command syntax errors, D-17
modifying an instance, 4-22
moving or copying password files, 6-16
preferred tools, 3-3
starting, 3-10

ORAPWD
creating password files, 6-14
starting, 3-10

OS_AUTHENT_PREFIX parameter
case insensitivity, 10-39
defined, 10-14
using, 10-39

OS_ROLES parameter
defined, 10-14
using with external roles, 9-4

OSAUTH_PREFIX_DOMAIN, 10-40
OSAUTH_PREFIX_DOMAIN parameter, 10-3, 

10-40

P
packaged functions

Intercartridge Exchange, 15-17
UTL_HTTP.REQUEST, 15-19
UTL_HTTP.REQUEST_PIECES, 15-19

parameter mode
Export, 4-6
Import, 4-13

parameters
AUDIT_FILE_DEST, 7-12
BACKGROUND_DUMP_DEST, 7-12
DisplayName, 14-10, C-2
Hostname, 7-3, 14-9
ImagePath, 14-10, C-2
INST_LOC, 14-8
LOCAL, C-3
LOG_ARCHIVE_DEST_n, 4-3, 6-18, 6-20
LOG_ARCHIVE_FORMAT, 6-20
LOG_ARCHIVE_START, 6-20

LOGFILE, 14-10
MSHELP_TOOLS, 14-3
NLS_LANG, 14-4
ObjectName, 14-10, C-2
OO4O, 14-8
ORA_AFFINITY, 14-5
ORA_CWD, 14-4
ORA_SID_AUTOSTART, 14-4
ORA_SID_PFILE, 14-4
ORA_SID_SHUTDOWN, 14-4
ORA_SID_SHUTDOWN_TIMEOUT, 14-4
ORA_SID_SHUTDOWNTYPE, 14-4
Oracle Counters for Windows Performance 

Monitor, 14-19
ORACLE_BASE, 14-6
ORACLE_GROUP_NAME, 14-6
ORACLE_HOME, 14-6
ORACLE_HOME_KEY, 14-6
ORACLE_HOME_NAME, 14-6
ORACLE_PRIORITY, 14-6
ORACLE_SID, 4-14, 6-13, 14-7
OS_AUTHENT_PREFIX, 10-14
OS_ROLES, 10-14
OSAUTH_PREFIX_DOMAIN, 10-3, 10-40, 14-7
OSAUTH_X509_NAME, 14-7
Password, 7-3
PERF_FILE_NAME, 14-10
RDBMS_ARCHIVE, 14-7
RDBMS_CONTROL, 14-7
REMOTE_LOGIN_PASSWORDFILE, 6-14
SQLPATH, 14-8
TNS_ADMIN, 2-7, C-3
USE_SHARED_SOCKET, C-4
Username, 7-3, 14-9

partition
raw, 2-18

partitions
extended, B-2
logical partition, B-3
physical disk, B-2
raw, B-2

password
encryption, 6-18
utility, 6-14

password file
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authenticating database administrators, 6-14
creating, 6-14
hiding, 6-14
viewing, 6-16

Password parameter, 7-3, 14-9
passwords

not needed with SYSDBA, 9-5
PATH, changing the value of, 2-3
PERFORMANCE key, 14-8
Performance Monitor

See Oracle Counters for Windows Performance 
Monitor

Performance Pack, monitoring a database, 7-2
performance, increasing, 2-17
PhysicalDrive, B-2
PL/SQL Embedded Gateway, 15-2
postinstallation

setting NTFS file system permissions, 5-2
setting Windows registry security, 5-5

PRAGMA RESTRICT_REFERENCES, with 
Intercartridge Exchange, 15-20

privileges
in Windows local groups, 10-48

Pro C-C++
starting, 3-8

Process Explode, 3-19
Process Viewer, 3-18
PWDSID.ORA file, 6-14

Q
QuickSlice, 3-18

R
RAID. See Redundant Array of Independent Disks
raw files

using, 1-5
raw partition

defined, B-2
logical partition, B-3
overview, B-2
physical disk, B-2

raw partitions
defined, 2-18

Recovery Manager
preferred tools, 3-3
starting, 3-10

Recovery Wizard
preferred tools, 3-3

redo log files
archiving, 6-19

Redundant Array of Independent Disks, 2-17
REGEDT32 command, 4-14
registering an external procedure, 15-11
registry

adding parameters, 14-12
and Oracle Real Application Clusters, 14-10
configuration parameters, defined, 14-2
DisplayName, 14-10, C-2
editor, 14-2
editor, starting, 3-11
Hostname, 7-3, 14-9
ImagePath, 14-10, C-2
INST_LOC, 14-8
keys, defined, 14-2
LOGFILE, 14-10
modifying values, 14-11
MSHELP_TOOLS, 14-3
NLS_LANG, 14-4
ObjectName, 14-10, C-2
OO4O, 14-8
ORA_AFFINITY, 14-5
ORA_CWD, 14-4
ORA_SID_AUTOSTART, 14-4
ORA_SID_PFILE, 14-4
ORA_SID_SHUTDOWN, 14-4
ORA_SID_SHUTDOWN_TIMEOUT, 14-4
ORA_SID_SHUTDOWNTYPE, 14-4
ORACLE_BASE, 14-6
ORACLE_GROUP_NAME, 14-6
ORACLE_HOME, 14-6
ORACLE_HOME_KEY, 14-6
ORACLE_HOME_NAME, 14-6
ORACLE_PRIORITY, 14-6
ORACLE_SID, 14-7
OracleHOME_NAMEClientCache, C-2
OracleHOME_NAMECMAdmin, C-2
OracleHOME_NAMECMan, C-2
OracleHOME_NAMETNSListener, C-2



Index-9

OSAUTH_PREFIX_DOMAIN, 10-40, 14-7
OSAUTH_X509_NAME, 14-7
Password, 7-3, 14-9
PERF_FILE_NAME, 14-10
PERFORMANCE key, 14-8
RDBMS_ARCHIVE, 14-7
RDBMS_CONTROL, 14-7
REG_DWORD, 14-2, 14-13
REG_EXPAND_SZ, 14-2, 14-13
REG_MULTI_SZ, 14-2, 14-13
REG_SZ, 14-2, 14-13
REGEDT32, 14-11, 14-12
setting security, 5-5
SQLPATH, 14-8
update ORACLE_SID, 4-14
Username, 7-3, 14-9
using OPERFCFGver, 14-20

reliability, increasing, 2-17
remote computers

managing with Oracle Administration Assistant 
for Windows, 10-3

remote computers, accessing database files, 6-18
REMOTE_LOGIN_PASSWORDFILE, 6-14
role authorization

description, 9-3
method enhancements, 9-3

roles
creating, 10-29
creating a local database role with Oracle 

Administration Assistant for 
Windows, 10-23

when to use enterprise roles, 9-4
when to use external roles, 9-4

S
Server Manager

replacement, 3-2
services, 6-2

auto-starting, 6-5
shutting down a database, 6-9
starting, 4-10, 6-2
stopping, 6-4

SET INSTANCE command, 10-46, 10-48
SET ORACLE_SID=SID, 6-13

Shared server process, 1-9
shutting down

databases, 6-8, 6-9
snap-ins

Oracle Counters for Windows Performance 
Monitor, 14-21

Oracle Home Configuration, 14-14
specifying an archiving file format, 6-20
SQL*Loader

control file conventions, 3-14
direct path option, 3-13
preferred tools, 3-3
starting, 3-10

SQL*Plus
preferred tools, 3-3
shutting down the database, 6-8
starting, 3-8, 3-10, 6-8
starting the database, 6-8

SQL*Plus Worksheet
preferred tools, 3-3
starting, 3-8

sqlnet.ora file
and Windows native authentication, 10-46, 

10-47
location of, 10-46, 10-47

starter database
archiving mode, 6-19

starting
databases, 6-8
Oracle Counters for Windows Performance 

Monitor, 7-4
Oracle Database services, 6-2
SQL*Plus, 6-8

stopping, Oracle Database services, 6-4
stored packages, Intercartridge Exchange, 15-17
storing private keys and trust points

Oracle Wallets, 11-2
striping disks, 2-18
symbolic links, 2-19

creating, B-5
SYSDBA privileges

connecting without a password, 9-5
for a single database on a computer, 10-34
for all databases on a computer, 10-5

SYSOPER privileges
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for a single database on a computer, 10-36
for all databases on a computer, 10-7

T
tablespaces

Advanced Replication support, 5-14, 5-16
Task List, 3-19
Task Manager

starting, 3-11
using, 3-17

threads
and Microsoft Management Console, 3-15
and multiple Oracle Database instances, 1-2
and ORASTACK, 1-4
and shared server process, 1-9
and UNIX processes, F-6
defined, 1-2
optional and required, 1-2
process errors, D-4
processor affinity, 14-5
scheduling priority, 14-6

TKPROF
starting, 3-10

TNS_ADMIN networking parameter, C-3
tools, starting

Data Pump Export, 3-9
Data Pump Import, 3-9
Database Configuration Assistant, 3-7
DBVERIFY, 3-9
Event Viewer, 3-11
Export, 3-9
Microsoft Management Console, 3-11
Microsoft ODBC Administration, 3-7
Migration Utility, 3-9
OPEFCFGver, 3-9
Oracle Administration Assistant for 

Windows, 3-7
Oracle Counters for Windows Performance 

Monitor, 3-8, 3-11
Oracle Database Upgrade Assistant, 3-7
Oracle Directory Manager, 3-8
Oracle Enterprise Manager Configuration 

Assistant, 3-7
Oracle Enterprise Manager Console, 3-7, 3-9

Oracle INTYPE File Assistant, 3-7
Oracle Locale Builder, 3-7
Oracle Migration Workbench, 3-8
Oracle Net Configuration Assistant, 3-8
Oracle Net Manager, 3-8
Oracle Wallet Manager, 3-8
ORADIM, 3-10
ORAPWD, 3-10
Pro C-C++, 3-8
Recovery Manager, 3-10
Registry Editor, 3-11
SQL*Loader, 3-10
SQL*Plus, 3-8, 3-10
SQL*Plus Worksheet, 3-8
Task Manager, 3-11
TKPROF, 3-10
User Manager, 3-11

trace files
for monitoring a database, 7-2
using, 7-12

troubleshooting
ORA-12560 error, D-27
ORA-28575 error, D-27
TNS-12203 error, D-27

tuning Windows Server operating system, 8-2

U
UNC, 4-2, 6-18
Universal Naming Convention, 4-2, 6-18
UNIX

and Optimal Flexible Architecture, 2-18
and Windows, Oracle Database differences, F-1

USE_SHARED_SOCKET networking 
parameter, C-4

user authentication
description, 9-3
enhancement methods, 9-3
when to use enterprise users, 9-4
when to use external users, 9-4

User Manager
defined, 3-18
integration with Oracle Database, 3-18
starting, 3-11

Username parameter, 7-3
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UTL_FILE
using, 15-15

UTL_HTTP.REQUEST, Intercartridge 
Exchange, 15-19

UTL_HTTP.REQUEST_PIECES, Intercartridge 
Exchange, 15-19

V
viewing

password file, 6-16

W
Wallet Resource Locator, 12-3
Web data, Intercartridge Exchange, 15-15
Windows

and UNIX, Oracle Database differences, F-1
diagnostic and tuning utilities, 3-18
extensions for internet development, 15-5

Windows 2000 domains
administering external users and roles with 

Oracle Administration Assistant for 
Windows, 10-2

Windows authentication protocols
default protocol used, 9-3
with Windows 2000, 9-2
with Windows NT 4.0, 9-2

Windows domains
administering external users and roles, 10-38
basic features, 9-4

Windows local groups
with database privileges, 9-5, 10-48

Windows native authentication
benefits, 9-2
enhancements, 9-3
installation of, 9-2
methods and use of, 9-2
overview, 9-2
role authorization enhancements, 9-3
setting the sqlnet.ora file, 10-46, 10-47
user and role requirements, 9-3
user authentication enhancements, 9-3

Windows tuning
applying latest service packs, 8-8

closing unnecessary foreground 
applications, 8-11

configuring server to be an application 
server, 8-6

disable unnecessary services, 8-6
foreground applications, 8-5
multiple striped volumes for sequential and 

random access, 8-10
overview, 8-2
removing unused network protocols, 8-7
resetting the network protocol bind order, 8-8
using hardware and operating system 

striping, 8-8
Windows-specific

archiving procedures, 6-20
audit trail availability, 7-10
audit trail facility, 7-10
automatic database startup after restart, 6-5
initialization parameter file, 13-2
parameter file location, 13-2
parameter filename and location, 13-2
password filename and location, 6-14
role syntax, 10-48
trace file names, 7-12
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